Canon

RAW Image Processing, Viewing and Editing Software

Digital Photo Professional
Ver. 3.14
Instruction Manual

Content of this Instruction Manual

DPP stands for Digital Photo Professional.

In this manual, the screens used in the basic
operation instructions are from Windows 7, with
some portions using screens from other
versions of Windows.

» indicates the selection procedure of the menu.

Example: [File] menu » [Exit].
Square brackets are used to indicate items such

as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

p.** indicates a reference page.
Click to move to the relevant page.

"2 : Marks helpful information when a problem
arises.

U@/
@ : Marks information that should be read

N1/
s

before use.

Marks additional information you may find
helpful.

: Marks tips for using the software skillfully.

Switching Between Pages
Click on arrows on the bottom right of the screen.

@ : next page

() : previous page

- return to the page you previously
displayed

Click on the chapter headings on the right side

of the screen to switch to the contents page of

that chapter. Also, click the item you want to

read about on the table of contents to move to
the relevant page.

Help and Shortcut Keys

For information about using DPP, refer to Help
from the [Help] menu.

Refer to the [Troubleshooting] » [Shortcut Key
List] in the Help for a list of shortcut keys which
are helpful for quick operation.
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Introduction

Digital Photo Professional (hereinafter, “DPP”) is a high-performance
RAW image processing, viewing and editing software for EOS cameras.
It is often thought that RAW images are difficult to handle compared with
ordinary JPEG images, but using DPP, you can perform advanced edits
and print RAW images with ease.

RAW Images and Their Features
What is a RAW Image?

A RAW image is image data that has recorded output data of imaging
sensor. As image processing is not performed inside the camera when a
photo is taken and the photo has been recorded in the special form of
“‘RAW image data + Image processing conditions information at the time
of shooting”, special software is needed to view or edit the image.

* “RAW” means “in a natural condition” or “not processed or refined”.

What is RAW Development?

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on

your computer unless you perform subsequent image signal processing.

Therefore, even though it is digital, this processing is called
“‘development”.

When is RAW Development done?

DPP automatically carries out this “development” processing when
RAW images are displayed in DPP.

As a result, RAW images displayed in DPP are images whose
development processing has been completed.

With DPP, you can view, edit and print RAW images without being
particularly conscious of the development processing.

What Advantages Does a RAW Image Have?

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Consequently, image
deterioration is not a problem and it is the perfect image data for users
who want to get creative with their images after they have been shot.
In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe”.

Introduction

Contents at
a Glance
D ————————

Basic
Operation

—

Advanced
Operation

—_—

Advanced
Image Editing
and Printing

—

Processing
Large Numbers

of Images
—_—

Editing
JPEG/TIFF

Images
R

Reference




Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

View and organize RAW images

Real-time adjustment of a RAW image

Various image adjustments while maintaining the original image
Freely apply a Picture Style
View your image before and after adjustment in the same window

Trim and adjust the angle of an image
Change image size

Correction of lens aberration
Automatic/manual dust erasure processing

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print a RAW image
View and organize JPEG and TIFF images

Real-time adjustment of JPEG and TIFF
images
Various image adjustments while maintaining the original image

Print JPEG and TIFF images

Color management compatibility
CMYK simulation for commercial printing

System Requirements

Introduction

oS Windows 8.1, Windows 8, Windows 7*1
PC with one of the above OS preinstalled
Computer | . Upgraded machines not supported Contents at
CPU 1.3GHz Pentium or higher*2 A ke
RAM Minimum 1GB*3
Displa Screen resolution: 1024 x 720 pixels or more Basic
play Color quality : Medium (16 bit) or more Operation
*1 Compatible with 32-bit/64-bit systems for all versions except Starter Edition
*2 Core 2 Duo or higher is recommended
*3 For Windows 8.1, Windows 8 or Windows 7 64-bit systems, minimum 2GB gd‘é?:t‘i’gﬁ
Check the Canon website for the latest system requirements, including P
supported OS versions.
Advanced
Supported Images imags Ediing
and Printin
This software supports the following image types. J
Image type Extension Processing
RAW images*! shot with EOS cameras, .CR2 La;%‘i,ﬂ‘a‘g‘f;’ s
RAW images | excluding EOS DCS1 and EOS DCS3 TIF
RAW images*2 shot with PowerShot cameras .CRW
- : Editing
JPEG images Exif 2.2, 2.21 or 2.3-compatible JPEG JPG, .JPEG JPEG/TIFF
Images Images
TIFF images | Exif-compatible TIFF images .TIF, .TIFF
*1 Compatible with RAW images shot with EOS D6000 or EOS D2000
that have been converted to RAW images using the CR2 Converter Reference
and have the “.CR2” extension.
For information on CR2 Converter, refer to Canon website.
*2 « Only with models where Digital Photo Professional is listed in the
“Data Type” item in the “Specifications” section near the end of the Index
Camera User Guide.

* Use the dedicated CameraWindow application to download images
from a PowerShot camera to a computer. See the Software Starter
Guide for details.

* Lens aberration correction can only be used with some camera and
lens models.

* Automatic dust erasure processing and other EOS specific
functions cannot be used.

* RAW images shot with the PowerShot Pro1 are also supported, but
they cannot be edited with the DPP RAW image adjustment
function.
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Contents at a Glance ‘ el < B

Introduction

Downloading Images to Your Computer Adjust brightness of shadows/highlights = p.57
Download images by connecting your camera and Reduce image noise = p.62 Contents at
2>p.7 . a Glance
computer Correct lens aberration = p.63
Download images using a card reader 2p9 Use the Digital Lens Optimizer - p.70
— . Use a Picture Style file = p.59 . Z?git?on
Viewing and Checking RAW Images Edit efficiently -p.34 P
Quickly enlarge parts of an image =p. 1 Edit an image while comparing the image before and _j 0.53
Sort images (check marks, rating) - p.18, p.19 after adjustment ' Advanced
Display the images shot simultaneously as a RAW - p.22 Synchronize multiple images = p.54 SEsTatloy
image and JPEG image as a single image Display an area beyond the set range as awarning -
Display the images in the thumbnail list display at high _j 0.23 indicator (Highlight/Shadow warning) P- Advanced
resolution Restore an adjusted image to its condition at the time Ir::ggﬁgtlf:lr;g
Check shooting information such as the shooting date =» p.10, p.23 of shooting P-
Composite images => p.80 Processing
Editing RAW Images (Adjusting) Create HDR (High Dynamic Range) images - p.83 Laggf“ig‘a";::rs
Adjust brightness/darkness - p.12, p.26 Lo —
Use automatic adjustment = p.33 Printing Editing
Change the Picture Style - p.26 orint wel c - - p.43, .89, JPEG/TIFF
Sharpen the modulation and contrast of colors (contrast) ~ =» p.29 rintwell on a L-anon printer p.90, p.91 Images
Make skin tone look healthier (color tone) = p.30 Faithfully reproduce the color of the subject = p.43, p.89,
Make the image colors more vivid (color saturation)  =» p.30 when printing p-90, p.91 Reference
Adjust an image to make color tone more natural .28 Print a thumbnail list of images - p.88
(white balance) ' Approximate the color seen on screen with your 0.95 -
Change an image to black-and-white or sepia tones . printing results '
(monochrome) P —
Trim an image and adjust the angle of an image - p.38 Conversion of Images
Specify an aspect ratio that matches the size of the 38 Convert a RAW image to a JPEG image = p.42,p.102 @ @
paper on which an image is to be printed P- Edit in Photoshop - p.79, p.103
Erase dust shot with the image = p.75, p.77 Perform batch processing - p.102 @
Erase unwanted parts of an image = p.79 Edit (adjust) a JPEG image - p.106

Auto correct RAW images with the Auto Lighting Optimizer =» p.61



1 Basic Operation

The basic operational flow — from how to download to your computer
images shot with a camera to checking, editing, saving and printing a
downloaded RAW image — is explained here.

)
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Starting up DPP

Introduction

Double-click the desktop icon. Main Window Display
| ' In the main window, you can use tabs to select either the [Folder]
Double-click window or the [Collection] window. The [Folder] window displays the C:'(';tfa";zeat
& : images in folders on your computer, while the [Collection] window (p.36)

displays images selected randomly by the user from one or more folders
and gathered together.

Unless noted otherwise, the [Folder] window will be described as the
main window from this point on.
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Downloading Images to Your Computer .
Introduction
Connect the camera and computer with the cable provided and EOS Utility (Displayed items differ depending on connected
download the images saved on the memory card inserted in the camera. camera)
For downloading images, start up the camera software “EOS Utility” R, . =
from DPP and use. 1 Cgrgfan:(s:eat
Control Camera Accessories

Select the save destination for the images.
Select the save destination in the folder area on the left of the
main window.
When creating a folder, see p.50.

' ital Photo Professional - [E\Users\CANON\Pi Advanced
Eile Edit View Bookmark Label Adjustment Tools Window Help Operation
“ Monitor Folder
: = Selectall Clarall  Rotste lft Rotste nght 7 ImAag‘éaggﬁldng
| o  colectioni) | and Printing
B Desiop S
-l Libraries Processing
Large Numbers
Connect your camera and computer and turn the - Images
camera on. —
Connect the camera and your computer with the interface cable Editing
provided with the camera and turn the camera on. JPEG/TIFF
. . . . Images
Start up EOS Utility. For detailed instructions on connecting your camera and =
Select the [Tools] menu » [Start EOS Utility] computer, refer to the “EOS Utility Instruction Manual” (PDF
— electronic manual). Reference
Start Quick check tool Alt+Q — -/
Start Trimming/Angle Adjustment tool Alt+C =
Start Stamp tool Alt+5 > e
Start Rename tool Alt+R HHHCD L o
[ startEOS Uil Alt+0 ' \?
Sync folder with EOS Utility @ @
Transfer to Photoshop Alt+P
Preferences... Chrl+ K . .
The capture window for EOS Utility appears. @

When an EOS M2 or EOS M is connected, the capture window

EOS Utility starts up.
y P does not appear. Proceed to step 5 on the next page.



Click the [Main Window] button.
B o oo =]

-
F

(=13

15| — —
an
®E o= =0
]
o EREARS

Standard

3.0,0,0
r Defined style

0,0

HDR Mode Disable HOR

Live View shoot. .. .

Other Functions. .

The main window for EOS Utility appears.

Download images.

IF}) EOS Utility - EOS XXX
|

Starts to download images CIiCk

Lets you select and download images

Control Camera

Camera settings/Remote shooting

Monitor Folder

Preferences

Downloading of images begins.

The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of DPP.

The downloaded images are sorted by date into folders and
saved.

-Z\@E Advantages of using EOS Utility to download images

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date.

5

You cannot start up EOS Utility in the [Collection] window
(p.6, p.36).
When EOS Utility has been started up from DPP, you cannot use
the following functions.
* Quick check window view (p.16)
* Trimming and adjusting the angle of an image (p.38, p.114)
*Digital Lens Optimizer (p.70)
» Compositing images (p.80)
* Creating HDR (High Dynamic Range) images (p.83)
* Dust erasure processing (copy stamp function)
(p.-75to p.79, p.117 to p.121)
* Batch change file names (rename function) (p.104)
* Printing using Easy-PhotoPrint EX or Easy-PhotoPrint
(Plug-in printing) (p.43, p.46)
* Transferring images to Photoshop (p.79)
* Batch saving images (batch processing) (p.102)
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Downloading Images Using Your Card Reader

You can also download images to the computer, using a third-party card
reader.

Load the memory card into the card reader.

Windows7_08 (E)
EOS_DIGITAL (F;

The [DCIM] folder is copied to your computer.
All images are saved in folder units inside the [DCIM] folder.

Ay
N

E02

Display the images downloaded to your computer.
In the [DCIM] folder copied to your desktop, select the folder
where the shot images are saved.

Info Selectall  Clearal  Rotate lsft Rotl

&, WindowsT_0S (E)
El e EOS_DIGITAL (F:)

B )0 DCIM
€l Network

=]
100CANON|

102CANON

Images in the folder are displayed in the main window of DPP.

Checking before downloading images

By selecting the memory card folder directly in DPP, the images in the
folder are displayed in DPP and you can check the shot images.

5

Copying images to your computer will take some time when there
is a large number of images saved on the memory card.

For details on the [DCIM] folder structure and the file names of
shot images, refer to “Folder Structure and File Names in the
Memory Card” in the “EOS Utility Instruction Manual” (PDF
electronic manual).
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Viewing an Image
Images downloaded to your computer are displayed as a thumbnails list

in the main window. You can double-click an image to open the edit
window and display the image at large size.

Viewing Images as Thumbnails in the Main Window

. . Rotate selected image
Main window

Click to select the image
Display thumbnails of all the images inside the
folder selected in the folder area on the left

® Images displayed with the ["® ] icon are movie files and cannot
be played back in DPP.
If the message [Insufficient memory.] appears, there are too
many images in one folder. Decrease the number of images in
one folder such as by dividing them into smaller folders, etc.

@ When aspect ratio information is attached to the shot image with the
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark lll, EOS-1D
Mark 1ll, EOS 5D Mark lll, EOS 6D, EOS 7D Mark I, EOS 7D, EOS
70D, EOS 60D, EOS 700D, EOS 100D, EOS 650D, EOS 600D,
EOS 1200D, EOS M2 or EOS M, the image is displayed as a trimmed
image (p.38, p.114).
For a list of main window functions, see p.127.

Changing the Size of Thumbnail Images

You can change the size of the thumbnail images displayed in the main
window and display them with shooting information attached.

Select the [View] menu » desired item.

View

Edit in Edit image window Ctrl+Right Arrow
View collections Alt+G

Tool palette Chrl+T
Tab

Folder view

Toolbar

Rating Ctrl+0

ol NN RN

Large thumbnail Ctrl+1
@  Medium thumbnail Crl+2
Small thumbnail Ctrl+3

Thurmbnail with information Ctrl+4

Sort >

The display changes to the selected item.
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Enlarging and Viewing an Image in the Edit Window Enlarging and Viewing a Specific Area
Double-click the area you want to enlarge.

06LCRa] S0

T R I Double-click
— e
-

The edit window appears.

Tool palette

e e The area you double-clicked is enlarged to 100% (actual pixel

size). If you wait for a while, it changes to a clearer display.
Double-click again to revert to the full view.

To change the enlargement display position, drag on the image
or drag the enlargement display position of the tool palette.

Enlargement display position in the tool palette

Change the enlargement
display position by
dragging

It may take time for the image to redraw itself.
Click the [[g]] in the upper right of the edit window to close the
edit window.

|§| By selecting the [View] menu P [AF Point] in the edit window, you can

display the AF points selected in the camera at the time of shooting.

However, AF points are not displayed for images whose image size

has been changed and then been converted and saved (p.42, p.137), N . . . . 0
images for which you selected an effect other than [Shot settings] as @< To display an image in an enlargement ratio other than 100%
correction of fisheye lens distortion aberration, or images which have Select the [View] menu » [200% view] or [50% view].

had settings specified during RAW processing on the camera for

distortion correction and chromatic aberration correction.

For a list of edit window functions, see p.130. @ You can change the enlargement ratio when you double-click (p.93).
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Adjusting an Image

You can perform a variety of image adjustments, such as adjusting the
brightness or changing the Picture Style of an image, using the tool
palette of the edit window. You can easily restore an image to its original
settings with the [[(5]] button even if you have made the wrong
adjustment. Try out the various adjustments.

As an example, the procedure to adjust the brightness of an image is
explained here.

Tool palette
I[raw [rge [ nejaco [iens | ]
|Brightness adjustment U?P Rever_ts_ the Ima_ge to
e the original settings
' White balance adjustment [3” I:_)rag the S“der Ieft or
[z’ 1 2 3 Register... rlght
|ﬂ (Auto) - “ Tune...
|Picture Style =]
|@ (Standard) - “ Browse... |
-10.0 80 %0 40 -20 00 20 40
Contrast:{0) 1
Highlight:(0) {
Shadow: (D)_ B {1
|| Linear
Color tone:{0) {1
Color saturation: (0) {1
|Unsharp mask - |
Strength:(0) 0
Fineness:{0) 0
Thresheld: (0) 1

The image brightness changes in real time according to the
amount of adjustments.

? The tool palette does not display

Select the [View] menu » [Tool palette].

About the Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALQO] and [LENS] tab sheets according to your
editing requirements.

Because adjustment made with the tool palette (it undergoes automatic
development processing each time) only changes the image processing
conditions, the “original image data itself” remains unaffected.
Therefore, there are no problems with image deterioration that arise with
editing and you can readjust your images any number of times.

See Chapter 2 onwards for more detailed information on the various
functions of the tool palette.

About Recipes

In DPP, all the adjustment contents (image processing conditions
information) made with the tool palette are saved to an image as data
called a “Recipe” (p.99).

@ For a list of tool palette functions, see p.131.
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Saving an Image

If you perform the save operation described here, you can save all the
adjustment contents (recipe) made with the tool palette to the RAW
image.

Select the [File] menu » [Save].

File
[ Save Ctrl+5 )
Save As... Ctrl+5Shift+5
Convert and save... Ctrl+D
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 2
Info Ctrl+I
Close Chrl+W

Your adjustment contents (recipe) are saved to the image.

Saving

With DPP, you can perform the following types of saving according to
your requirements. For detailed information on each saving method, see
Chapter 2 onwards.

Save (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save.

Save as (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW
image and save as a separate RAW image. The original RAW image
remains unaffected.

Add thumbnail to image and save* (p.23)

Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images
redraw themselves more quickly.

Convert and save (p.42)

Convert adjusted RAW image to a JPEG or TIFF image and save.
The original RAW image remains unaffected.

Batch process (p.102)

Convert in batches adjusted multiple RAW images to JPEG or TIFF
images and save.

The original RAW images remain unaffected.

* Option available in the main window.
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Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the [File] menu » [Print].

File
Save Ctrl+5
Save As... Ctrl+5Shift+5
Convert and save... Ctrl+D
([ Print.. cui-p )
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 2
Info Chrl+1
Close Ctrl+W

The printer’s print settings dialog box appears.

Print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [OK] button.
Printing begins.

Printing
With DPP, you can perform the following types of printing according to
your requirements. For detailed information on each printing method,
see Chapter 2 onwards.

Print one image (p.49)

Print with a Canon inkjet printer (p.43, p.46)

Print with a high-end Canon printer (p.89)

Print with shooting information (p.87)

Printing a thumbnail list (contact sheet printing) (p.88)

Exiting DPP

In the main window, select the [File] menu P [Exit].

File
Open in Edit window Ctrl+0
Open in Edit window (enlarged)
Save Ctrl+5
Save As.. Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+ T
Convert and save... Ctrl+D
Batch process... Ctrl+B
Create new folder...
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing
Add te collection Ctrl+G
Remove from collection Ctrl+Shift+G
Clear collection
Delete Del
Info Ctri+I
Exit Alt+F4

DPP exits.

@ A confirmation dialog box for saving the images appears when you
try to exit DPP without saving the adjusted image. Click the [Yes to
all] button to save the adjustment contents (recipe) to all the images

adjusted.
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D Advanced Operation

A more advanced operation — from efficiently checking images, to
various ways of editing an image, printing a RAW image using a Canon
printer and sorting images — is explained here.

Efficiently Checking/Sorting Images.........cccccc.oco... 16
Sorting IMages.......coooeeeiiiiiiieee e 18
Attaching Check Marks..........cccccceeeeeiiiicciiiiiieeeee. 18
Setting Ratings ........vvvveeiiieiiiiiiiiieeee e, 18
Sorting Images in the Main Window .......................... 19
Attaching Check Marks in the Main Window ......... 19
Setting Ratings in the Main Window ...................... 19
Arranging Images in the Main Window ...................... 20
Arranging by TYPE ..o 20
Arranging Freely ... 21
Displaying a RAW Image and JPEG Image as a Single
=T =SS PPPPPRRR 22
Improving the Quality of an Image in the Main Window ... 23
Checking Image Information.................ccccccuuvvnnneen... 23
Editingan Image ........ccooovviiiiii e 25
About the RAW Tool Palette...........ccccoovvvvvveeeeineennn, 25
Editing with the Tool Palette in the Main Window.. 25
Adjusting Brightness.........ccccceeeiiiiiiiiiiiiiieeeeeee e 26
Changing a Picture Style ..........cccccccooeoiiiiiiiiiiiiiiee. 26
Picture Style File..........ccoooiiieieeee 27
Adjusting Color Tone by Changing White Balance.... 28
Adjusting Color Tone Using Click White Balance...... 28
Adjusting Contrast ..........ccccieeiiiiiiiiie e 29
Changing Color Tone and Color Saturation............... 30
Adjusting Monochrome ...........ccccccveeiiciiieeeeece. 30
Adjusting Image Sharpness.........cccccoecceeeeeeiiiiienennnn 31

Detailed Setting of Image Sharpness..................... 32
Automatically Adjusting Brightness and Color (Tone
CUrve ASSISt) ... 33

Editing Efficiently ..., 34
Editing in the Edit Image Window............................... 34
Changing the Thumbnail Display Position to Horizontal ............... 36
Gathering and Editing Images in the Collection Window ... 36

Trimming and Adjusting the Angle of an Image....... 38

Applying Adjustment Contents to Other Images...... 41

Saving Editing Results...........cccccceiiiiiiiiii 41
Saving Editing Contents to a RAW Image.................. 41
Saving as a JPEG or TIFF Image.........cccccevviiiienenn. 42

Re-Editingan Image........cccccooeviviiiiiiieeeeee 43

Printing an Image ... 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint EX ......................... 43
Printing Photographs with Canon Inkjet Printers
Compatible with Easy-PhotoPrint............................... 46
Printing Photographs with a Printer other than Canon
Inkjet Printers.........oooo e 49

Organizing IMages .......ccceveeeeeeeeeeeeeeee e 49
Deleting an Unwanted Image...............cccccvvvveeeeenne.... 49
Creating a Folder for Saving Images............cccceee... 50
MOVING IMAQES ...oeveeeeeiieee e 50
Moving Images in Folders .........ccccceeiiiiiiiiiiiiiiieeee. 51
Registering Frequent-Use Folders (Bookmark
Registration) .........coooeiiiiiiiiiie e 51

Organizing Bookmarks ..........ccccccccoeevviiciiiiiieeeeen. 51

Introduction

—_—

Contents at
a Glance

—_—

Basic

Operation

Adv ed
(0]} ion

Advanced
Image Editing
and Printing

Processing
Large Numbers

of Images
N ——

Editing
JPEG/TIFF

Images
e

Reference




Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window Double-click the area you want to enlarge.
and efficiently check each image. You can attach check marks and sort , n
images into five groups.

Introduction

—_—

T U RO P, o2

Contents at

. ] . a Glance
Dlsplay the qmck check window. | Double-click ]
Click the [Quick check] button.
Basic
Operation
7y )
1 Rotste right Quick Trimming Ad@ ed
— check (0]} ion
Rating & & » » = o
_ w The area you double-clicked is enlarged to 50% view.
. ¥, . o . Advanced
¥ ; To change the display position, drag on the image. Image Editing
_ _ ' Double-click again to revert to the full view. and Printing
The quick check window appears. To exit, click the [OK] button.
Click the [Next] or [Previous] button to switch Processing
. Large Numbers
between images to be checked. of Images
N ——
Editing
JPEGI/TIFF
Images
Reference
Index
@ When [AF Point] is checkmarked, you can display the AF points
selected in the camera at the time of shooting. However, AF points @ @
_ are not displayed for images which have had their image size changed
. . . L _ and then been converted and saved (p.42, p.137), which have had g;\
All the images displayed in the main window can be checked in settings specified during RAW processing on the camera for distortion Q
the quick check window. correction and chromatic aberration correction, which are composited, or

which are created as HDR (High Dynamic Range) images. 16
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-@> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switch between images using the keyboard

You can also switch between images by pressing the <—> or <«>
key.

Switch between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Operate using the menu

Each operation can also be performed with the menu which appears
when you right-click with the mouse on an image.

@ The enlargement ratio when an image is enlarged is half (50%)
of the 100% (actual pixel size).
You can change the enlargement ratio to 100%, when an image
is enlarged (p.93).
For a list of quick check window functions, see p.135.
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Sorting Images

You can sort images by attaching check marks or setting ratings
(indicated with [ %] marks) by subject or theme.

Attaching Check Marks

Display the image you want to attach a check mark
to, and then click any one of [[i]] to [[5].

Chedk mark

Clear

(ti2]3 4

Click

The selected check mark appears in the upper left of the window.

Check mark

Click the [Clear] button to remove the check mark.

|§| The values of check marks attached to images in DPP version 3.8
or earlier are maintained as they are.
You can also attach check marks from the menu that appears by
right-clicking with the mouse on an image in the main window.

Setting Ratings

Display the image you want to rate, and then click
any one of the [ - ].

Rating

(s » 2 & 8)

— Click (changes to [« ] after
clicking [ = ])

The rating is set and an icon corresponding to the selected [ # ]
appears in the upper left of the window.

(Window shown with a rating of three [ % ])

To set [Reject], click the [Reject] button. Click the [Reject] button
again to cancel.

Rating icon

EA\Users\CANON\Pict.
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Sorting Images in the Main Window

You can also sort images in the main window by attaching check marks
or setting ratings (indicated with [E3] marks) by subject or theme.

Attaching Check Marks in the Main Window

Select the images you want to attach a check mark
to, and then click any of [v] to [v] in the toolbar.

B ®9®» ® & & 2

Sckectal Cearall Rolate kot Robate rght Quick Stamp  Trimming
n

check

Click

—— Select

IMG_0002.CR2  [ros] IMG_0003.CR2

frame.

Check mark

@ MG 000LCR2 IMG_000Z.CRZ IMG_0003.CR2

Click the check mark in the toolbar again to remove the check
marks.

Setting Ratings in the Main Window

Select the images you want to rate, and then click
any of the [m] in the toolbar.

Click (changes to [E1] after clicking [H])

&N (S ) 7

— Select

IMG_000ZCR2  * IMG_D003.CR2 IMG_0004.CR2

The rating is set and an icon corresponding to the selected [Ei]
appears in the image frame.
(Window shown with a rating of three [E3] as an example)

vV ® O & 2

Rotate left  Rotate right

Stamp — Trimming Baich
Angle process

ating Je W W o o

Rating icon

IMG_0002.CR2 i IMG_0003.CR2 3 IMG_0004.CR2

@

To cancel the rating, click the same [Ei] as when the setting was
made in the toolbar.

[Reject] cannot be set with the toolbar. Set [Reject] with the
[Label] menu or the quick check window (p.18).
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=@> To select multiple images in the main window

Click on desired images while holding down the <Ctrl> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <Shift> key.

-:@/3 To display more thumbnails in the main window

You can display a large number of images by setting the size of thumbnail
images to small (p.10). Then, by selecting the [View] menu » [Rating] and
removing check marks so that ratings no longer appear in the image
frame, you can display still more thumbnail images in the main window.

|§| The [Label] menu can also be used to attach check marks and set
ratings.
By selecting the [Edit] menu » [Check mark] or [Rating] » image
selection criteria, you can refine criteria for selecting
checkmarked or rated images.
You can display and change the rating settings set in DPP with
other bundled software and on an EOS-1D X, EOS-1D C, EOS 5D
Mark lll, EOS 6D, EOS 7D Mark I, EOS 7D (firmware version 2.0.0
or later), EOS 70D, EOS 60D, EOS 700D, EOS 100D, EOS 650D,
EOS 600D, EOS 1200D, EOS 1100D, EOS M2 or EOS M camera.
« EOS Utility version 2.9 or later:
Ratings set in DPP are displayed. However, [Reject] is not
displayed and you cannot change rating settings.
* On an EOS-1D X, EOS-1D C, EOS 5D Mark Ill, EOS 6D,
EOS 7D Mark I, EOS 7D (firmware version 2.0.0 or later), EOS
70D, EOS 60D, EOS 700D, EOS 100D, EOS 650D, EOS 600D,
EOS 1200D, EOS 1100D, EOS M2 or EOS M camera:
Ratings set in DPP are displayed in the playback screen. You
can also change rating settings. However, you cannot display or
change settings for [Reject].
Reversely, you can also display and change with DPP the rating
settings set for still images on an EOS-1D X, EOS-1D C, EOS 5D
Mark lll, EOS 6D, EOS 7D Mark I, EOS 7D (firmware version 2.0.0
or later), EOS 70D, EOS 60D, EOS 700D, EOS 100D, EOS 650D,
EOS 600D, EOS 1200D, EOS 100D, EOS M2 or EOS M camera.

Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them

individually.

Arranging by Type

Select the [View] menu » [Sort] » desired item.

Edit in Edit image window

View collections

Tool palette
Tab

Folder view
Toolbar
Rating

Large thumbnail
Medium thumbnail
Small thumbnail

Thurmbnail with information

Sort

Ctrl+Right Arrow
Alt+G

Ctrl+ T

Ctrl+0

Ctrl+1
Ctrl+2
Ctrl+3
Ctrl+4

L

The images are arranged in the order according to the selected

item.

Rating: Descending order

Rating: Ascending crder

File name

Shooting Date/Time
RAW priority

Check markl

Check mark2

Check mark3

Check mark4

Check mark5
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Sort item

Rating: ascending
order

Rating: descending
order

File name

Shooting Date/Time

RAW priority

Check mark1 -
Check mark5

Description

Sorted in order of fewest [« ].

Sorted in order of most [ ].

Images are sorted by file name in alphanumeric
order (0to 9 = Ato 2).

Images are sorted by shooting date and time
from the earliest.

Images are sorted in the following order: RAW
images - JPEG images — TIFF images.

Images with check marks take priority and are
sorted in number order.

-:@/3 Check mark sorting order

When check marks from 1 to 5 have been set, the images are sorted as

follows:

Check mark1 selected: 1-2—->3->4-5
Check mark2 selected: 2>3->4->5->1
Check mark3 selected: 3-4->5->1->2
Check mark4 selected: 4-5->1->2-3
Check mark5 selected: 5»>1-»2->3->4

Arranging Freely

Drag and drop the image to the desired location.

Nomber ofseisctedmges: 1

The image moves to the desired location.

You can also select multiple images (p.20) and move them.

The order of rearranged images is maintained until you exit DPP
or select another folder in the folder area.

Select the [View] menu » [Sort] » [File name] to revert to the
order before the images were rearranged.

Ny

5@5 Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you exit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View settings] tab sheet in the [Preferences] to
maintain the order of images without changing the image file names
(p.93).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.104).

Introduction

—_—

Contents at
a Glance

—_—

Basic
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers

of Images
N ——

Editing
JPEG/TIFF

Images
e

Reference

21



Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Tools] menu P [Preferences].

Select the [View settings] tab sheet and checkmark
[Display only CR2 images for CR2 and JPEG files of
the same name].

| General settings l | View settings ‘l Tool palette | Color management |

Grid pitch

84 Pixels(8-258)

Image selection status

[¥] images opened in Edit window remain selected in main window

Magnification in Edit window

@ Fit to window 50% _) 100% 200%

Magnification when the Edit/Edit image window is double-diicked

) 50% @ 100% ) 200%

RAW and JPEG

[ [C1Display, only CR2 images for CR2 and JPEG files of the same name: )

Sort order in main window

[T Retain sort order

Highlightshadow Alert
Highlight 255 (192-255) -
Shadow 0 (0-64) -

Quick check toal display

9 50% ) 100% {moiré reduction off)

OK Cancel

The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [ D] mark (p.129).

? RAW images with the extension “.CR2” can be displayed as a
single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2” and JPEG
images simultaneously. Images that have been simultaneously shot with
a camera that shoots RAW images with the extension “.CRW” or “.TIF”
cannot be displayed as a single image.

—I@/i- When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

* Deleting an image (p.49)

* Moving or copying an image (p.50)

» Checkmarking (p.18, p.19)

* Rating (p.18, p.19)

* Rotating an image (p.127, p.135, p.136)

+ Attaching a thumbnail to an image and saving (p.23)

Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[ 23] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2 (p.128).

@ In step 2, if you uncheck [Display only CR2 images for CR2 and
JPEG files of the same name], the RAW image and JPEG image
are displayed as separate images.
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Improving the Quality of an Image in the Main Window
Create a new thumbnail image for the main window and save to each
image.

The quality of images in the main window improves and images redraw
themselves more quickly.

With all the images selected, select the [File] menu »
[Add thumbnail to image and save].
File

Open in Edit window Ctrl+O

Open in Edit window (enlarged)

Save Ctrl+5
Save As.., Ctrl+Shift+5

[ Add thumbnail to image and save Ctrl+Shift+T ]
Convert and save... Ctrl+D)
Batch process... Ctrl+B

Create new folder...

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
Add to collection Ctrl+G
Remove from collection Ctrl+5Shift+G

Clear collection

Delete Del

E\@/E The extent of the improvement in quality

The quality is improved for any JPEG or TIFF image. While the image
quality improves regardless of the thumbnail size (p.10), selecting [Large
thumbnail], with its larger display size, shows the improvement more
clearly than [Medium thumbnail] and [Small thumbnail].

@ A large number of images may take some time to be processed.

Checking Image Information

Select the image for which you want to check the
image information.

Click the [Info] button.

igital Photo Professional - [EX S\CA \Pictures\Photo'x

ile Edit Wiew Bookmark Label Adjustment Tools Wi

2@® ®®

Selectall

=) Documents

The image information window appears (p.24).
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Select a tab sheet and check information.

[Shooting Information] tab sheet

-'| Shooting Information |Metadata|

[Metadata] tab sheet

Item

File Name

Camera Model
Firmware

Shooting Date/Time
Owner's Name
Shooting Mode

Tw{ Shutter Speed )
Av( Aperture Value )
Metering Mode
Exposure Compensation
IS0 Speed

Auto ISO Speed
Lens

Value

IMG_0001.CR2

Canon EQS XXX

Firmware Version Xxx
FOOOL AR A A K|

Shutter-Priority AE
1/1600

8.0

Evaluative Metering

a

400

OFF

EF70-200mm ff4L USM

m

Focal Length 188.0mm
Image Size HRA K
Image Quality RAW

Flash Off

FE lock QFF

White Balance Mode Auto

AF Mode Manual focusing
Picture Style Landscape
Sharpness 4

Contrast o

Saturation a

Color tone 0

Color Space sRGE

Long exposure noise reduc... :Off

High 150 speed noise redu... 0:5tandard
Highlight tone priority 0:Disable

Auto Lighting Optimizer 3:Disable
Peripheral illumination corr...  Disable

Dust Delete Data No

File Size HRRA KB i

IMG_0001.CR2 =

(|| Shooting Information | Metadzta |

[Desmpn‘on

|

[Document Title]
RHREHAHH

[Author]
KA

[Author Tite]
X

[Description]
KN

[Description Writer]
KN

[Keywords]
XXHHHKIH

[Copyright Status]
KO

[Copyright Notice]
Peessvess

[Copyright info URL]
KN

-

Shooting information is displayed in the [Shooting Information]
tab sheet, while IPTC* information appended to the image after
shooting is displayed in the [Metadata] tab sheet.

IPTC* information provides additional comments on images,
such as captions, credits and the shooting location. The
information is sorted into 5 different categories and can be
viewed by selecting [Description], [IPTC Contact], [IPTC Image],
[IPTC Content] or [IPTC Status] from the list box in the [Metadata]
tab sheet.

IPTC* information can only be appended to JPEG/TIFF images
using Photoshop (CS3 or later).

* International Press Telecommunications Council (IPTC)

The contents of the [Shooting Information] tab sheet will vary
depending on the camera model.

S03
Switching displays
If a different image is selected in the main window when the image
information window is displayed, the image information for that image
will be displayed.

Difference with the [Thumbnail with information]

Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in [View]
menu » [Thumbnail with information] (p.10).

Convenient uses in the main window
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Editing an Image

This section explains how to adjust an image using the tool palette in the
edit window.

You can easily restore an image to its original condition with the []
button even if you have made the wrong adjustment. Try out the various
adjustments.

How to make adjustments using the [RAW] tool palette functions, and
how to adjust automatically with the [RGB] tool palette are explained in
this section.

Tool palette

File Edit — RAW [Ree [ /a0 [LEns.

Edit window

The image changes in real time according to adjustments
performed with the tool palette.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> +
<Z> keys.

|§| You can rotate an image in the [Adjustment] menu.
You can adjust an image while comparing the images before and
after adjustment (p.53).
You can synchronize multiple images and edit while comparing
them (p.54).
See p.130 for a list of edit window functions, and p.131 for a list of
tool palette functions.

About the RAW Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALQO] and [LENS] tab sheets according to your
editing requirements.

Adjustments similar to those that can be performed with the functions of
your camera can be performed using the functions of the [RAW] tool
palette. When the camera settings were incorrect during shooting, or
when the shooting result is not what you visualized, you can get closer
to what you envisaged with the [RAW] tool palette which is similar to the
camera.

All functions other than [RGB] tool palette automatic adjustment, and
each function of the [NR/ALO] and [LENS] tool palette are explained in
Chapter 3.

Editing with the Tool Palette in the Main Window

By clicking the [Tool Palette] button (p.127) in the toolbar on the main
window, the same tool palette that appears in the edit window is
displayed and you can edit images.
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Adjusting Brightness

Theb

rightness of an image can be adjusted. Move the slider to the right

to make the image brighter and to the left to make the image darker.

[raw  |ree | nrjaLo [LENS |

Reverts the image to

((® Jf+—the original settings

| Brightness adjustment

L 0.00 Enter a numerical value
|White balance adjustment| E”
@ 1 & 3 Registel
@ (Auto) | Tune... |

Drag the slider left or right

@ The adjustment range is —2.0 to +2.0 (in 0.01-stop increments when
entering a value).

Changing a Picture Style

If the image you shot is different to what you visualized, you can change
the Picture Style to get closer to what you envisaged.

Even if you have saved the image (p.41) with [Monochrome] (p.30)
selected, you can still change to another Picture Style at any point by
simply selecting a Picture Style other than [Monochrome].

Picture Style = Reverts the image to
'@ (standard) [ Browse... | the original settings
e ——— / , Select

7

:_r-/:./

-10.0 8.0 60 <40 -20 0.0 20 4.0

@ Even if the RAW image is from a camera that does not have
Picture Style settings, you can still set a Picture Style as long as
the RAW image is compatible with DPP (p.3).
You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style (p.94).
[Auto] is only applied to images shot with the EOS-1D X, EOS-1D C,
EOS 5D Mark Ill, EOS 6D, EOS 7D Mark Il, EOS 70D, EOS 700D,

EOS 100D, EOS 650D, EOS 600D, EOS 1200D, EOS M2 or EOS M.

When changing a Picture Style with several images selected, you
can select [Auto] if images shot with the EOS-1D X, EOS-1D C,
EOS 5D Mark Ill, EOS 6D, EOS 7D Mark I, EOS 70D, EOS 700D,
EOS 100D, EOS 650D, EOS 600D, EOS 1200D, EOS M2 or EOS
M are included. However, [Auto] is actually applied only to images
shot with the EOS-1D X, EOS-1D C, EOS 5D Mark Ill, EOS 6D,
EOS 7D Mark Il, EOS 70D, EOS 700D, EOS 100D, EOS 650D,
EOS 600D, EOS 1200D, EOS M2 or EOS M.

You cannot select [Auto] with multiple-exposure RAW images
created on the camera.
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Picture Style

@)

Standard

Auto

Portrait

Landscape

Neutral

Faithful

Monochrome

Description

The Picture Style set on the camera when the
image was shot.

When a mode in the Creative Zone is selected on
the camera, the Picture Style setin () is
displayed.

When a mode in the Basic Zone is selected on
the camera, [Shot settings] is displayed in ( ), and
image characteristics that are according to the
selected shooting mode are applied.

The image looks vivid.

Generally, this setting is suitable for most images.

The color tone will be adjusted to suit the scene.

The colors will look vivid. Especially the colors of
blue skies, greenery, and sunsets will be vivid in a
shot of nature, outdoor, or sunset scenes.

For nice skin tones.

Effective for close-ups of women and children. By
changing the [Color tone], you can adjust the skin
tone (p.30).

For vivid blues and greens.

Effective for making images of landscapes
impressive.

For natural colors and subdued images.
Effective for base images which are to undergo
adjustment.

When the subject is photographed under a color
temperature of 5200K, the color is adjusted
colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment.

For black and white images.
You can also adjust with [Filter effect] or [Toning
effect] (p.30).

Picture Style

(Picture Style file
registered in the
camera)

[Picture Style file
applied in DPP]

Description

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

The name of the Picture Style file applied in DPP
is displayed in [ ].

Picture Style File

A Picture Style file is an extended function file of Picture Style. See p.59
for how to use Picture Style files.
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Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source at the time of shooting an
image of, for example, pale-colored flowers.

I[Raw |res [ nr/ao | ens |
| Brightness adjustment =]
[ 0.00
| white balance adjustment [=Jit— Reverts the image to
(2] izl S— the original settings
@ (auto) || Tune...
| Select
& () is the white balance set on the camera when the image
was shot.

* When a mode in the Creative Zone is selected on the camera,
the white balance set in () is displayed.

* When a mode in the Basic Zone is selected on the camera,
[Shot settings] is displayed in (), and image characteristics that
are according to the selected shooting mode are applied.

* If you have corrected white balance, the correction value is
displayed in ().

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (this page).

-Z\@/E Tune with color tone
To make further fine adjustments to color tone after adjusting the white

balance, you can use [Color tone] (p.30) to get closer to your requirements.

® You cannot register the adjustment results as personal white
balance (p.1071) when you have selected [ ( )] from the list box.
You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

ﬁl Refer to your camera’s Instruction Manual for details on each white
balance setting.

Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

RAW |RGB |nNR/ALO | LENS |
‘ Brightness adjustment [E|
I 0.00
White balance adjustment [3”
1 2 3 Register... C”Ck
Iﬂ (Auto) - Tune...

Click on a point that is to be the standard for white.

TG 000cR
R v | Ao |18

‘ Click
The coordinates of the cursor position and Reverts the
the RGB values (8-bit conversion) image to the

original settings
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The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, right-click with the mouse or click

the [[* ]] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

5

The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.

You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to

the right to make contrast stronger and to the left to make contrast
weaker.

Reverts the image to
the original settings

|Picture Style (=

|ﬁ (Standard) v‘ Browse...

-3.0 8.0 5.0 40 20 0.0 Z0 40
Contrast:{(0}——7F
Highlight: {0}
Shadow: (0)

|| Linear
Color tone:{0)
Color saturation: (1)
[Unsharp mask VI
Strength:(0) i
Fineness:{0) [
Threshold: (0] I

Drag the slider left or
right (9 steps)

Displays the value of the setting

|
O~

=@< [Linear] - A function for advanced adjustment

Use [Linear] when you will be adjusting separately using image editing
software that has advanced editing functions. Note that when [Linear] is

checkmarked, the image will become dim.

@ The Auto Lighting Optimizer (p.61) will not function when [Linear] is

checkmarked.

Introduction

Contents at
a Glance

Basic
Operation

Advanced
Image Editing
and Printing

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

Reference

Index

00
©

29




Changing Color Tone and Color Saturation

Skin tone and overall color saturation can be adjusted.
If Picture Style (p.26) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (this page).

| Picture Style ( Reverts the image to
the original settings

@8 (standard)

v] Browse...

-10.0 8.0 60 =40 -20 00 20 40
Contrast:{0) f
Highlight: {0}
Shadow:(0)

I:iLinear

Color tone:{0)

Color saturation: (0)—
IUnsharp mask vJ
Strength:(0) 1

‘| Fineness:{0) [

Threshold: (0) [

0

0

{

1 | Drag the sliders left or
ll right

Displays the values of the settings

Mainly used for adjusting skin tones. Move the
slider to the right to make skin tones more
yellow, and to the left to make skin tones
redder.

Color saturation: The overall color depth of the image is
adjusted with color saturation. Move the slider
to the right to make the color deeper, and to
the left to make the color weaker.

Color tone:

ﬁl The adjustment range is —4 to +4 (in 1-stop increments).

Adjusting Monochrome

When the Picture Style (p.26) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering and with the
look of a single-color photograph.

Select [Monochrome] in the [Picture Style] list box.

|Picture Style = Reverts the image to
| Monochrame the original settings

vJ Browse...

-10.0 8.0 6.0 -0 -20 0.0 20

4
Contrast:{0) 1
Highlight:(0) {
Shadow: (0) - 1 I
" Eﬁect!:‘(d:::;r | Drag the sliders left or
Toning effect: (Mone) D rlght
Unsharp mask vI
Strength:(0) i
Fineness:{0) i
Threshold: (0) I}

Displays the values of the settings
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Filter effect: Creates an image where the white of clouds and the
green of trees are emphasized in the same
monochrome photograph.

Filter Example of effect
None General monochrome image without filter effect.

Blue sky is reproduced more naturally and white

Yellow
clouds emerge clearly.
Orange Blue sky becomes somewhat darker. The
9 brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

Toning effect: You can create a monochrome photograph to which a
single color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

ALy

== Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider closer to the right.

Adjusting Image Sharpness

You can make the overall atmosphere of an image sharper or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and
[Unsharp mask].
[Sharpness]: Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting), the more the edges are
emphasized for a sharper image.

[Unsharp mask]: Adjusts the image’s sharpness more finely.

[Strength]: Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting), the more the image’s edges are
emphasized for a sharper image.

Shows the fineness of the emphasized outline. The
further to the left the slider is moved (the smaller the
setting), the more fine detail can be emphasized.
Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges”.

[Fineness]:

[Threshold]:
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Select [Sharpness] from the list box and make the
setting.

|Picture Style (o) Reverts the image to
@ (standard) the original settings

v] Browse...

-10.0 8.0 60 40 -20 0.0 20
Contrast:{0)
Highlight: {0}

Shadaw:(0)
|_I Linear
Color tone:(0)

Color saturation:(0)

EJ Bl L e e R A T

Select [Sharpness]

([Sharpness -

Sharpness

|

Drag the slider left or right

Displays the value of the setting

@ The adjustment range is 0 to 10 (in 1-stop increments).

Detailed Setting of Image Sharpness

Select [Unsharp mask] from the list box and make
the setting.

Picture Style E3)
'8 (standard)

v] Browse...

-10.0 8.0 5.0 40 -2.0 0.0 2.0
Contrast:{0)
Highlight: {0}

Shadow:(0)
[~ Linear

Color tone: (0)
Color saturation: {0} {
([Unsharp mask

-)
Strengﬂ'uﬂ:i)— IB
Fineness lil
Threshold m

& E) EJ

=1

Select [Unsharp mask]

Drag the slider left or right

Displays the values of the settings

? The effects of sharpness adjustment appear unnatural

Adjust image sharpness with the window view set to [200% view],
[100% view] or [50% view]. If the view is set to [Fit to window] (full view),
the effects of adjustment may seem unnatural.
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Automatically Adjusting Brightness and Color (Tone Curve Assist)

In order to make the image a desirable standard image, the image tone
curve can be adjusted automatically (p.146). You can select the degree
of automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired
automatic adjustment button.
Standard: Standard automatic adjustment. Suitable for most
images.
High: Use when the effect achieved in standard automatic
adjustment is not strong enough.

rawl | Ree  Jurjaco [ ens |

|T0ne curve assist

(@7 (23 (=) Reverts the tone curve
[Tone curve adjustment 5] to the original settings

RG] (r](c][5] 7]
255 High

Standard

Ju}

Brightness: {1 1}
Contrast: L| 1]
Hue: U @ a
Saturation: D 100
Sharpness: (I @ 0

The tone curve changes as adjusted.

Ny
~ N

:@: Images not suitable for automatic adjustment (tone curve
assist)

The result of automatic adjustment (tone curve assist) may not be as
expected with the following images:

* Images which have been shot with the proper exposure

* Images where the brightness is unbalanced

* Images which are too dark

* Images which have extreme backlighting

@ If you click the [[iZ%]] button, the tone curve as well as the [Hue] and
[Saturation] revert to the default settings. Take care when adjusting
the [Hue] and [Saturation] individually (p.110).
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Editing Efficiently
Editing in the Edit Image Window

The thumbnail display and the edit window are combined, and images
can be edited efficiently while quickly switching between images to be
edited. Images to be edited are to be selected beforehand in the main
window.

In the main window, select the images you want to edit.

Switch to the edit image window.

(@ Sy
Info Select all Clear all
Folder
- Desktop
é...- il Libraries
ﬂ;—] Docurments
Click

The main window switches to the edit image window.

Edit the image.

Change the size

Select the image to be edited
The selected image is displayed as an enlargement
in the middle of the window

It may take time for the image to redraw itself.

The same tool palette as in the edit window is displayed and you
can edit the image.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> +
<Z> keys.

@ By selecting the [View] menu » [AF Point] in the edit window or edit
image window, you can display the AF points selected in the camera
at the time of shooting. However, AF points are not displayed for
images whose image size has been changed and then been
converted and saved (p.42, p.137), images for which you selected
an effect other than [Shot settings] as correction of fisheye lens
distortion aberration, or images which have had settings specified
during RAW processing on the camera for distortion correction and
chromatic aberration correction.
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Double-click the area you want to enlarge.

0 (M @

Double-
click

The area you double-clicked is enlarged to 100% (actual pixel
size).

To change the display position, drag on the image or drag the
enlargement display position (p.131) of the tool palette.
Double-click again to revert to the full view ([Fit to window]).

To return to the main window, click the [Main window] button on
the toolbar.

-Z\@E To display an image in an enlargement ratio other than 100%

Click the [50% view] or [200% view] on the toolbar.

5

You can change the way the tool palette is displayed (p.94).
You can change the enlargement ratio when you double-click
(p.93).

With the edit image window, you can only select images from a
single folder. To gather images from several folders for editing,
see “Gathering and Editing Images in the Collection Window”
(p-36).

For a list of edit image window functions, see p.136.
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Changing the Thumbnail Display Position to Horizontal

Select the [View] menu » [Change thumbnail
position].

Digital Photo.

\\\\\\

If you select [Change thumbnail position] again, the thumbnail
display reverts to the vertical position.

Gathering and Editing Images in the Collection Window

You can gather any randomly selected images together in the
[Collection] window for viewing, comparison and editing. You can gather
images from several folders as well as from only one folder, allowing you
to work with them efficiently.

Select images from the [Folder] window in the main

window, and select the [File] menu » [Add to collection].

File

Open in Edit window Ctrl+O
Open in Edit window (enlarged)

Save Ctrl+5S
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+T
Convert and save... Ctrl+D

Batch process... Ctrl+B
Create new folder...

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3

' Add to collection Ctrl+G
EMOVE 1T0M Collection Cirl+5hit+ G

Clear collection

Delete Del
Info Ctrl+I

Exit Alt+F4

The selected images are added to the [Collection] window and the
number of selected images is shown on the [Collection] tab sheet.
When you add RAW and JPEG images displayed as a single
image (p.22), the number of images shown on the [Collection]
tab sheet increases by 2.

You can select several images and add them to the [Collection]
window.

You can also add images to the [Collection] window by selecting
images, right-clicking with your mouse, and selecting [Add to
collection] from the menu that appears.

You can add up to 1,000 images to the [Collection] window.
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Select the [Collection] tab sheet.

Digital Photo Professi
File Edit Yiew Label Adjustment Tools Help

= i

1113

Folder Collection(14)

e

The selected images are displayed in the [Collection] window.

Bl Desktop
-+ Libraries
|ﬂl] Documents

Check displayed images in the [Collection] window.

Digital Phote P = (=
File Edit View Bookmark Label Adjustment Tools Window Help

SRGB | Adobe RGB High quality Recpe data: Yes Number of images: 7

Number of selected mages: 1

Edit the images.
You can now edit the images displayed in the [Collection]
window.
Images displayed in the [Collection] window are retained in the
[Collection] window even after exiting DPP.

s

=@>= To remove images from the [Collection] window

Removing randomly selected images
Select the images to be removed in the [Collection] window and then
select [Remove from collection] in the [File] menu. (You can also remove
images from the [Collection] window by selecting the images, right-
clicking with the mouse, and selecting [Remove from collection] from the
menu that appears.)
Note that even if you remove an image from the [Collection] window, the
original image remains unaffected.

Removing all images
Select [Clear collection] in the [File] menu. (You can also remove all
images from the [Collection] window by selecting one image, right-
clicking with the mouse, and selecting [Clear collection] from the menu
that appears.)
Note that even if you remove all images from the [Collection] window,
the original images remain unaffected.

@ Modifications to the image are applied to the original image
Modifications made to images added to the [Collection] window are
all applied to the original image.

@ You can arrange images displayed in the [Collection] window the
same way as in the [Folder] window (p.20, p.21). You can
maintain the order of rearranged images even after exiting DPP
by checkmarking [Retain sort order] on the [View settings] tab
sheet in the [Preferences] (p.93).

You cannot use the following functions in the [Collection] window.

+ Starting EOS Utility (p.7), or synchronizing folders with EOS
Utility

» Batch change the file name of images (p.104)
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Select the image to be trimmed.

Open the trimming/angle adjustment window.
Click the [Trimming Angle] button.

R —
v @@ @® @

Rotate right Quick Stamp  Trimming Batch
check Angle process

Rating # & & » »

_—

The trimming/angle adjustment window appears.
Editing can be done once the image is displayed clearly in the
trimming/angle adjustment window.

Trimming and Adjusting the Angle of an Image

You can crop only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before trimming. If
you select [Circle] for [Aspect ratio], the area outside the specified range
is only masked in black and the image will not be cropped.

Adjust the angle of the image as needed.

Trimming/angle adjustment window
000t CR2

(@ 1/ 1 EUser:\CANONPicture\Photo\osa: o

\\\\\\\\\

— Largest
possible
trimming
range

eeeeee

ﬁﬁﬁﬁﬁﬁﬁ — Click (rotate

image left
or right in
90-degree
increments)

ccccc

Drag* (0.01-degree increments;
adjustment range: -45 to +45 degrees)

Use the mouse (click A/V) to adjust the angle or
directly enter the adjustment angle* (0.01-degree
increments; adjustable range: -45 to +45 degrees)

* You cannot adjust the angle of images that exceed 9999 x 6666
pixels in size.

If you click [Center on Screen], you can display the trimming
range in the center of the window.

When correcting lens aberrations, it is recommended to perform
lens aberration correction before adjusting the angle of the
image.

If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming
range.

@ When aspect ratio information is attached to an image shot with the
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D
Mark Ill, EOS 5D Mark lll, EOS 6D, EOS 7D Mark Il, EOS 7D, EOS 70D,
EOS 60D, EOS 700D, EOS 100D, EOS 650D, EOS 600D, EOS 1200D,
EOS M2 or EOS M, the trimming range based on the aspect ratio
information is displayed.
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Select a ratio and drag the trimming range.

1/ 1 EUsers\CANON\Pictures\Photovo L.CR2

eeeeeeeeee ___Cancel

—Select a
trimming
ratio

nnnnn

eeeeeee

—Drag the
trimming
range

(704, 362) > (2281, 1413) = (1577 x1051) [1.50]

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range. (Not available
when [Circle] is selected.)

List of aspect ratios (width : height)

A Size Landscape
A Size Portrait
Letter Landscape
Letter Portrait
Custom

Cirde

[Free]: You can trim an image to any size, regardless of the
selectable ratio.

[Custom]: You can trim an image at the specified ratio.

[Circle]l: The area outside the specified range is masked in
black. The image is not trimmed.

Click the [OK] button to return to the main window.

The trimming range frame is displayed in the trimmed image
(p.129).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its timmed form.
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"2 About trimmed images

The trimmed range can be reverted to its original condition at

any time

A trimmed image is displayed or printed as a trimmed image.

However, since the image is not actually trimmed, you can always

revert to the original image by clicking the [Reset] button in the

trimming/angle adjustment window or performing the “Re-Editing an

Image” procedure (p.43).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.129).

 Edit window: The image is displayed in its trimmed condition.

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when
converted to a JPEG or TIFF image and saved (p.42).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark Ill, EOS-1D
Mark Ill, EOS 5D Mark Ill, EOS 6D, EOS 7D Mark Il, EOS 7D,

EOS 70D, EOS 60D, EOS 700D, EOS 100D, EOS 650D, EOS 600D,
EOS 1200D, EOS M2 or EOS M, the set trimming range based on the
aspect ratio information is displayed. Since the image is not actually
trimmed, you can change the trimming range or revert to the condition
before trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 5D Mark Ill, EOS 6D, EOS 7D Mark I,

EOS 70D, EOS 60D, EOS 700D, EOS 100D, EOS 650D, EOS 600D,
EOS 1200D, EOS M2 or EOS M, its trimming range cannot be
changed nor reverted to the condition before trimming, since the
image is actually trimmed and saved in the set trimming ratio.*

When reverting to the condition before trimming is performed based

on the aspect ratio information at the time of shooting, click the

[Reset] button. Also, if you want to cancel all the trimming range, click

the [Clear] button (p.138).

* When shooting with EOS 5D Mark Il or EOS 7D Mark Il, and [Add
cropping information] is set in Custom Functions, aspect ratio information

is only set and the image is not actually trimmed, even for JPEG images.

N

=)= Convenient functions of the trimming/angle adjustment

window

Switch between screens using the keyboard
You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys or the <F11> key.

Operate using the menu

Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the <Ctrl> key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <Shift> key.

© For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view the image in detail in the
trimming/angle adjustment window, so using this function is not
recommended.

@ For a list of the trimming/angle adjustment window functions, see

p.138.
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Applying Adjustment Contents to Other Images

You can copy the image adjustment contents (recipe) adjusted with the
tool palette and apply it to other images.

You can efficiently adjust multiple images by adjusting one image and
applying the results of this to multiple images shot in similar shooting
environment.

Select the adjusted image and then select the [Edit]
menu » [Copy recipe to clipboard].
The recipe is copied.

Select the image to which the recipe is to be applied
and then select the [Edit] menu P [Paste recipe].
The recipe is applied to the image.

|§| The recipe (p.99) can be saved as a separate file from the image
and loaded and applied to another image (p.100).

Saving Editing Results
Saving Editing Contents to a RAW Image

All the contents (recipe) adjusted with the tool palette as well as the
trimmed (p.38) range information can be saved to a RAW image or to a
separate RAW image.

The adjustments made with the tool palette (p.56 to p.69) and the dust
erase processing explained in Chapter 3 (p.75 to p.79) can also be
saved in a RAW image.

Select the [File] menu » desired item.
File
Open in Edit window Ctrl+0

Open in Edit window (enlarged)

Save Ctrl+5
Save As.. Ctrl+5Shift+5
Add thumbnail to image and save Ctrl+Shift+T
Convert and save... Ctrl+D
Batch process... Ctrl+B

Create new folder...

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 4
Add to collection Ctrl+G
Remove from cellection Ctrl+ Shift+G
Clear collection

Delete Del
Info Ctrl+I
Exit Alt+F4

Your adjustments are saved to the image.
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Saving as a JPEG or TIFF Image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

The image is saved as a separate image, so the RAW image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

File

Open in Edit window Ctrl+0
Open in Edit window (enlarged)
Save Ctrl+5
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+5Shift+T

( Convert and save... Ctrl+D
Batch process... Ctrl+B
Create new folder...
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
Add to collection Ctrl+G
Remove frem collection Ctrl+Shift+G
Clear collection
Delete Del
Info Ctrl+1
Exit Alt+F4

The [Convert and save] window appears.

Specify the necessary settings, and then click the

[Save] button.
By default, the image is converted and saved to a JPEG image

with the highest image quality, without changing the image size.

Change the settings according to your requirements.

—— Select the save
LY destination

-

File name: 1MG_0001
Save astype: Exif-JPEG("JPG,*JPEG) -

— Click and save

gl
H |

Image quality 0 1w

Output resolution 350 dpi [¥] Embeg 1CC profile in image:

Enter a file name and
select an image type

The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.

A

-:@/5 To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two different versions of DPP, processing results may
differ very slightly even if with the same RAW image data, or the results of
significant editing of RAW image data with an attached recipe may be different.
When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

@ By saving as explained on this page, a trimmed image (p.38) or
dust-erased image explained in Chapter 3 (p.75 to p.79) actually
becomes a trimmed image or dust-erased image.

You can reduce the noise characteristic of JPEG images which

occurs when you convert and save an image as a JPEG (p.92, p.93).

You can batch convert and save multiple images (p.102).
For a list of [Convert and save] window functions, see p.137.
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.25 to p.33), so the “original image data itself”
remains unaffected.

Also, the trimming range information of a trimmed image (p.38) is simply
saved to the image.

For this reason, you can undo any adjustments saved (p.41) to the
image, trimming information, and revert to the condition when last
saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Adjustrent |
Rotate Left Ctrl+L
Rotate Right Ctrl+R

Apply Dust Delete Data
Work color space 3

Tone Curve Assist - Standard

Tone Curve Assist - High

Ctrl+ Alt+Z
Ctrl+ Shift+Z

Revert to last saved settings
Revert to shot settings

The image reverts to the conditions of the selected item.

Printing an Image

This section explains how to print high-resolution photographs easily
with Canon inkjet printers compatible with the Canon printing software,
Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how to print
photographs using other printers.

Proceed to the page for the printer you are using.
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint EX (this page)
Printing Photographs with Canon Inkjet Printers Compatible with
Easy-PhotoPrint (p.46)
Printing Photographs with a Printer other than Canon Inkjet Printers

(p.49)

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint EX

You can perform the following types of photograph printing with Canon
inkjet printers compatible with Easy-PhotoPrint EX (hereinafter, “EPP
EX"):

Simple printing of RAW images

Printing with faithful colors

To perform this printing, it is necessary to first install EPP EX version 1.1
or later on your computer.
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Introduction

Select the image to be printed. In the EPP EX window, select the [File] menu »

[Preferences].

Start up EPP EX. [File] Contents at
Select the [File] menu » [Plug-in printing] » [Print with Easy- e e A ke
PhotoPrint EX]. Previous Step

Next Step
= : Basic
Open in Edit window Ctrl+O save ‘ Crles Operation
Open in Edit window (enlarged) save s
Preferences...
save il Frint. Cirl+F
Save As... Ctrle Shift+5 Ad\ac_ed
Add thumbnail to image and save Ctrl+Shift+T My Recent Files op fon
Convert and save... Ctrl+D Exit
Batch process... Ctrl+B .
The [Preferences] window appears. Advanced
Create new folder... . . . . . . |mage Ed|t|ng
= = In [Print Quality], select [Quality Priority], click the and Printing
Print with detailed setting... Crl+ Alt+P [Option] button. In the dialog box that appears,
Contact Sheet Prints... Ctrl+Shift+P i i i Processing
Plug-in printing Pu Print with Easy-PhotoPrint EX ] CheCKmark [Prlnt WIth the beSt quaIItY]. L'arge Numbers
= e e of Images
- o - —
Add to collection Ctrl+G et [dianced]
Remove from collection Ctrl+Shift+G .
Clear collection [ spool print job page by page Edltlng
Number of copies : 1 =/ Copies JPEG/T'FF
Delete Del Printing Orcer : [yp=se z Images
Tafs Chrlsl Amount of extension of borderless printing : Default - S —
Print Quality : Quality Priority = Se I eCt
Exit Alt+F4 : .
— Qqal!ty Reference
EPP EX starts up. Priority
—
Index
I _—_
[ OK. ] [ Cancel ] [ Help ] @ @
Click and checkmark [Print with the best quality] g;:
—_—
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Select the [Advanced] tab, checkmark [Enable ICC

profile], and then click the [OK] button.

The [Preferences] window closes.

Specify the number of sheets to be printed, and then

click [Select Paper].
EPP EX

3

@ Select Images E

@ Select Paper

——]
[® tavoutserint

 —T—

I

I

Y

Selections 15image(s)

e e el ™

WI_0001_ MG_0002_ WG_0003. MG_0004_NG_0005._IG_0005_IG_0007__IG_000B_ WIG_0003_WI_0010_ G001 HG_0012

Click

Click to
increase the
number of
sheets to be
printed

Select the paper type, and then click the [Layout/
Print] button.

New Photo Print -

Fle fdit View Help

Select the printer to use, then select the sz and type of paper for printng.

@ Select Images ]
3 F

hd

Exif Print

@ select paper

3

@ Layout/print |

T

[E—r—

Specify the layout, and then click the [Print] button.

Click

S New Photo Print -
Ele Edt View Help

Photo Print

Exif Print

@ Select Images

Select the
paper size
and type

Select the

[ »

N
Exit

a5
Help % EE

Click to print
Printing begins.

layout
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? Additional information

Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.

The printed image’s color is not what you expected

In the EPP EX window, select [Preferences] in the [File] menu and
then click the [Advanced] tab in the [Preferences] window to display
the [Advanced] tab sheet.

In the [Advanced] tab sheet, select [Enable ICC profile] in [Color
correction for printing] and try printing using the [Perceptual] setting
(p.147).

Ay

-@> Advantages of printing with EPP EX

Printing with faithful colors

When the color space (p.147) is set to sSRGB or Adobe RGB (p.79,
p.96), this color space is automatically transmitted from DPP to EPP
EX, allowing you to print with faithful colors.

When the color space is set to Apple RGB or ColorMatch RGB, the
image is printed with an sRGB color space, and when set to Wide
Gamut RGB, with an Adobe RGB color space.

Printing with a wide color reproduction

When the color space setting (p.79, p.96) is set to Adobe RGB and
the image is printed with a Canon inkjet printer, the color reproduction
range is wider, and green and blue in particular are reproduced
vividly.

|§| DPP is also compatible for printing with Easy-PhotoPrint Pro (p.89).

Printing Photographs with Canon Inkjet
Printers Compatible with Easy-PhotoPrint

You can perform the following types of photograph printing with Canon
inkjet printers compatible with Easy-PhotoPrint (hereinafter, “EPP”):
Simple printing of RAW images
High quality printing using the color reproduction range of Adobe RGB
and a Canon inkjet printer

To perform this printing, it is necessary to first install EPP version 3.5 or
later on your computer. When using an Easy-PhotoPrint EX-compatible
inkjet printer, it is recommended that you print using Easy-PhotoPrint EX
(p-43).

Select the image to be printed.

Start up EPP.
Select the [File] menu » [Plug-in printing] » [Print with Easy-
PhotoPrint].

Cpen in Edit window Chrl+O

Open in Edit window (enlarged)

Save Chrl+3
Save As... Ckrl+5hifk+5
Add thumbnail ko image and save  Cerl+Shift+T
Convert and save... Ckrl+D
Batch process... Chrl+B

Creake new folder ...
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Print... Chrl+P

Print with detailed setting. .. Chrl+Alk+P
Contack Sheek Prints. .. Ckrl+Shift+P
add ko collection Chrl+G

Remove Fram collection Ckrl+Shift+G

EPP starts up.
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In the EPP window, select the [File] menu »
[Preferences].

Preferences. ..
Exit

The [Preferences] window appears.

In [Print Quality], select [Quality Priority].

Preferences fg‘

] Spoal print job page by page

Mumber of copies : 1 2] Copies

Printing Drder : [By Date v

Amount of exterion of barderless printing: | Defaut v

Print Cuality : Select
Quality
Priority

[ 0K | [ Cancel ] [ Help ]

Select the [Advanced] tab sheet and check that the
EPP image compensation function is disabled.
If not disabled, the operation of the EPP image compensation
function may prevent images being printed with faithful color

reproduction.
Preferences [E|
_.Pr.int : i_Aavanced_|
— _ If checked,

Image [0 ptimize images autornatically

Apply Rotate/Trimming ta the same images in the same manner C“Ck tO

‘When landscape images are rotated depending on the selected layout : remove the

(%) Rotate Left h k
mark
) Rotate Right chec a

Layout [ &heays trim when you select the layout with the marging

Set marging to the minimum when you select the lapout with the marging

Print filznarme when vou select the index in lapout

Preview all layouts of &4 and Letter
Image
Selection .

Click to
close the
Defauts window
\
[[ 0k l I Cancel ] [ Help ]
v 4

Specify the number of sheets to be printed, and then

click [Next].

toPrint

eeeeeeee

Easy;_, hotoPrint
() 5| )

— Click

— Click to
increase the
number of
sheets to be
printed
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Introduction
Check that the image compensation function is 2 Additional information

disabled, select the paper type and then click [Next]. :

If checked, click to remove the check marks ® Print up to 1000 images at a time Contents at

You can print up to 1000 images selected in DPP at a time. When a Glance
printing more than 1000 images, divide the printing into several jobs.
© The printed image’s color is not what you expected
Click Change the [Rendering intents when using Easy-PhotoPrint] (p.95) to Basic
[Perceptual] (p.147) and print. Operation

Select the "
paper type == Printing with a wide color reproduction édg{:ed
o] ion
When the color space (p.79, p.95) is set to Adobe RGB and the image is
printed with Canon inkjet printer, the color reproduction area widens,
and green and blue in particular are reproduced vividly. Imﬁd‘éaggﬁ?n
When the color space is set to Apple RGB or ColorMatch RGB, the ang Printingg
image is printed with an sRGB color space, and when set to Wide
Gamut RGB, with an Adobe RGB color space. .
Processing
= = Large Numbers
|§| DPP is al tible f inti ith E PhotoPrint P 89 STINELEE
8 Specify the layout, and then click [Print]. is also compatible for printing with Easy-PhotoPrint Pro (p.89).
@ tasy Photoprint CEX Editin g
= JPEGI/TIFF
Images
Click to print
Reference
Index

Select the layout @

=» Printing begins.
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Printing Photographs with a Printer other than Canon Inkjet Printers

You can print one image on one sheet of paper.

Select the image to be printed.

Select the [File] menu » [Print].

File

Open in Edit window Ctrl+0
Open in Edit window (enlarged])

Save Ctrl+5
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+T
Convert and save... Ctrl+D
Batch process... Ctrl+B
Create new folder...

[ Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing
Add to collection Ctrl+G
Remowve from collection Ctrl+5Shift+G
Clear collection
Delete Del
Info Ctrl+1
Exit Alt+F4

The [Print] dialog box appears.

Set to photograph printing and print.
Specify the optimum settings for photograph printing in the
printer’s print settings dialog box and click the [OK] button.

Printing begins.

Organizing Images
This section explains how to delete unwanted images, create folders for
saving images, move or copy images, etc., and organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Delete].

File

Open in Edit window Ctrl+0
Open in Edit window (enlarged)
Save Ctrl+5
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+ T
Convert and save... Ctrl+D
Batch process... Ctrl+B
Create new folder...
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
Add te collection Ctrl+G
Remove from collection Ctrl+Shift+G
Clear collection

[ Delete Del
Info Ctrl+I
Exit Alt+F4

The [Confirm File Delete] dialog box appears.

Click the [Yes] button.
The image is moved to the [Recycle Bin] and is deleted from DPP.
The images are deleted completely from your computer when the
[Empty Recycle Bin] operation is performed on the [Recycle Bin]
on the desktop.
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Creating a Folder for Saving Images

You can create a folder for sorting images.

In the folder area, select the location where the new
folder is to be created.
(@) Digital Photo Professional - [E\Users\ CANON\Pictu

File Edit Vi kmark Label Adjustment Tools Window Help
Tool Info Selectall  Clearal Rotste left Rots
Palette

| Folder Collection(0)

B Desktop
- Libraries

| Documents

Select the [File] menu » [Create new folder].

File
Open in Edit window Ctrl+O
Open in Edit window (enlarged)
Save Ctrl+5S
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+T
Convert and save... Ctrl+D
Batch process... Ctrl+B
( Create new folder...
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 3
Add to collection Ctrl+G
Remove from collection Ctrl+Shift+G
Clear collection
Delete Del
Info Ctrl+I
Exit Alt+F4

The [Create new folder] dialog box appears.

Enter a folder name and click the [OK] button.
The new folder is created in the folder selected in step 1.

Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <Ctrl> key and
release when the image is in the destination folder.

il Digital Photo Professional - [EAUsers\CANON\P

Eile Edit View mark Label Adjustme ow Help

2 @

‘ Folder Collection(0)

B Desktop
'} [ Libraries

B ®®

Info Selectall Clearal  Rotsteleft Rob)

-5 Documents
HTI,J‘t Music
== Pictures
J- . Phote

| Sample Pictures
-5 Videos
(11 # Homegroup
- B CANON
[#-78 Computer
-l Metwork

=
Travel <l

™

=

The images are moved or copied to the destination folder.

£l
2
2]
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Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <Ctrl> key and
release when the folder is in the destination folder.

@ Digital Photo Professional - [EAUsers\CANON\Pict \oocx_ok_]
E\\e Edit View Bookmark Label Adjustment T Help

2 @

Tool Info Selectall  Clearal  Rolsteleft Rot|
alette

(1] #dy Homegroup
- & CANON
[#-788 Computer
- Network
-0 Travel

The folders are moved or copied to the destination folder.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders appear by clicking the [Bookmark] menu.

Select the folder for which a bookmark is to be
registered.

B Desktop

(=i Libraries

- Documents
gl Music
=-Ji= Pictures

Select

-5 Videos

[+ Homegroup

- A CANON @ &

[#-78 Computer IMG_0001.CR2 ™
-6l Metwork

Travel

ro

Select the [Bookmark] menu » [Add].
The folder selected in step 1 is registered in the [Bookmark]
menu.

Select a registered folder from the [Bookmark] menu to display
images in the selected folder in the main window.

Organizing Bookmarks

You can change a folder name or delete a folder registered in
[Bookmark].

Select the [Bookmark] menu » [Organize].
The [Sort bookmarks] window appears and you can change
folder names or delete folders.
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3 Advanced Image Editing and Printing

Various preferences including advanced image adjustment, automatic
dust erasure processing, various printing functions for printing out work,
and color management are explained here, geared to the user who is
competent in the handling of third-party image editing software.

Adjusting While Comparing with the Original Image... 53
Changing How the Window is Split............................ 53

Adjusting by Comparing Multiple Images................. 54

Displaying an Area Beyond the Set Range as a
Warning Indicator (Highlight/Shadow Warning) ....... 95

Performing Advanced Editing.............cccoeeviiiiinnn. 56
Adjusting White Balance with Color Temperature ..... 56
Tuning White Balance with Color Wheel ................... 56
Adjusting Dynamic Range ............cccccciiiiiieeeeeeeeeennns o7
Adjusting Brightness of Shadows/Highlights ............. o7
Tone Curve Adjustment.............ccooiiiiieee e 58

Example of a Tone Curve Operation ..................... 59
Using a Picture Style File..........ccoooiiiiiiiieeee 59
About the RGB Tool Palette ............ccccciiieeeeeineennn, 60

Using the Auto Lighting Optimizer..........ccccccvvveennn... 61

Reducing NOISE.........coviiiiiiiie e, 62

Correcting Lens Aberration ..........cccoooovviiiiiienennnnnnn. 63
Compatible Cameras.........ccccoeeeiiiiiiii 63
Compatible Lenses.......ccccooveieiiiiiiiiiiee 63
Making Corrections............cceevvveeeeiiiiiciiiiieeeeeeee e 65

Effects of Distortion Aberration Correction for Fisheye

LENSES ...ttt 66
About Shooting Distance Information Slider.............. 68
Correcting Multiple Images ata Time..............c......... 69

Using the Digital Lens Optimizer ............ccccccooooo. 70
Compatible Cameras..........ccccceevvvvvveveevriiiiriiiians 70
Compatible Lenses...........cooovvvviviiiiiiieeeieeeeiiieviviinis 70
Using the Digital Lens Optimizer.............cccccveeeenne... 72

Performing Automatic Dust Erasure Processing ..... 75
Compatible Cameras..........cccoeeeeeiiiiiiieieeeeeeeeeeenn. 75
Automatic Dust Erasure Processing in the Main Window... 76

Manually Erasing Dust (Repair Function)................ 77
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCLON)......iiiiiiiiiieee e 79

Transferring a RAW Image to Photoshop................ 79

Setting Work Color Space .........cccoooevvvvviiiiieeeeeinnn. 79

Compositing Images.........coovvvveeiiiiiiiieecieeeeeeen, 80
Compositing Methods.............oooiiiiiiiiie, 83

Creating HDR (High Dynamic Range) Images........ 83

Starting Up Map Utility ..., 86

Printing with Shooting Information........................... 87

Printing a Thumbnail List (Contact Sheet Printing)...... 88

Printing RAW Images on a High-End Canon Printer ... 89
Printing with a High-End Canon Inkjet Printer ............ 89

Printing with DPP and Easy-PhotoPrint Pro........... 89
Printing with DPP and Print Studio Pro .................. 90
Printing with a Large-Format Canon Printer............... 91

Specifying Preferences...........cccovviiiiiiiiiiiieeee 91
General SettingS......ccovvvieieiiiii e 92
View SettingS....coovveiiiiiiieee e 93
TOOlI Palette ......oooveeeeeee e 94

Color Management.........ccouveeeeeiiiccciiiiiiieeee e 95
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Adjusting While Comparing with the Original Image

You can display before and after versions of an adjusted image in the
same window and adjust while checking the adjustment results.

Introduction
Changing How the Window is Split NER—

You can change the display of the image to a single image split in two.

Contents at

In the edit window, select the [View] menu » [Before/ a Glance

after comparison]. In the edit window, select the [View] menu » [Display L
— mode] » [Split single image].

Basic
Operation

—

Advanced
Operation

Imaggiltmg
and Pfinting

One image is divided and displayed on the left and right or top

The image divides into a left and right window. )
: . : " and bottom. Processing
The window on the right shows the image after editing. To switch between top and bottom, and left and right, perform the Laggf‘irﬂ:mg:rs
Change the image display. same operation as step 2 on the left page. =_94
Select the [View] menu » [Change up/down/left/right] » [Up/ Editing
down]. JPEGI/TIFF
= Images
—
Reference
—
Index
The layout of the two images changes to top and bottom. @ @
The bottom window shows the image after editing. @

|§| Images can also be displayed in the edit image window by the same

operation.
53



Adjusting by Comparing Multiple Images

You can synchronize the display position of multiple edit windows and
adjust images while comparing them with each other.

In the edit window, display the multiple images to be
compared.

Align the images.
Select the [Window] menu » [Arrange vertically] or [Arrange
horizontally].
The edit windows are aligned.

Select the [Window] menu » [Synchronize].

Enlarge the image.
Enlarge and display any of the edit windows.

The other edit windows will also be displayed in the same
position/enlargement ratio.

Move the display position.
If you move the enlargement display position in one of the edit
windows, the enlargement display position will also change in the
other edit windows.
To cancel synchronization, select the [Window] menu »
[Synchronize] again.

@ Synchronization only applies to the enlargement display position
and the enlargement ratio. Adjustments to the images are not
synchronized.
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Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning) _
Introduction
You can set up a warning indicator in both the highlighted part and the Display the edit window.
shaded part, which is effective for checking the bright and dark areas
and preventing excessive adjustment of an image. Where the area on . . . . .
the image has exceeded the set range, you can display the highlighted Select the [View] menu » [Highlight]. Similarly, select C:rgfan:(s:eat
part in red and the shaded part in blue. [Shadow].
On the opened image, if there is an area that exceeds the value
Select the [Tools] menu » [Preferences]. entered in step 3, the highlighted part of that area is displayed in Basic
red and the shaded part is displayed in blue. Operation
Select the [View settings] tab sheet.
Advanced
Enter the warning value for [Highlight] and [Shadow]. RESTatigy
L,g?nffﬁtgngs, 7| View settings ‘ Tool palette I Color management ‘ Ad ced
Grdptch Imaggjiting
64 Pixels(8-256) and nting
[¥] images opened in Edit window remain selected in main window ProceSSi ng
Large Numbers
Magf’viﬁfaﬁon in Edit window - of Images
Magnification when the Edit/Edit image window is double-licked Ed iti ng
) 50% @ 100% ) 200% JPEGITIFF
RAW and JPEG Images
Sor: o:r:e;ln mal: w:\dow Refe rence
Highlight/shadow Alert
Highlight 255 192-255) .
Shadow 0 0-64) . I ndex
Quick check tool display —_/
@ 50% () 100% (moiré reduction off)
e 00
Click the [OK] button to close the window. @

@ You can also display the warning with the same operation in the edit

image window.
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Performing Advanced Editing

This section explains how to use the advanced adjustment function on
the tool palette in the edit window.

Adjustments made using the high-level functions of the [RAW] and
[RGB] tool palettes, as well as the functions of the [NR/ALO] and [LENS]
tool palette are explained in this section.

Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

[raw  |ReB [ nR/aLO [ LENS |

| Brightness adjustment E”
{l 0.00
| White balance adjustment E”
) 2] —
gor temperature _P“ Tune... ]
(00 k|- Displays the value of the

setting
Drag the slider left or right

|§| The adjustment range is 2500 to 10000K (in 100K increments).

Tuning White Balance with Color Wheel

White balance can be tuned by moving a cursor in the color direction
shown in the color wheel.

In the [RAW] tool palette, click the [Tune] button.

Tune by dragging a point.
You can also fine-tune your adjustment by directly entering the
adjustment values.

White balance fine adjustment

Color tone:

Enter the values to set

Color saturation:

© To register adjustment results as personal white balance (p.101),
select a setting other than [ @& ( )] from the [White balance
adjustment] list box, and then tune with the color wheel. You
cannot register the adjustment results as personal white balance
when you have selected [ ( )] from the list box and have done
any tuning.

You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

@ The adjustment range of color tone is 0 to 359 (1 increment in
numerical value input), and the adjustment range of color saturation
is 0 to 255 (1 increment in numerical value input).
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Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Picture Style E3)
@ (Standard)

vl[ Bro‘wse... ]

Move downwards
Output highlight points

Move to the left or rignt
Input highlight points

Al

-10.0 " " o i"

Contrast: (0)

Highlight: {0}

Shadow:(0)

|:| Linear

Color tone:(0)

Color saturation: (1)

[Unsharp mask v]
Strength: (0) [
Fineness: (D) 0
Threshold: (0) [}

(=]

Move upwards
Output shadow points

‘= i | e i B N e

Move to the left or right
Input shadow points

The horizontal axis shows the input level and the vertical axis
shows the output level.

Adjusting Brightness of Shadows/Highlights

You can adjust the brightness of shadows and highlights in an image.
By adjusting shadows and highlights in an image with a restricted
brightness, you can reduce the effects of clipping in shadows and
highlights.

Picture Style =]
Iﬂ (Standard) v] Browse, ..

o
'

[ L ._
-10,0 8.0 60 40 -20 0.0 20
Contrast: (0)
Highlight: (i0)

Shadow: (D)
|:| Linear

Color tone: (0}

Color saturation:{0)

[Unsharp mask VI
Strength: (0) 1}
Fineness: (0) 1
Threshold:(0) I}

B S R e
=

| Drag the sliders left or
right

-4 8O-
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Tone Curve Adjustment

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.146).

Make adjustments.

In the tool palette, select the [RGB] tab sheet.

Select the tone curve mode and interpolation

method.
RAW | RGE  |NR/ALO | LENS |
| Tone curve assist @ |
|Tone curve adjustment |

Lors  J[R][c][e] 3]

255

@ Curve

Straight

@ RGERGB

Lurminance R G B

Brightness:

Confrast:

=

Hue:

Saturation:

e

Sharpness: I

255

®]o
(5] 100
B o

Right-click with the
mouse inside the graph
to display the menu

RAW | RGB |NR/ALO | LEns |

|Tor|e curve assist

([0 (I)[35)

|Tone curve adjustment

|
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Saturation:
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Adjusts each channel
Batch adjusts RGB

Click to add a [[] (point)
Adjust by dragging [[]

The horizontal axis shows the input level and the vertical axis
shows the output level.
The maximum number of [[] is 8.

To delete a [[1], either press the <Del> key or double-click on the [[].

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any

adjustments (p.94).

The tone curve mode and interpolation method for a tone curve
can also be changed in [Preferences] (p.94).
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Example of a Tone Curve Operation
Makes medium tones brighter

Makes medium tones darker

Makes tones sharper

Makes tones softer

Using a Picture Style File

A Picture Style file is an extended function file of a Picture Style.

With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon website effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Display the image to which the Picture Style file is to
be applied in the edit window (p.11).

Select the [RAW] tab sheet in the tool palette, and
click the [Browse] button.

Browse...

|Picture Style
@ (standard) -

-10.0 80 60 40 -20 00 20

4.0

The [Open] dialog box appears.

Select a Picture Style file saved on your computer,
and click the [Open] button.
The Picture Style file you selected is applied to an image.

To apply a different Picture Style file, follow the procedure from
step 2 again.

@ The Picture Style files that you can apply to the camera are files with
the “.PF2” or “.PF3” extension only. Furthermore, you cannot apply
Picture Style files with the extension “.PSE” to an image; however if
such a file is registered in the camera and the image is shot, the
image will display correctly.
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About the RGB Tool Palette

You can adjust images with the tool palette by switching between the
[RAW], [RGB], [NR/ALQO] and [LENS] tab sheets according to your
editing requirements.

The [RGB] tool palette functions are the same as ordinary image editing
software, such as tone curve adjustment that is explained here, with
which you can adjust RAW images.

However, because the adjustment width of the functions in the [RGB]
tool palette is wider than the [RAW] tool palette, the image color may be
saturated, or the image quality may deteriorate if you adjust too much.
Therefore we recommend for functions other than tone curve
adjustment (p.58) and automatic adjustment (p.33), that you adjust
images using the same functions available in the [RAW] tool palette.
See Chapter 5 for explanations on functions of the [RGB] tool palette
other than tone curve adjustment.

5@/3 Using the tool palette

We recommend that as a general principle you edit RAW images using
the [RAW] tool palette. However, where the adjustment width with the
[RAW] tool palette is not wide enough and you wish to use the special
functions in the [RGB] tool palette, we recommend that you adjust your
images at the necessary lowest limit with the [RGB] tool palette after
having completed basic adjustment with the [RAW] tool palette.

Use the adjustment function of the [NR/ALO] and [LENS] tool palette
(p.132) when applying the Auto Lighting Optimizer (p.61), reducing
noise (p.62) or correcting aberration (p.63) after you have made any
required adjustments with the [RAW] and [RGB] tool palettes.
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Using the Auto Lighting Optimizer .
Introduction

If the shooting result is dark or the contrast is low, you can use the Auto Checkmark the checkbox.

Lighting Optimizer function to auto-correct the brightness and contrast, —_— : —

and obtain a more pleasant image. Raw [RGB | NRIALO [iens |

You can also change the settings of the image shot with the camera’s | Auto Lighting Optimizer | Checkmark Cgrgfannt(s:eat

Auto Lighting Optimizer function. = 0

This function is compatible only with RAW images shot with EOS-1D X, —~ Low Standard Strang

EOS-1D C, EOS-1D Mark IV, EOS 5D Mark Ill, EOS 5D Mark Il, EOS 6D, Basic

EOS 7D Mark II, EOS 7D, EOS 70D, EOS 60D, EOS 50D, EOS 700D, For images shot with the camera’s Auto Lighting Optimizer Operation

EOS 100D, EOS 650D, EOS 6OOD, EOS 550D, EOS 5OOD, EOS 1200D, function’ the checkbox is a|ready checked.

EOS 1100D, EOS M2 and EOS M. . .

* ALO stands for Auto Lighting Optimizer. Change the settings according to your preferences. Advanced
RAW | RGE | MRIALO | LENS | ok

Select the [NR/ALO] tab sheet from the tool palette in

| Auto Lighting Optimizer |

the edit window or edit image window. e W Advapced
e ey i : Select from three levels: Imagegditing
oo R AL /0 [ | 1 e g e Low/Standard/Strong and Pfinting
| Auto Lighting Optimizer |
& 1 Auto correction is applied to the image to match the settings. Processing
| L ELEk Sl For images shot with the camera’s Auto Lighting Optimizer Large Numbers
e | function, the settings at the time of shooting are applied as the of Images
— default values. —
RANe To cancel the Auto Lighting Optimizer, remove the check mark JF’EEd(I;/I?IgFF
Luminance noise reduction:{1)
o 0 . from the checkbox. Images
Chrominance noise reduction:(3)
0 { 20
TIFF/IPEG Reference
Index

EOS-1D C, EOS 5D Mark Ill, EOS 6D, EOS 7D Mark Il, EOS 7D,

EOS 70D, EOS 60D, EOS 700D, EOS 100D, EOS 650D,

EOS 600D, EOS 550D, EOS 1200D, EOS 1100D, EOS M2 and @
EOS M, the Auto Lighting Optimizer function cannot be set.

You cannot use the Auto Lighting Optimizer with multiple-

exposure RAW images created on the camera.

© When [Highlight tone priority] is set to [Enable] in EOS-1D X, @ @
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Reducing Noise

You can reduce noise that arises in RAW images shot at night or with a
high ISO speed.
NR is an abbreviation for “noise reduction”.

Select the [NR/ALO] tab sheet from the tool palette in
the edit window or edit image window.

Click the [NR Preview] button.

| Moise reduction Appl |

[ [ MR Preview... I

AW

The [NR Preview] window appears.

Adjust an image.

Navigator
window

—Enlargement

display
| Raw position
Luminance noise rj n:{7)
o L = Drag the
Chrominance noise, tion:(8) .
D 0 o sliders

NR check window

You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.

The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.

You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Click the [Apply] button.

Noise reduction is applied to the image and the image is
redisplayed.

? The noise reduction function does not work

Noise reduction cannot be applied when [Viewing and saving RAW
images] (p.92) is set to [High speed] in the [Preferences] window.
Select [High quality] to reduce noise.

Ny
== To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/ALO]
tool palette (p.132) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

5

You can set the default noise reduction beforehand, using
[Default noise reduction settings] in the [Tool palette] tab sheet in
the [Preferences] (p.94).

* When [Apply camera settings] is selected, you can pre-set a
noise reduction level that suits the camera settings beforehand
as the default.

* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand. This is
particularly useful for applying noise reduction to all the images
in a folder at once, such as batch noise reduction for images
with high ISO speeds.

However, for images with recipes attached, the noise level

recorded in the recipe will be applied.

If [Luminance noise reduction] has been set, resolution may be

reduced along with reduction of noise.

If [Chrominance noise reduction] has been set, color bleeding

may occur along with reduction of noise.

For a list of [NR Preview] window functions, see p.134.
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Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

Please note that you can only correct RAW images which have been
taken with the compatible cameras and lenses listed below. JPEG or
TIFF images cannot be corrected.

Compatible Cameras

EOS-1D X
EOS-1Ds Mark lli
EOS-1Ds Mark Il
EOS-1D

EOS 5D*1

EOS 7D

EOS 50D

EOS 700D

EOS 600D

EOS 450D

EOS 1100D
EOS M

EOCS-1DC
EOS-1D Mark Il
EOS-1D Mark Il
EOS 5D Mark Il
EOS 6D

EOS 70D

EOS 40D

EOS 100D

EOS 550D

EOS 400D DIGITAL
EOS 1000D

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

EOS-1D Mark IV
EOS-1D Mark II N
EOS-1Ds

EOS 5D Mark I
EOS 7D Mark Il
EOS 60D

EOS 30D*2

EOS 650D

EOS 500D

EOS 1200D
EOS M2

Compatible Lenses

Fisheye, ultra wide, and wide angle lenses

EF14mm f/2.8L USM
EF8-15mm f/4L USM Fisheye*3
EF20mm /2.8 USM

EF24mm f/1.4L 1l USM*3
EF24mm /2.8 IS USM*3
EF28mm /2.8

EF35mm f/1.4L USM

EF35mm f/2 IS USM*3

EF14mm f/2.8L Il USM*3
EF15mm f/2.8 Fisheye*3
EF24mm f/1.4L USM
EF24mm /2.8

EF28mm /1.8 USM
EF28mm f/2.8 IS USM*3
EF35mm f/2

Standard and medium telephoto lenses

EF40mm f/2.8 STM*3
EF50mm f/1.4 USM
EF50mm /1.8 Il
EF85mm f/1.2L Il USM*>
EF100mm f/2 USM

EF50mm f/1.2L USM*4
EF50mm /1.8
EF85mm f/1.2L USM
EF85mm /1.8 USM

Telephoto lenses

EF135mm f/2L USM

EF200mm f/2L IS USM*3
EF200mm f/2.8L Il USM
EF300mm f/2.8L IS USM
EF400mm f/2.8L IS USM
EF400mm f/4 DO IS USM
EF500mm f/4L IS USM
EF600mm f/4L IS USM
EF800mm f/5.6L IS USM*3

EF135mm /2.8
(with Softfocus mechanism)

EF200mm f/2.8L USM
EF300mm f/2.8L IS Il USM*3
EF300mm f/4L IS USM
EF400mm f/2.8L IS Il USM*3
EF400mm f/5.6L USM
EF500mm f/4L IS Il USM*3
EF600mm f/4L IS Il USM*3
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Zoom lenses

EF16-35mm f/2.8L USM
EF16-35mm f/4L IS USM*3
EF17-40mm f/4L USM
EF24-70mm f/2.8L USM
EF24-70mm f/4L IS USM*3
EF24-105mm /4L IS USM
EF28-90mm f/4-5.6 USM
EF28-90mm f/4-5.6
EF28-90mm /4-5.6 Il
EF28-105mm /3.5-4.5 1| USM
EF28-105mm f/4-5.6
EF28-200mm /3.5-5.6
EF28-300mm /3.5-5.6L IS USM
EF55-200mm f/4-5.6 USM
EF70-200mm /2.8L IS USM
EF70-200mm f/4AL USM
EF70-300mm f/4-5.6L IS USM*3
EF70-300mm f/4.5-5.6 DO IS USM
EF75-300mm f/4-5.6 111*3
EF75-300mm f/4-5.6 Il USM
EF90-300mm f/4.5-5.6
EF100-300mm f/4.5-5.6 USM
EF200-400mm f/4L IS USM*3

EF16-35mm f/2.8L Il USM*3
EF17-35mm f/2.8L USM
EF20-35mm /3.5-4.5 USM
EF24-70mm f/2.8L Il USM*3
EF24-85mm /3.5-4.5 USM
EF28-70mm f/2.8L USM
EF28-90mm f/4-5.6 1l USM
EF28-90mm f/4-5.6 Il
EF28-105mm /3.5-4.5 USM
EF28-105mm /4-5.6 USM
EF28-135mm f/3.5-5.6 IS USM
EF28-200mm f/3.5-5.6 USM
EF55-200mm f/4.5-5.6 1| USM
EF70-200mm f/2.8L USM
EF70-200mm f/2.8L IS Il USM*3
EF70-200mm f/4L IS USM*4
EF70-300mm f/4-5.6 IS USM
EF75-300mm f/4-5.6 11*3
EF75-300mm f/4-5.6 USM
EF75-300mm /4-5.6 |Il USM
EF90-300mm f/4.5-5.6 USM
EF100-400mm f/4.5-5.6L IS USM

Macro lenses

EF50mm /2.5 Compact Macro*3
EF100mm f/2.8L Macro IS USM*3

MP-E65mm f/2.8 1-5x Macro
Photo*3

EF100mm /2.8 Macro USM
EF180mm /3.5L Macro USM

5

EF-S lenses
EF-S60mm /2.8 Macro USM EF-S10-18mm /4.5-5.6 IS STM*3
EF-S10-22mm f/3.5-4.5 USM EF-S15-85mm /3.5-5.6 IS USM*3
EF-S17-55mm /2.8 IS USM EF-S17-85mm f/4-5.6 IS USM
EF-S18-55mm f/3.5-5.6 IS STM*3 EF-S18-55mm f/3.5-5.6
EF-S18-55mm /3.5-5.6 1| EF-S18-55mm f/3.5-5.6 111*3
EF-S18-55mm /3.5-5.6 USM EF-S18-55mm /3.5-5.6 1| USM
EF-S18-55mm f/3.5-5.6 1S*3 EF-S18-55mm f/3.5-5.6 IS II*3
EF-S18-135mm /3.5-5.6 1S*3 EF-S18-135mm f/3.5-5.6 IS STM*3
EF-S18-200mm /3.5-5.6 1S*3 EF-S55-250mm f/4-5.6 1S*3
EF-S55-250mm /4-5.6 1S 11*3 EF-S55-250mm /4-5.6 IS STM*3

EF-M lenses
EF-M22mm /2 STM EF-M11-22mm f/4-5.6 IS STM
EF-M18-55mm /3.5-5.6 IS STM  EF-M55-200mm /4.5-6.3 IS STM
Aberration correction will not apply to images shot with a combination of

lenses *3 *4 *5 agnd EOS 5D or EOS 30D with the firmware versions below.

* You cannot attach an EF-S lens to EOS 5D.

*3 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.5 or earlier

*4 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

*5 EOS 5D with firmware version 1.0.5 or earlier, EOS 30D with
firmware version 1.0.4 or earlier

You can also correct RAW images taken with the compatible lens
even when the extender is attached.

You can also correct RAW images shot with EF50mm /2.5
Compact Macro fitted with Life Size Converter EF.

The aberration correction function is not available for images shot
with combinations of camera/lens other than those given under
“Compatible Cameras” and “Compatible Lenses”. They are
therefore not displayed and cannot be used.

The lens aberration correction function is not available for
multiple-exposure RAW images created on the camera.

EF cinema lenses (CN-E lenses) are not compatible.
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Making Corrections

You can make corrections to any of the four aberrations as below, either
one at a time or simultaneously.
Peripheral illumination
Chromatic aberration (color fringing which occurs in the periphery of
an image)
Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)
Distortions

In the tool palette, select the [LENS] tab sheet.

Click the [Tune] button.

RawW | RGB | NR/ALO | LENS |

| Digital Lens Optimizer TunE. .. |

Setting OFF

Lens data @ Mo

| Update...

| Lens aberration correction I [ Tune... |

Peripheral ilumination COFF
Chromatic aberration QFF
Color blur COFF

Diskartion OFF

The [Lens aberration correction] window appears.

Checkmark the items to be corrected.

The image is corrected and redisplayed.

Check the results of corrections to peripheral illumination or
distortions in the full view.

Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check. In the
top right of the window, the area is displayed at 200% in the
enlargement display section (p.139).

You can lessen the degree of correction by moving the slider to
the left for the item you want to correct.

You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

To correct distortion aberration of images shot with a fisheye lens
(EF8-15mm f/4L USM Fisheye or EF15mm /2.8 Fisheye), four
effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.

The level of an effect can be adjusted with the adjustment slider
located below [Distortion].

For details on each effect, see “Effects of Distortion Aberration
Correction for Fisheye Lenses” (p.66).
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Introduction
For images shot with EF8-15mm f/4L USM Fisheye, a fine-tune Effects of Distortion Aberration Correction for
slider is also displayed when you select [Emphasize Linearity] .
from the [Effect] list box. FISheye Lenses
Adjust the amount of correction for distortion aberration with the Shot settings Cgrgfanntgeat
adjustment slider, and then adjust with the fine-tune slider if more By selecting this option, only distortion aberration correction for
adjustment' Is required. ) o correcting optical distortion is performed.
When the list box for selecting an extender is displayed, select Basi
the extender attached at the time of shooting from the list box. Op .
Click the [OK] button.
The [Lens aberration correction] window closes and the result of
the corrections is applied to the image in the edit window and the Advanced
image is redisplayed. Operation

The result of the settings of the [Lens aberration correction]
window is also displayed in the tool palette.

Advapced
In the main window, the [Q))] mark is displayed on the image to Imag\gﬁging
indicate the lens aberration corrections (p.129). and Pfinting
Processing
Emphasize Linearity Large Numbers
of Images

This converts the image to a “central projection” style image. This
projection method is used with general lenses. =
Differing from fisheye lenses, central projection displays straight lines Editing

: . ) . : . : . JPEGI/TIFF
as straight lines. By selecting this option, a wide-view panoramic Images
image can be obtained. However, the periphery is stretched, resulting
in decreased resolution.

' Reference
& 4
gy
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VA RN o

66

-
\




Emphasize Distance

This converts the image to an “equidistant projection" style image.
This projection method preserves distance relationships.
Equidistant projection displays a distance in the same distance
anywhere from the center to the periphery. In particular, when
shooting a celestial body such as the celestial sphere, same heights
above the horizon (declination) are captured at the same heights.
This method is therefore used in such photography as celestial
photography (star maps, solar path diagrams, etc.).

Emphasize Periphery

This converts the image to a “stereographic projection” style image.
This projection method emphasizes the periphery.

Stereographic projection allows position relationships on a spherical
surface, such as N, S, E, W on a map, to be displayed correctly. It is
therefore used for world maps and monitoring cameras.

By selecting this option, the periphery is stretched and may result in
decreased resolution.

Emphasize Center

This converts the image to an “orthogonal projection” style image.
With this projection method, the center is more emphasized.

Since an orthogonal projection allows a subject of the same
brightness to be displayed as occupying the same area in the image,
this method has typical uses in photography for celestial luminance
distributions and center-emphasized animal photography. By
selecting this option, the center is stretched and may result in
decreased resolution.

® While selecting any of the options [Emphasize Linearity],
[Emphasize Distance], [Emphasize Periphery], or [Emphasize
Center] will yield results similar to each of the projection methods,
the conversion does not exactly apply each projection method in
their precise sense.
Accordingly, care should be taken since they are not suited to
scientific or other such purposes.
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About Shooting Distance Information Slider

When correcting RAW images shot with the cameras in the table below,
if shooting distance information has been saved to the image, the slider
is set automatically according to this shooting distance information.
However, if no shooting distance information is saved to the image, the
slider is set automatically to the right end at infinity position and a [<!>]
appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.

The distance cannot be minutely adjusted by using the slider forimages
shot with an EF-M lens. (The slider is not displayed.)

EOS-1D X EOS-1DC EOS-1D Mark IV
EOS-1Ds Mark Il EOS-1D Mark Il EOS 5D Mark Il
EOS 5D Mark I EOS 6D EOS 7D Mark I
EOS 7D EOS 70D EOS 60D

EOS 50D EOS 40D EOS 700D

EOS 100D EOS 650D EOS 600D

EOS 550D EOS 500D EOS 450D

EOS 1200D EOS 1100D EOS 1000D
EOS M2 EOS M —

When correcting RAW images shot with the cameras in the table
below, it is set automatically to the right end at infinity position. You
can then minutely adjust the distance by operating the slider while
looking at the screen if the shooting distance is not infinite.

EOS-1D Mark II N EOS-1Ds Mark Il EOS-1D Mark Il
EOS-1Ds EOS-1D EOS 5D
EOS 30D EOS 400D DIGITAL —

For RAW images shot with MP-E65mm /2.8 1-5x Macro Photo or
EF50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].

[Shooting distance information] slider is applied to all the correction
items with check marks.
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Correcting Multiple Images at a Time

Select multiple images to correct in the main window. Display tool
palette by clicking the [Tool Palette] button (p.127) in the toolbar. If you
perform correction procedures (p.65) when tool palette is displayed, you
can apply the same corrections to all the images selected in the main
window.

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.41).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.62). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p.31).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.30) and/or the color saturation (p.110) to
make the color deeper.

The result of [Color blur] correction cannot be detected

[Color blur] correction is effective for correcting blue or red color blur
which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

® The periphery of the image may be truncated when [Distortion]
correction is made.

|§| For a list of the [Lens aberration correction] window functions, see
p.139.
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Using the Digital Lens Optimizer

This function enables the resolution of images to be increased by
removing any remaining aberration related to image-forming capability
or any deterioration of resolution resulting from diffraction phenomena
that are unavoidable as long as light must pass through the lens. These
optical phenomena cannot be corrected under [Lens aberration
correction] (p.63). Correction is achieved using the designed value of
each lens. The images that can be corrected are RAW images shot
using any of the following “Compatible Cameras” and “Compatible
Lenses”. JPEG, TIFF, S-RAW, and M-RAW images cannot be corrected.
To use this function, [Lens data] for the lens used to shoot images first
needs to be downloaded to your computer.

Before using the Digital Lens Optimizer, it is recommended that you set
[Sharpness] or [Strength] for [Unsharp mask] for images to O.

Compatible Cameras

EOS-1D X EOS-1DC EOS-1D Mark IV
EOS-1Ds Mark Il EOS-1D Mark Il EOS-1D Mark II N
EOS-1Ds Mark Il EOS-1D Mark Il EOS-1Ds
EOS-1D EOS 5D Mark Il EOS 5D Mark I
EOS 5D*1 EOS 6D EOS 7D Mark Il
EOS 7D EOS 70D EOS 60D

EOS 50D EOS 40D EOS 30D*2

EOS 700D EOS 100D EOS 650D

EOS 600D EOS 550D EOS 500D

EOS 450D EOS 400D DIGITAL EOS 1200D
EOS 1100D EOS 1000D EOS M2

EOS M — —

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

Compatible Lenses

EF14mm f/2.8L USM
EF20mm /2.8 USM
EF24mm f/1.4L USM
EF24mm /2.8 IS USM
EF28mm /2.8
EF35mm f/1.4L USM
EF35mm f/2 IS USM

Wide angle lenses

EF14mm f/2.8L Il USM
EF24mm f/1.4L Il USM
EF24mm /2.8
EF28mm /1.8 USM
EF28mm /2.8 IS USM
EF35mm f/2

Standard and medium telephoto lenses

EF40mm /2.8 STM
EF50mm f/1.2L USM
EF50mm /1.8 1l
EF85mm f/1.2L Il USM

EF100mm f/2 USM

EF135mm f/2L USM
EF200mm f/2.8L USM

EF300mm f/2.8L IS 1l USM
EF400mm f/2.8L IS USM
EF400mm f/4 DO IS USM

EF500mm f/4L IS USM

EF600mm f/4L IS Il USM

EF50mm f/1.4 USM
EF50mm /1.8
EF85mm f/1.2L USM
EF85mm f/1.8 USM

EF135mm /2.8
(with Softfocus mechanism)

Telephoto lenses

EF200mm f/2L IS USM
EF200mm f/2.8L Il USM
EF300mm f/4L IS USM
EF400mm f/2.8L IS 1l USM
EF400mm f/5.6L USM
EF500mm f/4L IS Il USM
EF800mm /5.6L IS USM
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Zoom lenses

EF16-35mm f/2.8L USM EF16-35mm f/4L IS USM
EF16-35mm f/2.8L Il USM EF17-35mm f/2.8L USM
EF17-40mm f/4L USM EF20-35mm /3.5-4.5 USM
EF24-70mm f/2.8L USM EF24-70mm f/2.8L Il USM
EF24-70mm f/4L IS USM EF24-85mm /3.5-4.5 USM
EF24-105mm /4L IS USM EF28-70mm f/2.8L USM
EF28-105mm /3.5-4.5 USM EF28-105mm /3.5-4.5 1| USM
EF28-135mm f/3.5-5.6 IS USM  EF28-200mm f/3.5-5.6 USM
EF28-200mm /3.5-5.6 EF28-300mm /3.5-5.6L IS USM
EF70-200mm f/2.8L USM EF70-200mm /2.8L IS USM
EF70-200mm f/2.8L IS Il USM EF70-200mm f/4L USM
EF70-200mm f/4L IS USM EF70-300mm /4-5.6L IS USM

EF70-300mm f/4.5-5.6 DO IS USM EF70-300mm f/4-5.6 IS USM
EF100-300mm f/4.5-5.6 USM EF100-400mm f/4.5-5.6L IS USM
EF75-300mm /4-5.6 Il USM EF75-300mm f/4-5.6 Il USM
EF75-300mm f/4-5.6 IlI EF75-300mm f/4-5.6 Il
EF75-300mm /4-5.6 USM EF200-400mm f/4L IS USM

Macro lenses
EF50mm f/2.5 Compact Macro  EF100mm f/2.8 Macro USM
EF100mm f/2.8L Macro IS USM  EF180mm f/3.5L Macro USM

MP-E65mm f/2.8 1-5x Macro
Photo

EF-S lenses
EF-S60mm f/2.8 Macro USM EF-S10-18mm f/4.5-5.6 IS STM
EF-S10-22mm f/3.5-4.5 USM EF-S15-85mm /3.5-5.6 IS USM
EF-S18-55mm /3.5-5.6 Il USM  EF-S18-55mm /3.5-5.6 USM

EF-S18-55mm 1/3.5-5.6 IlI EF-S18-55mm 1/3.5-5.6 I
EF-S18-55mm f/3.5-5.6 EF-S18-55mm f/3.5-5.6 IS Il
EF-S18-55mm f/3.5-5.6 IS EF-S17-55mm /2.8 IS USM
EF-S17-85mm f/4-5.6 IS USM EF-S18-55mm f/3.5-5.6 IS STM
EF-S18-135mm f/3.5-5.6 IS EF-S18-135mm f/3.5-5.6 IS STM
EF-S18-200mm f/3.5-5.6 IS EF-S55-250mm f/4-5.6 IS
EF-S55-250mm 1/4-5.6 IS |l EF-S55-250mm f/4-5.6 IS STM

EF-M lenses
EF-M11-22mm f/4-5.6 IS STM EF-M22mm f/2 STM
EF-M18-55mm f/3.5-5.6 IS STM EF-M55-200mm f/4.5-6.3 IS STM

© The Digital Lens Optimizer is also available for images shot with

an extender mounted on a compatible lens.

You cannot use the Digital Lens Optimizer with multiple-exposure
RAW images created on the camera.

EF cinema lenses (CN-E lenses) are not compatible.
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Introduction

Click the [Update] button.

Using the Digital Lens Optimizer

RAW | RGE | NRfALO | LENS |

|Digita| Lens Cptimizer TURE .. | Contents at
In the tool palette, select the [LENS] tab sheet, and N . a Glance
check the status of [Lens data] for [Digital Lens -
Optimizer]_ Lens data : Mo Basic

-—ludeI Operation

| Lens aberration correction Ture. .. ||

| Digital Lens Optimizer Tune. .. | [l fl

. The [Add or Remove lens data] window appears. Advanced
Setking OFF 0perat|on
Lens data @ Mo '
E”m‘ate'" Advapced
Imag iting
| Lens aberration correction [ Tune. .. || and nting
[Not Available] is displayed for an image shot with a non- -
compatible camera or lens, or for a non-compatible image such Processing
. . Large Numbers
as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot of Images
be used for these images.
If [No] is displayed, proceed to step 2. To use the function, you Editin
need to download [Lens data] for the lens used when shooting JPEGI/TIFF
the image. It is recommended that you check the lens used when Inages
shooting the image beforehand. The lens used can be checked
using the [Info] button in the toolbar on the main window (p.23). Ref
You can also check it with the menu that appears when you right- elerence
click with the mouse on an image.
If [Yes] is displayed, proceed to step 4.
Index
|§| Before you click the [Update] button in step 2, Lens data [No] may
be displayed instead of [Not Available] for non-compatible images. : :
@ To use this function, an environment with Internet access @
(subscription to a provider, browser software installed and an in-

place line connection) is required.

An administrator-level privilege is required for this operation. )
7



Introduction
Checkmark the checkbox for the lens used to shoot Click the [Tune] button.
the image, and click the [Start] button.
(@ Add or Remove lens datal ) Raw [Ree |nejao| eS| Contents at
e . - |Digita| Lens Optimizer I[ Tune, .. a Glance
| |eF14mm F2.8L 11 USM .
|_|EF24mm F1.4L TUsM I SEtting OFF
=EF35mm F1.4L USM |
i;:g:z :iLUUSiIM Lens data : ‘fes Basig
[ |EFasmm F1.2L TUsM Operation
L EF300mm F2.8L IS II USM
zi‘éﬁﬁﬂ!iﬁéﬁﬁsﬁ” . The [Digital Lens Optimizer] window appears.
e s U Advanced
|_|EF16-35mm F2.8L USM Operatlon
| |eF17-40mm FaL usm
: EF24-70mm F2.5L II USM
| |eF24-70mm F2.8L UsM
: EF24-105mm F4L IS USM
;EFZB—3DDmm F3.5-5.6L IS USM E_ Imag |t|ng
=EF?D-ZDDmmF2.8LISIIUSM and tln
L EF70-200mm F2.8L IS USM g
(Gerozoommesvsnaagy ]
~300mm F4-3. Processing
’_|EFIDD4DDmm F4,5-5.6L IS USM N = Large Numbers
Add : 1/Delete : 0 () of Images
—_—
The lens data is downloaded to your computer. Editing
When the downloading of the lens data ends, the indication for J'TE?Q;EF
[Lens data] changes to [Yes]. —
You can download the data for up to 30 lenses at the same time.
If you remove the check mark from the checkbox for already- Reference
downloaded lens names and click the [Start] button, the lens data
will be deleted from your computer.
Index
—
® Depending on the type, current state, etc. of software running on @

your computer, the download of the lens data may fail. If it occurs,
wait for a while, then try downloading the data again.
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Checkmark the [Setting] checkbox and adjust the
image.

Save | | Cancel

The [Setting] checkbox will be checkmarked if the image has the
Digital Lens Optimizer already applied. Remove the checkmark
and click the [Save] button to cancel the Digital Lens Optimizer.
Images displayed in the [Digital Lens Optimizer] window are with
[Sharpness] and [Unsharp mask] effects applied by default. If you
checkmark the [Do not sharpen previews] checkbox, images are
displayed without [Sharpness] or [Unsharp mask] effects applied,
allowing you to check only the Digital Lens Optimizer effect.
When applying the Digital Lens Optimizer, the effect of
[Sharpness] or [Unsharp mask] may become excessive. It is
recommended that you set [Sharpness] or [Strength] for [Unsharp
mask] for images to 0 before using the Digital Lens Optimizer.
Adjust [Sharpness] or [Unsharp mask] again after applying the
Digital Lens Optimizer to images.

When the list box for selecting an extender is displayed, select
the extender attached at the time of shooting from the list box.
Use the slider to adjust the Digital Lens Optimizer effect.

When [MAX] is displayed for the Digital Lens Optimizer level, the
effect will remain the same even if you move the slider further to
the right.

You can change the display position of the check window by
dragging the enlargement display position in the navigator
window.

Even if you set shooting distance for a lens in this window, the
value indicated for shooting distance in the [Lens aberration
correction] window will not change.

If no shooting distance information is saved to the image, the
shooting distance slider is set automatically to the right end at
infinity position and a [<!>] appears above the shooting distance
slider. The distance cannot be minutely adjusted by using the
slider for images shot with an EF-M lens. (The slider is not
displayed.)

Images cannot be corrected for [Chromatic aberration] in [Lens
aberration correction] if the Digital Lens Optimizer has been
applied.

Click the [Save] button.

Save | Cancel I W

The [Digital Lens Optimizer] window closes and correction
results are applied to the image in the edit window.

Corrections made in the [Digital Lens Optimizer] window are also
displayed in the tool palette.

In the main window, the [%] mark is displayed on the image to
indicate that the Digital Lens Optimizer is applied (p.129).

After clicking the [Save] button, the application of the corrections
to the image may take some time.

The size of the image file will be larger after applying the Digital
Lens Optimizer.
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The copy stamp window appears.

Performing Automatic Dust Erasure Processing e
The Dust Delete Data that is appended to images shot with the camera When the image has redrawn itself, click the [Apply
that can attach this data, can be used to automatically erase dust spots. Dust Delete Data] button.
(@ 2 3 Eausers\CANONPictures Photouam oM 0050+ CR2 (3456 2304 Corz;tents at
Y V== a Glance
Compatible Cameras SRR
Basic
EOS-1D X EOS-1D C EOS-1D Mark IV Operation
EOS-1Ds Mark lli EOS-1D Mark I EOS 5D Mark Il e
EOS 5D Mark I EOS 6D EOS 7D Mark I Advanced
EOS 7D EOS 70D EOS 60D e
EOS 50D EOS 40D EOS 700D
Advapced
EOS 100D EOS 650D EOS 600D Imag\aﬁting
and Pfinting
EOS 550D EOS 500D EOS 450D
EOS 400D DIGITAL  EOS 1200D EOS 1100D — . Processing
Dust spots are erased in a single operation. Large Numbers
Click the [OK] button to return to the main window. "=
In the main window, select an image appended with The [ %] mark (p.129) is displayed on an image from which dust Editing
Dust Delete Data. spots have been erased. JPEGITIFF
Images
Click the [Stamp] button. —
_ N Reference
y ® & & 92 )
Rotate right 31 Ll_‘l‘—f t Stamp Tr;‘ n:l ;;glg pEr:::‘L; I - d 5




? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.77) or the copy stamp function (p.79).

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).

Ny

~
-

= Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

@ For a list of the copy stamp window functions, see p.143.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one. Click the button that matches the dust spot to be
. : erased.
In the main window, select the image you want to If the dust spot is dark in color, click the [[@*+_]] button, and if
erase dust spots. the dust spot is light in color, click the [[O»O)]] button.
Click the [Stamp] button. When you move the cursor over the image, the dust erasure

range appears as [O].
Place the dust spot to be erased within the [O] and

|
vV & @ & @

Rotate right Quick Stamp Trimming Batch
check Angle process

Rating » » » » »

The copy stamp window appears. WJ | EON Click
When the image has redrawn itself, double-click the
point from where dust is to be erased. —
(@ 2/ 3 EUsers\CANONPitures Photovemme oG 0050+ CR2 D436 x 2304
The dust spot within the [Q] is erased.
Double- Click on another part of the image to continue erasing dust spots

click in the image.
To erase dust in another part of the image, either right-click with
the mouse, or click the button clicked in step 4 again to cancel dust
erasure processing and perform the operation again from step 3.
When the dust spot cannot be erased, [§)] is displayed.

Click the [OK] button to return to the main window.
The [ 8,] mark (p.129) is displayed on the image from which dust

The display changes to 100% view. spots have been erased.

The display position can be changed by dragging.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.79).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.43).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.42).

Ny

~
-

= Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you
can efficiently erase dust spots by clicking the images while holding
down the <Ctrl> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <Shift> key, and then displaying the copy
stamp window.

@ For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

@ For a list of the copy stamp window functions, see p.143.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1 to 3 in “Manually Erasing Dust (Repair
Function)” (p.77).

Specify the section to be copied.
Click on the section that is to be the copy source while holding
down the <Alt> key.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the section you want to correct on the image. [+]
in the window indicates the copy source and [Q] indicates the
copy destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Click the [OK] button to return to the main window.
The [@,] mark (p.129) is displayed on the corrected image.

Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Photoshop.

Select the [Tools] menu P [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, see p.103.

|§| Compatible versions of Photoshop are 7.0 or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.146) is added. The ICC profile
contains information about [Preferences] (p.95) or work color
space set for each image as described below, and the appropriate
color information is relayed to Photoshop.
When you exit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred
image as a separate image in Photoshop is recommended.

Setting Work Color Space

A different work color space (p.147) from the default settings (p.95) can
be set for each image.

Select the [Adjustment] menu » [Work color space] »
color space to be set.

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and then
subsequently change the default color space setting (p.95), this default
setting will not be applied and the individually set color space will remain.

-3@/3 The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Compositing Images
p g g Introduction
You can combine two images into a single image. You can further Select the [Tools] menu » [Start Compositing tool].
combine images by adding another image to the composited image. (Toor )
Since the composited image is saved as a separate image, the original :
. . they are Start Quick check tool Alt+Q Contents at
Images rémain as : Start Trimming/Angle Adjustment tool Alt+C a Glance
Start Stamp tool Alt+5 T
|§| This function can be used with all image types (p.3) supported by [Start Compositing tool Alt+X ] ]
DPP. However, images with more than 6666 x 4444 pixels are not Start DR tool A=Y o Z?glt?on
supported. P
i ) i Start Rename tool Alt+R
The color space of a composited image will be the color space of
the background image_ Start EOS Utility Alt+0 Ad
i i i i i Sync folder with EQS Utility vanc_:ed
Image information is not appended to a composited image. ) ¥ Operation
Transfer to Photoshop Alt+P
Select a background image in the main window. Preferences... Ctrl+K AdvVmced
: , e— - ] Imaggiiting
The compositing tool window appears. and Pfinting
”*. EAUsers\CANON\Pictures\Photowooo ot IMG_0001.CR2 [3436  2304]
' Processing
Large Numbers
of Images
N ——
Editing
JPEG/TIFF
Images
—_—
Reference
SGjaerE sy Repedmves Namber of mages: 4 Number of slectd mages: 1 an N ——
You can also select a background image from the edit window,
edit image window, or [Collection] window. Index
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Select the image to combine.

Select the image to combine from the [Foreground Image] list
box.

[ 100% view ]

Foreground Image

| MG_oo01 .CRZ -]

Select an image
IMG_0001,.CRE

IMiG 0002, CRE
IMG_D004,.CRE
IMG_0006,CR2

The selected image is displayed in the [Foreground Image]

thumbnail display.

A preview of the combined background image and foreground

image is displayed in the composite preview.

The following images can be combined.

* When a background image is selected in the main window
([Folder] window) or edit window: images in same folder as
background image

* When a background image is selected in the [Collection]
window: images in the [Collection] window

* When a background image is selected in the edit image
window: images displayed in the thumbnail display area

You can combine images of different sizes.

Select a compositing method.

Select a compositing method from the [Composite Method] list
box.

[ 100% view |

Foreground Image

| MG_ooo2.cr2 -

Compaosite Method
|Add -]
- add
| AueraEE
Lighten
Diarken

Fosition

The compositing method selected in the composite preview is
applied.

The compositing method can be selected from five types: Add,

Average, Weighted, Lighten, and Darken. For details on each
compositing method, see “Compositing Methods” (p.83).

If you select [Weighted], you can set the proportion of brightness

of the image to be combined. Use the [Weight] slider at the
bottom of the [Composite Method] list box or directly enter a
value to set the brightness proportionally.

By clicking the [100% view] button, the image is displayed at
100% magnification (actual pixel size).
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Introduction
Position the images.
EE:\US&E\CANO es\Photowouoo_oAIMG_0001 CR2 (3436 [T e
T Contents at
a Glance
Foreground Image
—
Basic
Operation
Advanced
Composite Method Ope ration

[V] Compose in RAW Format

Weight 500 5

g Advanced
Positon Shift large amount (50 pixels) Imag iting
@ and Pfinting
(=] Shift small amount (1 pixel)
@E%@@ o Processing
= Align image centers Large Numbers
z . - of Images
x o = vo s ———— Youcan alsodirectly enter the position —
i coordinates of the [Foreground Image] "
to align it Editing
- gn it JPEGITIFF
Images
Reference
By default, the background image and the [Foreground Image] are
displayed with their centers aligned. —
[Compose in RAW Format]
Checkmark the [Compose in RAW Format] checkbox as necessary. Index
@ You can set [Compose in RAW Format] under the following |§| The following functions are not available for images composited —
conditions. with [Compose in RAW Format].
Both the background image and [Foreground Image] are RAW * Auto Lighting Optimizer (p.61) @ @
images, and, all the following conditions are met. + Picture Style Auto (automatically set to Standard) (p.59)
* The cameras used to shoot were of the same model « Selecting [Circle] for the aspect ratio when trimming (p.39) g.x
* The ISO speed setting at time of shooting was the same Q

* The highlight tone priority setting at time of shooting was the same
» The image sizes (original size) are the same
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Creating HDR (High Dynamic Range) Images .
Introduction
Click the [Save As] button. You can create images with a wide dynamic range where clipping in
highlights and shadows has been reduced, and images that appear like
Position . . . . . . .
& paintings. This is suited for scenes such as still-lifes and landscapes.
This function is most effective when using three images with different Cgrgfan:(s:eat
inBnr exposures of the same scene (negative exposure, standard exposure,
i~ positive exposure) to create an HDR image. However, you can also
¥ create an HDR image from two images, or even only one. Basic
e B ylo E Since an HDR image is saved as a separate image, the original images Operation
| — : remain as they are.
[ s ) * HDR stands for High Dynamic Range.
Advanced
Operation
@ This function can be used with all image types (p.3) supported by

By clicking the [Save As] button, the [Convert and save] window DPP. However, images with more than 6666 x 4444 pixels are not

, . . . supported. Advapced
(p.42) appears. Specify the required settings, and then click the , L : Imag iting
[Save] button. Image information is not appended to an HDR image. hting

By clicking the [Continue] button, images are combined to create

and

a new background image, and you can continue by combining Processing
another image. Large Numbers
To finish, click the [Close] button. m
e Editing
Compositing Methods JPEGITIFF
Images
Add —
The brightnesses of the background image and [Foreground Image]
are added and images are overlaid. Reference
Average
Images are overlaid with negative exposure compensation being
applied automatically. If you want to change the amount of exposure
for individual images, select [Weighted]. Index
Weighted -
Compositing method where brightness is set proportionally for the S S -

[Foreground Image].
00

The background image and the [Foreground Image] are compared,

with only brighter portions being combined. @
Darken

The background image and the [Foreground Image] are compared,

with only darker portions being combined. 83



Select the [Tools] menu » [Start HDR tool]. Specify the required settings, then click the [Start
Toolsl HDR] button-
Start Quick check tool Alt+Q -
Start Trimming/Angle Adjustment tool Alt+C @
Start Stamp tool Alt+S
Start Compositing tool Alt+X
(Start HDR tool AltY )
Start Rename tool Alt+R
Start EOS Utility Alt+0
Sync folder with EOS Utility
Transfer to Photoshop Alt+P
Ereferones ) Ctrl+K | IMG_0001.CR2 IMG_0002.CR2 IMG_0003.CR2
: [ bromse.. | [ momse. | [ Bromse.. |
The [Select Images] window appears. —
|| Auto Align
You can also display the [Select Images] window from the edit
window and edit image window. L_secror ) Doz

To change the selected image, or add another image, click the
[Browse] button and in the [Open] dialog box that appears, select
the image file and click the [Open] button.

If you select two images of the same size, you can checkmark
the [Auto Align] checkbox for auto image alignment. However,
auto image alignment may not work properly with repetitive
patterns (lattice, stripes, etc.) or flat, single-tone images.

By clicking the [Start HDR] button, the [Adjust Image] window
appears.

® After using auto image alignment, the periphery of the images is
partially deleted.
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Make required selections to adjust the image.

IMG_0001.CR2 / IMG_0002.CR2 / IMG_0003.CR2

Brightriess: (55)
{
Saturation: (50)
0
Contrast:(50)

0

Detail Enhancement
Strength:(0)
I}

Sliders in [Adjust Image]

[Tone/Color]

[Brightness]:

[Saturation]:

[Contrast]:

Adjusts the overall brightness of the image. Move
the slider to the right to brighten the image, and to
the left to darken the image.

Adjusts the overall color saturation of the image.
Move the slider to the right to make the color
deeper, and to the left to make the color weaker.
Adjusts the overall contrast of the image. Move
the slider to the right to make contrast stronger
and to the left to make contrast weaker.

[Detail Enhancement]

[Strength]: Adjusts the overall contrast and contrast of
details together. Move the slider to the right for a
stronger effect.

[Smoothness]: Adjusts the overall smoothness of the image.
Move the slider to the right for a smooth and
natural impression.

Adjusts the clearness of details. Move the slider
to the right for a sharper outline.

[Fineness]:

[Presets] and finishing effects

With [Presets], you can select from the five preset finishing

effects below from a pulldown menu ([Natural] is selected by

default), instead of operating the sliders individually. By selecting

a finishing effect, each slider moves according to the setting. You

can also operate and adjust the sliders after selecting an effect.

[Natural]: In high-contrast scenes, rendering in areas
where highlights or shadows are usually clipped
is corrected, for a finish with reduced highlight
and shadow clipping.

[Art standard]: Gives a finish with painting-like tonality for an

impressive image.

For a more vivid look than with [Art standard].

For a more vivid look than with [Art standard],

that makes the subject pop out.

[Art embossed]: Tones down sharpness more than [Art standard],
for an old-fashioned feel.

[Art vivid]
[Art bold]:
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Starting Up Map Utility o
Click the [Save As] button. Map Utility is a software that allows you to view images shot on a GPS
function-compatible Canon camera, including the shooting location and
Fineness:(0) route travelled. After installing Map Utility to your computer, you can
0 start it up from DPP. Contents at
Select the [Tools] menu » [Start Map Utility].
Map Utility starts up. Basic
For information about Map Utility, refer to the Map Utility Operation
instructions, or to the Help for Map Utility.
Advanced
Operation
] © Do not edit images with DPP and use Map Utility at the same time.
l Save As... ] o
Editing results may not be saved properly.
Advapced
I Close ] Imaggiiting
) i . . and Pfinting
— Version 1.1.0 or later versions of Map Ultility are compatible.
By clicking the [Save As] button, the [Convert and save] (p.42) Map Utility is not included on the EOS Solution Disk. Procesain
window appears. Specify the required settings and click the [Start Map Utility] will not appear in the [Tools] menu if Map Utility  |Large o
[Save] button. is not installed to your computer. of Images
Editing
JPEGI/TIFF
Images
Reference
Index

00
©

86



Printing with Shooting Information .
Introduction
You can freely layout one image on one sheet of paper and print YN s .
together with titles and shooting information, etc. “W° To maintain the settings
The settings of each tab sheet in step 3 are memorized when the [Apply] S
Select one image to be printed. button is clicked (excluding the contents of the [Text] tab sheet). The :r(';fa"nzea
settings can be applied to another image when printing.
Select the [File] menu » [Print with detailed setting]. P
@ You can set printer profiles (p.95). Opea:zltfon
Specify the required settings for printing, and then If CMYK simulation has been set, the image is printed in the set
click the [Print] button. colors (p.95). .
Switches the settings tab sheet op‘é?;‘t‘i‘ﬁn

(o — |
B E\Users\CANON\Pictures\Phato'vooor oo R2 s
ool

] Printer | Image | Text | Settings
prnter: Imag%iltmg
[Ganon PIAUS so00¢ | and nting
Media: 257.0mm x 210.0mm Processing
a4 |
o Large Numbers
Mes {a nrlent:itmn‘ 7 of Images
() Portrait (@) Landscape
——
Media type:
Plain Paper Editing
Print Quality: JPEG/TIFF
Standard Images
Borderless: ——
off
rint profile:
printpr. Reference
CMYK profile: —_—
I (e ) o e index
—— —_—

Print preview

The image can be moved by dragging. @ @

Drag the four corners of the image to change the size.
For the shooting information, click [E]] on the [Text] tab sheet @
and select the necessary items in the window that appears.
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Printing a Thumbnail List (Contact Sheet Printing)

Introduction
You can print rows of multiple images on one sheet of paper. sy

Select images to be printed in a thumbnail list.

button is clicked (excluding the contents of the [Text] tab sheet). The a Glance
Select the [File] menu » [Contact Sheet Prints]. settings can be applied to another image when printing. -
) ) Basic
Specify the required settings for printing, and then F ® You can set printer profiles (p.95). Operation

click the [Print] button.
Switches the settings tab sheet

P””‘P" Image | Text | Settings

==

Printer:
[ Ganon PRAUS oo -

Media: 210.0mm x 297.0mm
Ad 'l

Media orientation:

(@ Portrait () Landscape

Media type:

Plain Paper

Print Quality:
Standard

Borderless:
off

Print profile:

CMYK profile:

CMS settings...

~N
Print

Cancel Apply

Print preview

=@> To maintain the settings

The settings of each tab sheet in step 3 are memorized when the [Apply]

If CMYK simulation has been set, the image is printed in the set

colors (p.95).

—_—
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Printing RAW Images on a High-End Canon Printer

Printing with a High-End Canon Inkjet Printer

For high-end Canon inkjet printers that are compatible with the printing
software Easy-PhotoPrint Pro and Print Studio Pro, you can print with
DPP by a simple operation that has the following features:

Simple printing of RAW images

Printing in faithful colors

High quality printing using a wide color space of Adobe RGB, etc. and

the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP and Easy-PhotoPrint Pro, first install Easy-PhotoPrint
Pro version 1.3 or later on your computer.

Printing with DPP and Easy-PhotoPrint Pro
Select the [File] menu » [Plug-in printing] » [Print
with Easy-PhotoPrint Pro].

Easy-PhotoPrint Pro starts up.

Match on-screen image colors and printing result

colors.
Select [Custom] in [Print Quality], click the [Set] button, and in the
window that appears, drag the slider to [1] at the right end, and
then click the [OK] button to close the window.
Next, click the [Color Adjustment] button to display the [Color
Adjustment] window and display the [Color Management] tab
sheet. Set [Color Mode] to [Enable ICC Profile] and [Printer
Profile] to [Auto], and then click the [OK] button to close the
[Color Adjustment] window.

Specify any other required settings for printing, and

then print.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.95) is not applied.

The printed image’s color is not what you expected

In the Easy-PhotoPrint Pro window, click the [Color Adjustment]
button to display the [Color Management] tab sheet, set [Rendering
Intent] to [Perceptual] (p.147), and try printing.

¥

-@> Advantages of printing with Easy-PhotoPrint Pro

Printing with faithful colors

When a color space is set (p.79, p.95), it is automatically transmitted
from DPP to Easy-PhotoPrint Pro, allowing you to print with faithful
colors.

Printing with a wide color reproduction

When the color space setting (p.79, p.95) is set to a color space wider
than sRGB (such as Adobe RGB), the image is printed with a wider
color gamut than an image that has an sRGB color space, with green
and blue in particular being reproduced vividly.
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Printing with DPP and Print Studio Pro
Select the [File] menu » [Plug-in printing] » [Print
with Print Studio Pro].

Print Studio Pro starts up.

Specify required settings for printing photographs,
and then print.

Refer to Print Studio Pro's Instruction Manual for details on
settings.

? Additional information

Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When
printing more than 1000 images, divide the printing into several jobs.
Function set in DPP that is not applied to printing

Specified CMYK simulation (p.97) is not applied.

Ay

-= Advantages of printing with Print Studio Pro

Printing with faithful colors
When a color space is set (p.79, p.95), it is automatically transmitted

from DPP to Print Studio Pro, allowing you to print with faithful colors.

Printing with a wide color reproduction

When the color space setting (p.79, p.95) is set to a color space wider
than sRGB (such as Adobe RGB), the image is printed with a wider
color gamut than an image that has an sRGB color space, with green
and blue in particular being reproduced vividly.
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Printing with a Large-Format Canon Printer

You can use DPP to print with the DPP-compatible Canon large-format
imagePROGRAF printer. To print with DPP, first install imagePROGRAF
Print Plug-In for Digital Photo Professional on your computer.

Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.

Specify the required settings for printing photographs
and then print.

? Additional information

A single image can be printed at a time

You can print a single image selected in DPP at a time. When printing
multiple images, perform printing for each image individually.
Functions set in DPP that are not applied to printing

Specified output resolution (p.92) and CMYK simulation (p.95) are not
applied.

1/

> Advantages of printing with imagePROGRAF Print Plug-In

Printing with faithful colors
When a color space is set (p.79, p.95), it is automatically transmitted
from DPP to the Plug-In, allowing you to print with faithful colors.

Printing with a wide color reproduction

When the color space setting (p.79, p.95) is set to a color space wider
than sRGB (such as Adobe RGB), the color reproduction range of the
imagePROGRAF printer is fully utilized and the image is printed with
a wider color gamut than an image that has an sRGB color space,
with green and blue in particular being reproduced vividly.

Specifying Preferences

You can change the various functions of DPP in the [Preferences]
window. Check the contents of each window and set.

Refer to the detailed explanations if available, as well as to each
window.

Select the [Tools] menu » [Preferences].
The [Preferences] window appears.

Select a tab sheet, specify the settings, and then
click the [OK] button.

General settings | View settings | Tool palette | Color management |l

Startup folder
@) Last displayed folder
_ Specified folder

Save redpe
'@ Display message when adding file

~) Add to file automatically

Viewing and saving RAY images

View fsave RAW images at high quality

@) High quality (recommended)
B e gty & ) Moiré iz reduced and the NR. tool palette can be used

") High speed

JPEG image quality

|| Remove block noise and mosquito noise

Default value of output resolution

350 dpi{1-60000)

At EOS Utiity startup

| Editimage window enabled st EQS Utility startup

[ OK. | l Cancel ]
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General Settings

You can specify the folder that opens when DPP is started up, image
quality of displayed and saved RAW images, etc.

General settings | View settings | Tool palette | Color management |

Startup folder
@) Last displayed folder
") Spedfied folder

Save redpe
@) Display message when adding file

() Add to file automatically

Viewing and saving RAW images

View =ave RAW images at high quality

@ High quality (recommended)
Moiré is reduced and the NR. tool palette can be used

*) High speed

JPEG image quality

Default value of output resolution

350 dpi{1-60000)

At EOS Utility startup
[ Editimage window enabled at EOS Utility startup

E Ok | I Cancel

Viewing and saving RAW images

You can select from two types of image quality for displaying/saving
RAW images: high image quality with false color reduction processing
and noise reduction function (p.62) used, or high speed without false
color processing and noise reduction function used.

[High quality]
False color reduction processing is automatically applied, and the
image can be displayed/saved as a false color reduced-high quality
image. Furthermore, you can use the noise reduction function (p.62)
to reduce the luminance noise and chrominance noise.
Because the effects of the false color reduction processing and noise
reduction function are difficult to see in the [50% view] or [Fit to
window] display of the edit window and edit image window, use
[100% view] or [200% view] to check.
We recommend that you normally set [High quality] for a balance
between image quality and display speed.

[High speed]
Since false color reduction processing is not applied, the display speed
of a RAW image in the edit window or the edit image window, and the
time it takes to save a RAW image is shorter than with [High quality].
You cannot use the noise reduction function (p.62).
Depending on the image, it may be displayed/saved with false color
or noise being noticeable.

@ For images shot with ISO speed range expansion set, the difference
in image quality between [High quality] and [High speed] becomes
remarkable. To check the image quality of images shot with ISO
speed range expansion, make sure to set [High quality] and check
the images in the edit window or edit image window.
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Introduction
JPEG image quality View Settings
[Remove block noise and mosquito noise] . . . .
. itv of a JPEG i by reducing th . You can specify settings relating to the display.
You can improve the quality of a image by reducing the noise Contents at
particular to JPEG images. a Glance
This setting is also effective when RAW images are converted to —
JPEG images and saved (p.42, p.102) and for JPEG images that [ ceneralsettngs e settiogs Toolpelette Color management
have been saved with a different name. Bl Basic
69 Pixels(8-256) Operatlon
? The extent of the improvement in noise reduction Image selecton status
. i . ) . [¥] Images opened in Edit window remain selected in main window Ad d
The higher the JPEG image’s compression rate, the more noise is Op‘é?:t?gn
reduced. When the compression rate is low, the effect of noise reduction Magrification in Edit window
may not be noticeable. @) Fit to window ) 50% () 100% () 200%
Magnification when the Edit/Edit image window is double-dicked I Ad c?t'd
. : _ § ma Iinin
Default value of output resolution s o ;,w;‘il ntingg
You can set the resolution for RAW images converted and saved as RAW and FEG
JPEG or TIFF ImageS (p42, p102) ["|Display only CR2 images for CR2 and JPEG files of the same name Processing
Large Numbers
Sort order in main window of Images
[ Retain sort order —
Highlight/shadow Alert J PEEdg/i!FIgF F
Highlight 255 (192-255) . Images
Shadow 1] {0-64) . —
Quick check tool display
@) 50% () 100% {mairé reduction off) Reference
—_—
[ Ok ] [ Cancel
Index
—_—
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Sort order in main window

You can set the order of images which have been rearranged in the
main window to be maintained or not maintained (p.21).

If you checkmark the checkbox, the order of the rearranged images is
maintained even if you exit DPP or select another folder in the folder
area.

If you remove the check mark, the order of the rearranged images is not
maintained and reverts to the previous order when you exit DPP or
select another folder in the folder area.

Highlight/shadow warning

Highlighted/shaded areas that exceed the set range can be displayed
on the image as warning indicators (p.55).

Tool Palette

You can specify settings for the tool palette.

[ General settings I View settings

| Tool palette

Default settings of RGB tool palette
Tone curve mode
@ RGBRGB
() Luminance R GB
Histogram display
) Before adjustment

@) After adjustment

Tool palette display in Edit Image Window
(@) Docking display

() Floating display

Modified Picture Style settings
[¥]Retain settings of each Picture Style

Tool palette display mode
[ same for Main window and Edit window

Default noise reduction settings
(@ Apply camera settings

") Set as defaults

TIFF/IPEG luminance noise reduction: (0)

TIFF/IPEG chrominance noise reduction:(0)

Tone curve interpalation method
@ Curve

*) Straight

o [

Color management

Default settings of RGB tool palette

You cannot apply changes to the settings until you re-open the folder.

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change the settings individually.
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Modified Picture Style settings

You can select whether the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings will be changed accordingly or
retained, when you change the Picture Style.
If you checkmark the checkbox, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be changed to match the
camera’s preset settings, when you change the Picture Style.
If you remove the check mark, the [Color tone], [Color saturation],
[Contrast] and [Sharpness] settings will be retained, even if you
change the Picture Style.

Default noise reduction settings

You can set a default beforehand for the noise reduction level.
RAW Images
* When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
* When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.
JPEG/TIFF Images
* You can set a desired default noise reduction level beforehand.
For images not having a recipe attached, the default set here for noise
reduction level is applied. However, if you want to apply settings to
images in the opened folder, you need to re-open the folder after making
settings here. For images with a recipe attached, the noise level
recorded in the recipe remains as it is and the default for noise reduction
level set here is not applied.

\
~

-,@/i— Advantages of setting a noise reduction default

In instances where the same level of noise occurs in several images,
such as images shot with high ISO speed, setting an appropriate default
noise reduction setting enables you to apply a batch noise reduction
default to all the images displayed in DPP (excluding images with a
recipe attached). This eliminates the need to apply noise reduction to
each individual image. And, since you always shoot with the same
conditions, it is also useful when you want to set the same noise
reduction level for all shot images.

Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

|
‘

| General settings | view settings | Tool palette Color management L

Default settings of Wark color space
@ sRe8 ) Apple RGB
Adobe RGB _) ColorMatch RGB

Wide Gamut RGB

Color matching settings
For display
@) sRGE

Use the OS settings

~) Manitor profile

Printing profile
Perceptual

T o f b

@) Relative Colorimetric

CMYK simulation profile

— None — &

Rendering intents when using Easy-PhotoPrint
() Perceptual

@) Relative Colorimetric

Cancel
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Default settings of Work color space

You can select from five types of color space (p.147) that is applied as a
default setting in RAW images. Color space that has been set is applied
as the color space when a RAW image is converted and saved (p.42,
p.102) or printed (p.43, p.46, p.49, p.87 to p.91).
If you have changed the setting, and you restart DPP, the new setting
is applied as the default setting color space.
You can check color space that has been set in an image in the main
window (p.127, p.128), the edit window (p.130), and the edit image
window (p.136).

? Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

|§| You can set a color space that is different from the default settings
for each image (p.79).

Display setting (color setting of the monitor)

Where a profile (p.146) is attached to the monitor you are using, you can
display an image in more faithful colors by setting the profile.
If you select [Use the OS settings], the color profile set in Windows
will also be applied in DPP.
If you are using multiple monitors, only the profile of the primary
monitor is applied to DPP.
Select the [Monitor profile], click the [Browse] button and in the dialog
box that appears, select a profile for your monitor.

AL/

=@> Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.

Setting of printing profile (color setting of the printer)

Where a profile is not attached to the printer you are using to print
images, you can print an image and simulate the colors displayed on
screen by setting the profile in DPP. The profile that has been set is
applied to all printing (p.49, p.87, p.88) except when printing with a
Canon inkjet printer (p.43, p.46, p.89 to p.91).

@ If you specify a profile for printing in DPP, set the color adjustment
function of the printer driver to off. If it is left on, the image may be
printed in colors different from those displayed on screen.

:@3 Automatic settings for printing using EPP EX, EPP, and
linked printing

If you are printing using a Canon inkjet printer (p.43, p.46) or using
linked printing (p.89, p.91), a profile is set automatically even when the
[Printing profile] setting is not performed. This allows you to print faithful
colors easily.
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Setting of CMYK simulation profile

You can select the color when printing in the CMYK environment of a
printing machine, etc. from four types of profiles (p.147) and perform
simulation on screen.
When CMYK simulation has been set, [CMYK] appears (p.127, p.128,
p.130, p.136) at the bottom of the main window, edit window and edit
image window, and colors can be checked.

To temporarily cancel CMYK simulation, press the <Ctrl> + <Y> keys.

Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.147) for printing
using Easy-PhotoPrint (p.46).

The rendering intent is ordinarily set to [Relative Colorimetric].

When colors with [Relative Colorimetric] are not satisfactory, set to
[Perceptual].
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4 Useful Functions for Processing Large Numbers of RAW Images

For users shooting a large amount of RAW images, the convenient
function of batch processing large amounts of RAW images is explained
here.
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.vrd”) and loaded and
applied to another image.
You can edit images efficiently by selecting and adjusting one image
from images shot with the same shooting environment and batch
applying the adjustment results to a large number of images.

SHYTS T A
we oo I

=

|| Raw  [Res | nRjaLO [ LENS

| Brightness adjustment |
0 0.00
|White balance adjustment |
I 2 3 Register.
[ﬁ (Auta) - l[ Ture... J
| Picture Style |

Iﬁ (5tandard) v | Browse...

Contrast:(0)
Highlight: {0}
Shadow:{0)

[l Linear
Color tone: (1)

Color saturation: (0)

[Unsharp mask - I
Strength:(0) I
Fineness:(0) 1
Threshold: (1) {1

I}
1
I

l
1

-10.0 8.0 60 40 -20 00 20 40

hiage -data'

I \N
Lvid)

Contents adjusted using the tool
palette can be handled
individually as a recipe file
(extension “.vrd”).

|§| The adjustment contents of JPEG or TIFF images (p.106) can be
saved as a recipe file (extension “.vrd”) and loaded and applied to
another image in the same way as with RAW images.

? Additional information

Recipe data includes tool palette contents

Recipe data includes adjustments made with the tool palette ([RAW],
[RGB], [NR/ALQO] and [LENS]). For this reason, other editing content
such as trimming or dust-erasure (copy stamp) is not included in the
recipe data.

Recipes adjusted with the [RAW] tool palette can only be applied
to RAW images

Adjustments in the [RAW] tool palette, which can only be made for
RAW images, are not applied to a JPEG or TIFF image even if they
are pasted.
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Introduction

Saving Recipes as a File

Select an edited image, and then select the [Edit]

Copying a Recipe and Applying to Another Image

You can copy a recipe of an edited image and then apply it to another
image. Contents at

menu » [Save recipe in file].
The [Save recipe in file] dialog box appears.

Select the destination folder, enter a file name, and

and then select the [Edit] menu » [Copy recipe to Basic
then click the [Save] button. clipboard]. Operation
The recipe is copied.
? Check the contents of a recipe file by pasting to an image Select the image to Whi_Ch the recipe is to be' applied Sg‘é?Q{i’ﬁﬂ
o . _ and then select the [Edit] menu » [Paste recipe to
When you do not know the contents of a recipe file, paste it to an image .
L : selected image].

and check the settings in the tool palette. When only a few settings are o ) _ Advanced
adjusted, we recommend you use a file name that describes the The recipe is applied to the image. Image Editing
contents or that you separately record the adjustments as text and Printing

information.

Select the image from which a recipe is to be copied

a Glance

Procefsing
Largbers
of Images
Loading and Pasting Recipes -
iting
Select the image to which a recipe is to be applied, J'TES“;EF
and then select the [Edit] menu » [Read and paste J
recipe from file].
The [Open] dialog box appears. Reference
Select a recipe and click the [Open] button.
The recipe is applied to the image.
Index
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Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the
same shooting environment.

Registering Personal White Balance

Adjust the white balance (p.28, p.56).
To adjust white balance, select a setting other than [ & ()] from
the [White balance adjustment] list box (p.28). You will be unable
to register the adjustments if you select [ & ( )].

In the [RAW] tool palette, click the [Register] button.
The [Register personal white balance] dialog box appears.

Select the button number to be registered from the
list and click the [OK] button.

Register personal white balance

Register current setting in personal white balance

Current setting: Click white balance

—

? To use the registered personal white balance on another
computer

In step 3, click the [Export] button to write as a file.

Copy the file to another computer.

In DPP on the other computer, display the window of step 3.

Click the [Import] button and in the window that appears, select the
copied file.

® You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.

Applying Personal White Balance

In the main window, select the image to which white

balance is to be applied.

Click the [Tool Palette] button on the toolbar.

The tool palette appears.

Click the personal white balance number button that

is to be applied.

|| Raw  |ree | nRrjaLo | LENS |
| Brightness adjustment EH
0 0.00
White balance adjustment =]
|EEE) [ row..
I Davylight v‘ Tune. ..
Picture Style (=]

lﬂ (Standard) v] Browse...

-10.0 8.0 -60 <40 -20 00 20 40

Contrast:(0) 1

Highlight: () 1

Shadow: [D)__ B {1
|| Linear

Color tone: (0} {1

Color saturation: (1)

|Unsharp mask v‘
Strength: (0) 1
Fineness: (0) [
Threshald:(a) I
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Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain
unaffected.

In the main window, select multiple images to be
converted.

Click the [Batch process] button on the toolbar (p.127).
The [Batch settings] window appears.

Specify the required settings, and then click the
[Execute] button.

IMG_0001.CR2 7| save folder

MG_0002.CR2 : (O
IMC_0003.CR2 E:\Users \CANON'Pictures P
MG_0004.CR2
IMG_0005.CR2 File format

MG_0006.CR2 \and of file Eeres
IMG_0007.CR2

MG_0008.CR2 Image quali 01w
IMG_0003.CR2 R

MG_0D10.CR2 Output setting
IMG_0011.CR2 )
IMG_D012.CR2 Output resolution 350 dpi V| Embed ICC profile
IMG_0013.CR2
MG_0014.CR2 Resize setting
IMG_0015.CR2 [FlResize

File name
Current file name

@) New file name
String Sequence number
DPP_ 0001 ‘
Save sequence number
Ex.: DPP_0001.JPG, DPP_0002.JPG...
Shaoting info setting
@ Include all shooting info
~) Remaove on ly GPS info
Remove shooting info

Image transfer settings
Open image using software

The batch processing dialog box appears and saving begins.
When all the images are saved, the [Exit] button appears in the
batch processing dialog box.

In the processing dialog box, click the [Exit] button.

? Saving images with recipe is not possible

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.41, p.122) to edited RAW images.

5@/3 To save the developing/editing results for the version you are currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, it is recommended that you convert and
save images as JPEG image or TIFF images.

Q% Skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the edit window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.

@ If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected images.

@ If you have selected [New file name] in [File name], [Sequence
number] has to be set.
By saving as explained on this page, a trimmed image (p.38,
p.114) or dust-erased image (p.75 to p.79, p.117 to p.121)
actually becomes a trimmed image or dust-erased image.
For a list of [Batch settings] window functions, see p.144.
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Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike
[Transferring a RAW Image to Photoshop] (p.79), you transfer images
that have first been converted and saved as a seperate image, so the
transferred image will not disappear after exiting the destination
software. The software used here as an example is Adobe Photoshop
CS.

In the main window, select multiple images to be
transferred.

Click the [Batch process] button on the toolbar (p.127).

The [Batch settings] window appears.

Perform settings required for transferring (e.g. file
format).

Click the [Browse] button.

[MG_oooLcrz | Save folder

IMG_0003.CR2 E:\Jsers\CANON Pictures Browse...
IMG_0004.CR2

IMG_0005.CR2 File format

IMG_0006.CR2 Kind of file CREE— =
IMG_0007.CR2

MG_0008.CR2 Image quality ) w0
IMG_0009.CR2

MG_0010.CR2
MG_0011.CR2
IMG_0012.CR2
IMG_0013.CR2
MG_0014.CR2
IMG_0015.CR2 [ Resize

350 dpi  [V]Embed ICC profie

@) New file name
String Sequence number
DPP_ 0001
[ 5ave sequence number
Exe DPP_0001.JPG, DPP_0002.JPG. ..
Shooting info setting
@ Include all shooting info
() Remave only GPS info
*) Remave shooting info

Image transfer settings
Open image using software

Cancel

The [Open] dialog box appears.

Select Photoshop CS.
In the [Open] dialog box, select a Photoshop CS file or a shortcut
and click the [Open] button.
The [Open] dialog box closes and [Image transfer settings] in the
[Batch settings] window is set to Photoshop CS.

Checkmark [Open image using software].

Image transfer settings

Dpen image using software

E:\Program Files\Adobe\Adobe Photoshop CS'\Photoshop Browse. ..

[ Execute ] I Cancel I

Click the [Execute] button.
The processing dialog box appears and batch transfer begins.
When the first image has been transferred, Photoshop CS starts
up and transferred images are displayed in transferred order.

© If the message [Insufficient memory.] appears, too many images are
selected at the same time. Decrease the number of selected
images.
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Batch Change the File Name of Images .
Introduction
In the main window, select multiple images of which . . . . .
the file names are to be changed. Changing the File Name of Images in the Order in the Main Window
When you change the order of the images in the main window, you can Contents at
Select the [Tools] menu » [Start Rename tool]. change in one operation the names of the files for the images, in the a Glance
The rename window appears. order they were rearranged.
ify the r ir in .145) and click th . . s -
Specify the required settings (p.145) and click the Change the order of the images in the main window Basic
[Execute] button. (0.21) Operation
a wmwwmmmgi I o
e E— E— N In thfe main window, select multiple images of which L N
Basic Settings Format settings the flle names are to be Changed- operation
e s Select the [Tools] menu » [Start Rename tool].
Shooting Date/Time Shh”:‘:;my - Advanced
Same file name for RAW +IPEG images - - - Ima e Editin
I Copy and Rename _— d Select [Flt to main WIndow]. an(? Printingg

[¥] Insert underbar

-

E:\Users\CANONPictures % . .
@ E:\Users\CANON\Pictures\Photoloso: ot Z
— : ' Procefsing
OmfG,c‘l;clquz L MDS:,;GZQ:LUUULCM File name Larg bers
MG_0001.JPG DPP_D6-08-13_0001.1PG DFP » Shooting Date/Time of Im es
IMG_0002.CR2 DPP_06-09-13_0002.CR2
IMG_0002.JPG DPP_06-09-13_0002.JPG A i
IMG_0003.CR2 DPP_06-09-13_0003.CR2 Basic Settings
00082 "~ [ Sort Editing
MG_0004. PG DPP_05-09-12_0004.IPG g S Window J PEG/TIFF
- Images
File name
[ [ Ereate ] Cancel | w ") Shooting Date/Time
: : . Specify the required settings (p.145). Reference
Processing begins and the file names are changed. P y i q gs (p )
To copy an image, checkmark [Copy Rename].
? i is dupli .
¢ Changes cannot be made when the file name is duplicated Click the [Execute] button.
If a file name in red text has appeared in [Modified File Name], the file name The file names are changed and the order in the main window is Index
has been duplicated. Changes cannot be made if even one file name has maintained.

been duplicated. Change the settings so that duplication does not occur.

® The name of the movie files cannot be changed in DPP.

|§| You cannot start up the rename tool from the [Collection] window
(p.36, p.128).
For a list of the rename window functions, see p.145.

© If the message [Insufficient memory.] appears, too many images are

selected at the same time. Decrease the number of selected
images.
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5 Editing JPEG and TIFF Images

DPP is software mainly aimed for advanced RAW image editing, but it
also has JPEG and TIFF image editing functions. Here, the editing and
saving of JPEG and TIFF images are explained.
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the [RGB] and [NR/ALO] tool palettes.

Because adjustment made with the tool palette (recipe) only changes
the image processing conditions, the “original image data itself” remains
unaffected. Therefore, there are no problems with image deterioration
that arise with editing and you can readjust your images any number of
times.

e I

RAW | RGB  |NR/ALO | LENS |

Tone curve assist

(O
Tone curve adjustment
[ re&_ J[r]

255

| i | li [
LT LR P
Ll ! .1 R
Wy I\
:
Lurd
Brightness: { 0 ——

Contrast: {} 0 I

Contents adjusted using the tool
palette can be handled

Hue: D @ 0
Sl 0 o0 individually as a recipe file
s 0 e || (extension “.vrd”) (p.99, p.122).

In DPP all the adjustments (image processing conditions information)
made with the tool palette can be saved in the image as data called a
“recipe” (p.122), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.vrd”) (p.99, p.122).

About the RGB Tool Palette

With the functions in the [RGB] tool palette, you can adjust JPEG and
TIFF images with the same functions as ordinary image editing
software.

However, because the adjustment width of the adjustment functions in
the [RGB] tool palette is wider than the [RAW] tool palette, the image
color may be saturated, or the image quality may deteriorate if you
adjust too much. Therefore, take care not to adjust your images to an
excessive degree.

You can adjust RAW images with the functions in the [RGB] tool palette.

However, for functions other than tone curve adjustment (p.111) and
automatic adjustment (p.107), we recommend adjusting RAW images
using the same functions available in the [RAW] tool palette.
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Introduction
Automatically Adjusting Brightness and Color (Tone Curve ASSiSt) =Q= Images not suitable for automatic adjustment (tone curve —
In order to make the image a desirable standard image, automatically ZEEE)
adjust the image tone curve (p.146). You can select the degree of The result of automatic adjustment (tone curve assist) may not be as Contents at
automatic adjustment from “Standard” and “High”. expected with the following images:
» Images which have been shot with the proper exposure
Click the desired automatic adjustment button. - Images where the brightness is unbalanced Basic
Standard: Standard automatic adjustment. Suitable for most * Images which are too dark Operation
images. » Images which have extreme backlighting
High: Use when the effect achieved in standard automatic
adjustment is not strong enough o »
i J 9 gn. @ If you click the [[[Z%]] button, the tone curve as well as the [Hue] Operation
RAW | RGE  [NR/ALO [ LENS | and [Saturation] revert to the default settings. Take care when
‘Tnne curve assist @B 03 E-_-,]‘i Reverts the tone curve adjusting the [Hue] and [Saturation] individually (p.110). Advanced
|T|::ne curve adjustment to the original settings Image Editing
G JREE) | | & and Printing
255 High
Processing
Large Numbers
Standard of Images
Editihg
JP IFF
| es
Reference
a
Index
Brightness: 1 ]
Contfrast: ] 0
¥ = 00
Saturation: D 100
Sharpness: [ @ i] @

The tone curve changes as adjusted.
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Adjusting Brightness and Contrast

The brightness and contrast of an image can be adjusted.

Brightness: Move the slider to the right to make an image
brighter and to the left to make an image darker.

Contrast: Used to adjust modulation and degree of contrast

RAW | RGB  |[nr/aLo | LEns |

| Tone curve assist | |
‘Tone curve adjustment |
(] |

Brightness:

Contrast:

Hue:

Saturation:

Sharpness:

(5] 100
(B] o

of color. Move the slider to the right to make
contrast of an image stronger and to the left to
make contrast weaker.

Drag the sliders left or
right
Enter numerical values

@ The adjustment range is —100 to +100 (in 1-stop increments when
entering a value).
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Click the [[.~]] button.

RAW | RGB  |NR/ALO | LENS |

|T0r1e curve assist

() 1z 28]

|Tor1e curve adjustment -] ”

e JmE)

Brightness: [ ]
Confrast: i [ i}
Hue: [ @ i}
Saturation: @ 100
Sharpness: [ @ ]

?

Click on a point that is to be the standard for white.

1632 B44): 220224235 RAw [ AdobeRGE CMYK High quality

The coordinates of the cursor position and
the RGB values (8-bit conversion)

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, right-click with the mouse or click

the [[# ]] button again.

When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white point.

5

The image is adjusted based on the average value of 5 x 5 pixel
range from the clicked point.

The histogram display changes according to adjustment. You can
also fix the histogram display to the display before any
adjustments (p.94).

J
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Adjusting Hue, Saturation and Sharpness

You can adjust hue (tone) and saturation and make the overall
atmosphere of an image sharper or softer.

RAW | RGE  |NR/ALO [ LENS |

|T|:une curve assist

() 1z 28]

|T0ne curve adjustment @|

ks J[R][c][e] (2]

255

Brightness:

Confrast:

Hue:

Saturation:

Sharpness:

{}
{1
®Blo —
(O

(5] 100

B

Enter numerical values

Drag the sliders left or right

Hue: Move the slider to the right to make color tones
more yellow, and to the left to make color tones
redder.

Saturation: Move the slider to the right to make the color
deeper, and to the left to make the color weaker.

Sharpness: Move the slider to the right to make an image
sharper, and to the left to make an image softer.

? Sharpness is unnatural

Adjust sharpness with the window view set to [100% view], [50% view]
or [200% view]. If the view is set to [Fit to window] (full view), the
sharpness will seem unnatural.

|§| The adjustment range is —30 to 30 for hue, 0 to 200 for saturation,
and 0 to 500 for sharpness (in 1-stop increments when entering a
value).
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. Introduction
Tone Curve Adjustment Make adjustments. —
You can adjust the brightness, contrast and color of a specific area by RAW | RGB [ NR/ALO |LENS |
changing the tone curve (p.146). [ Tone urve assist (D[ 25)] Contents at
- a Glance
|Tone curve adjustment |
Select the tone curve mode and interpolation RGE,)(R [ ][8 |
method. 255 ‘— Adjusts each channel Basic
. Batch adjusts RGB Operation
RAW | RGB  |NR/ALO | LENS | —
‘Tnne curve assist |
|T0ne curve adjustment | deantc_:ed
peration
il (2 (5 (2 ; . Click to add a [[] (point) )
= ' Adjust by dragging [[]
Advanced
Image Editing
and Printing
—
@ Curve A
. . . Processing
Straight R'ght'd_'Ck_W'th the g Large Numbers
mouse inside the graph of Images
© RGBRGB to display the menu Brightness: { 0
Luminance RG B
Contrast: I I 0 E (¢]
- JP:ElFF
Hue: I @ 0 I e
w Saturation: |:| @ 100
Bl 0 0 Sharpness: [ @ i} Reference
Confrast: : {l 0 The horizontal axis shows the input level and the vertical axis
' " shows the output level.
e : The maximum number of [[]] is 8. Index
etk 0 18 To delete a [[], either press the <Del> key or double-click on the [[]]. ‘“r’
Sharpness: [ i]

|§| The histogram display changes according to adjustment. You can @ @
also fix the histogram display to the display before any @
adjustments (p.94).
The tone curve mode and interpolation method for a tone curve

can also be changed in [Preferences] (p.94). 111



Introduction
Adjusting Dynamic Range @ The setting range of shadow points is 0 to 247 (in 1-stop -
D . idth of aradati ion) f dark points to bright increments when entering a value).
yhamic range (width of gra ation expression) from dark points to brig The setting range of highlight points is 8 to 255 (in 1-stop Contents at
points in an image can be adjusted. . ;
increments when entering a value). a Glance
The histogram display changes according to adjustment. You can —
Move downwards also fix the histogram display to the display before any
Output highlight points adjustments (p.94). Basic
Operation
RAW | RGB  |NR/ALO | LENS |
|Tone curve assist @|
‘Tone curve adjustment -— Reverts the Advant_:ed
s 1ol 2| image to the Operation
Output 255 original
hlghllght point settings Advanced
numerical Image Editing
value and Printing
p .
Move to the Move to the ._a,;,‘;"ﬁﬁrsn'{,'grs
right left of Images
Input shadow Input highlight
points points E g
JPI%IFF
| es
Output shadow .
pointnumerical a55-1- Input highlight
value i 6 pointnumerical Reference
value .
Contrast: u}
Input shadow
point numerical ®) 0 Index
value L _
Saturation: @ 100
Sharpness: [} @ ]

Move upwards
Output shadow points

The horizontal axis shows the input level and the vertical axis shows

the output level.
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Reducing Noise

You can reduce noise that arises in JPEG and TIFF images that have
been shot at night or with a high ISO speed.

Select the [NR/ALO] tab sheet from the tool palette in
the edit window or edit image window.

Click the [NR Preview] button.

|
| Moise reduction App |

[ [ MR, Preview... I

RAW

The [NR Preview] window appears.

Adjust an image.

NR Preview

Navigator
window

— Enlargement

display
TIFF/JPEG pOSition
Luminance noise on:(7)
° Gj = Drag the
Chrominance no ise geduction: (8) .
0 é” i sliders

NR check window

You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.

The noise reduction effect can be checked when an image is
displayed at 100% in the NR check window.

You can change the display position of the NR check window by
dragging the enlargement display position in the navigator
window.

Click the [Apply] button.

Noise reduction is applied to the image and the image is
redisplayed.

To set the same noise reduction level for several images

After selecting multiple images in the main window, you can set the
same noise reduction level for the images without displaying the [NR
Preview] window, by adjusting the noise reduction level in the [NR/ALO]
tool palette (p.132) using the [Luminance noise reduction] and
[Chrominance noise reduction] sliders, and then clicking the [Apply]
button.

5

If [Luminance noise reduction] has been set, resolution may be
reduced along with reduction of noise.

If [Chrominance noise reduction] has been set, color bleeding
may occur along with reduction of noise.

You can set the batch processing settings for noise reduction
beforehand, using [Default noise reduction settings] in the [Tool
palette] tab sheet in the [Preferences] (p.94). This is particularly
useful for applying noise reduction to all the images in a folder at
once, such as batch noise reduction for images with high ISO
speeds. However, where images have a recipe attached, the
noise level recorded in the recipe is applied.

For a list of [NR Preview] window functions, see p.134.
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Trimming and Adjusting the Angle of an Image :
Introduction
You can crop only the part of an image you need, or change the Adjust the angle of the image as needed.
composition of an image where an image shot horizontally becomes Trimming/angle adjustment window
vertical. You can also adjust the angle of an image before trimming. If T s Trw
you select [Circle] for [Aspect ratio], the area outside the specified range e Cgrgfan:(s:eat
will only be masked in black and the image will not be trimmed. - — Largest
,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, = possible
Select the image to be trimmed. : - - | limming Basic
- : _ <. range Operation
Open the trimming/angle adjustment window. | e ’ . &= — Click (rotate
Click the [Trimming Angle] button. : - T .. | image left Advanced
or right in Operation
90-degree
| increments)
D B B 4 = — T = daegsit s e Advanced
y @& & @ B Image Editing
Rotate right Quick Stamp Trimming Eatch and Printing
check Angle process Lo L crel ) —
ating & & & & » ‘ .
- - Drag® (0.01-degree increments; Processing
RK adjustment range: -45 to +45 degrees) Laggfe"ﬁgr;g:rs
' Use the mouse (click A/V) to adjust the angle or
The trimming/angle adjustment window appears. directly enter the adjustment angle” (0.01-degree Editihg
Editing can be done once the image is displayed clearly in the increments; adjustable range: -45 to +45 degrees) J'Tl%":':
trimming/angle adjustment window. * You cannot adjust the angle of images that exceed 9999 x 6666 es
pixels in size.
If you (.:Iick [Center on Scre(.an], you can display the trimming Reference
range in the center of the window.
If you click the [OK] button after adjusting only the angle of the
image, the image will be trimmed at the largest possible trimming
range. Index

@ When aspect ratio information is attached to an image shot with the @ @
EOS-1D X, EOS-1D C, EOS-1D Mark 1V, EOS-1Ds Mark IIl,
EOS-1D Mark lll, EOS 5D Mark Ill, EOS 6D, EOS 7D Mark I, m—
EOS 7D, EOS 70D, EOS 60D, EOS 700D, EOS 100D, EOS 650D,

EOS 600D, EOS 1200D, EOS M2 or EOS M, the trimming range
based on the aspect ratio information is displayed. 114



(704, 362) > (2281, 1413) = (1577 x1051) [1.50]

Select a ratio and drag the trimming range.

| 1/ 1 E\Users\CANON\Pictures\Photovo LCR2 [

eeeeeeeeee —— Cancel
y— Select a
trimming
ratio

nnnnn

— Drag the
trimming
range

‘‘‘‘‘‘

The trimming range can be moved by dragging.

You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range. (Not available
when [Circle] is selected.)

List of aspect ratios (width : height)

A Size Landscape
& Size Porfrait
Letter Landscape
Letter Portrait
Custom

Circle

[Free]:  You can trim an image to any size, regardless of the
selectable ratio.

[Custom]: You can trim an image at the specified ratio.

[Circle]: The area outside the specified range is masked in
black. The image is not trimmed.

Click the [OK] button to return to the main window.

The trimming range frame is displayed in the trimmed image
(p.129).

When the trimmed image is displayed in an edit window or the
edit image window, it is displayed in its timmed form.
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? About trimmed images

The trimmed range can be reverted to its original condition at

any time

A trimmed image is displayed or printed as a trimmed image.

However, since the image is not actually trimmed, you can always

revert to the original image by clicking the [Reset] button in the

trimming/angle adjustment window or performing the “Re-Editing an

Image” procedure (p.123).

Display of the trimmed image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.129).

* Edit window:

» Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the edit window display.

Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

The image becomes a trimmed image when saved as a separate image
The trimmed JPEG or TIFF image actually becomes a trimmed image
when saved as a separate image (p.122).

Images that have aspect ratio set will be displayed as trimmed
images

When aspect ratio information is attached to a RAW image shot with
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark 1ll, EOS-1D
Mark Ill, EOS 5D Mark Ill, EOS 6D, EOS 7D Mark Il, EOS 7D,

EOS 70D, EOS 60D, EOS 700D, EOS 100D, EOS 650D, EOS 600D,
EOS 1200D, EOS M2 or EOS M, the set trimming range based on the
aspect ratio information is displayed. Since the image is not actually
trimmed, you can change the trimming range or revert to the condition
before trimming.

However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect
ratio set with the EOS 5D Mark Ill, EOS 6D, EOS 7D Mark I, EOS
70D, EOS 60D, EOS 700D, EOS 100D, EOS 650D, EOS 600D, EOS
1200D, EOS M2 or EOS M, its trimming range cannot be changed nor
reverted to the condition before trimming, since the image is actually
trimmed and saved in the set trimming ratio.*

The image is displayed in its trimmed condition.

When reverting to the condition before trimming is performed based

on the aspect ratio information at the time of shooting, click the

[Reset] button. Also, if you want to cancel all the trimming range, click

the [Clear] button (p.138).

* For JPEG images shot with EOS 5D Mark IIl or EOS 7D Mark |l,
and [Add cropping information] is set in Custom Functions, aspect
ratio information is only set and the image is not actually trimmed.

Ny

-@)> Convenient functions of the trimming/angle adjustment
window

Switch between screens using the keyboard
You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys or the <F11> key.

Operate using the menu

Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
trimmed image and the multiple images to which you want to apply
the trimmed range in the main window, and display the trimming/angle
adjustment window. With the trimmed image displayed, click the
[Copy] button and then click the [Apply All] button. This will apply the
trimming range to all the images selected when the trimming/angle
adjustment window is displayed.

@ For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view the image in detail in the
trimming/angle adjustment window, so using this function is not
recommended.

@ For a list of the trimming/angle adjustment window functions, see
p.138.
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Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images shot with the camera
that can attach this data, can be used to automatically erase dust spots.

Compatible Cameras

EOS-1D X EOS-1D C EOS-1D Mark IV
EOS-1Ds Mark Il EOS-1D Mark I EOS 5D Mark Il
EOS 5D Mark Il EOS 6D EOS 7D Mark Il
EOS 7D EOS 70D EOS 60D

EOS 50D EOS 40D EOS 700D

EOS 100D EOS 650D EOS 600D

EOS 550D EOS 500D EOS 450D

EOS 400D DIGITAL EOS 1200D EOS 1100D
EOS 1000D EOS M2 EOS M

In the main window, select an image appended with
Dust Delete Data.

Click the [Stamp] button.

I
vy @®

S & @

Rotate right Quick Stamp Trimming Batch
chack Angle process

Rating

——

The copy stamp window appears.

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

(@ 2/ 3 E\Users\CANON\Pictures\Photo\ooo s odIMG, 0030.PG 5184 x 3450]

aaaaaa

ccccc

100%view to perform stamp operation

Dust spots are erased in a single operation.

Click the [OK] button to return to the main window.
The [8,] mark (p.129) is displayed on an image from which dust
spots have been erased.

@ Dust Delete Data is not attached to images having settings specified
during RAW processing on the camera for distortion correction,
chromatic aberration correction, etc. As a result, you cannot perform
automatic dust erasure processing on such images.
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? Additional Information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.123).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

The [Apply Dust Delete Data] button cannot be clicked

Even with an image that has Dust Delete Data attached to it in the
camera, if there is no dust to remove by DPP from the image, the
[Apply Dust Delete Data] button will be disabled.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.119) or the copy stamp function (p.121).

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.122).

Ny

~
-

= Useful functions of the copy stamp window

Checking the dust erased spots

After step 3, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 3, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

@ For a list of the copy stamp window functions, see p.143.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image you want to
erase dust spots.

Click the [Stamp] button.

|
vV ® @ @ @

Rotate right Quick Stamp Trimming Batch
check process

Rating

The copy stamp window appears.

When the image has redrawn itself, double-click the
point from where dust is to be erased.

(@ 2/ 3 E\Users\CANONPitures\PhotoVooor e sIMG 0050.PG 3184 x 3456)

Double-
click

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spots to be
erased.
If the dust spot is dark in color, click the [[@»(]] button, and if the

dust spot is light in color, click the [+ ] button.
When you move the cursor over the image, the dust erasure
range appears as [O].

Place the dust spot to be erased within the [O] and

click.

Brush Pendl

aaaaaa

() —— Click

Circle the dark spot to repair

The dust spot within the [Q] is erased.

Click on another part of the image to continue erasing dust spots
in the image.

To erase dust in another part of the image, either right-click with
the mouse, or click the button clicked in step 4 again to cancel dust
erasure processing and perform the operation again from step 3.
When the dust spot cannot be erased, [§)] is displayed.

Click the [OK] button to return to the main window.
The [8,] mark (p.129) is displayed on an image from which dust
spots have been erased.
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? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.121).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [Undo] button in the
copy stamp window or performing the “Re-Editing an Image”
procedure (p.123).

Check dust erasure in the copy stamp window

Check dust erasure in the copy stamp window. Images before dust
erasure are displayed in other windows and you will be unable to
check them.

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when saved as a
separate image

The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.122).

Ny

~
-

= Useful functions of the copy stamp window

Checking the dust erased spots

After step 5, you can display and check in detail the erased dust spots
one by one by pressing the <Shift> + <F> keys. (Press the <Shift> +
<B> keys to return to the previous dust spot.)

Canceling a specified erased dust spot only

After step 5, you can press the <Shift> + <F> keys or the <Shift> +
<B> keys to display the erased dust spot, and then press the <Shift>
+ <Del> keys to cancel only the erased dust spot displayed.

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

To apply dust erasure to the same place in several other images, you
can efficiently erase dust spots by clicking the images while holding
down the <Ctrl> key in the main window, or, by selecting multiple
images by clicking the first image and then clicking the last image
while holding down the <Shift> key, and then displaying the copy
stamp window.

@ For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.

@ For a list of the copy stamp window functions, see p.143.
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Compositing and High Dynamic Range .
Introduction
: : You can composite images also using JPEG and TIFF images in the
Erasing Unwanted Parts of an Image (Copy Stamp Function) same way as RAW images as described below,
You can correct an image by pasting a section copied from another part Compositing Images (p.80)
of the image to an unwanted part of the image. Creating HDR (High Dynamic Range) Images (p.83) Cgrgfannt(s:eat
Follow steps 1 to 3 in “Manually Erasing Dust (Repair
- [1] . ] - - B H
Function)” (p.119) Starting Up Map Utility .
Specify the section to be copied. You can start up Map Utility using the procedure below.
Click on the section that is to be the copy source while holding Starting Up Map Utility (p.86)
down the <Alt> key. Advanced
. . Operation
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy : Advaélg}:?l
o mage Editing
Source position]. and Printing
Correct the image.
Click or drag on the section you want to correct on the image. [+] Processing
. . L - Large Numbers
in the window indicates the copy source and [Q] indicates the of Images

copy destination.
The copied image is pasted in the position to which it was

Editing
dragged. JP§IFF
For [Pen type], you can select from [Brush] (the pasted image’s I €s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Reference
Click the [OK] button to return to the main window.
The [@,] mark (p.129) is displayed on a corrected image.
Index
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Saving Editing Results

Saving Editing Content to an Image

All the contents (recipe) adjusted with the tool palette (p.106 to p.113)
as well as the trimmed range (p.114) and dust-erasure (p.117 to p.121)
information can be saved to a JPEG or TIFF image, or to a separate
JPEG or TIFF image.

Select the [File] menu » desired item.

File

Open in Edit window Ctrl+0
Open in Edit window (enlarged)

Save Ctrl+S
Save As... Ctrl+Shift+5
Add thumbnail to image and save Ctrl+Shift+T
Convert and save... Ctrl+D
Batch process... Ctrl+B
Create new folder...

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Contact Sheet Prints... Ctrl+Shift+P
Plug-in printing 4
Add to collection Ctrl+G
Remaove frem collection Ctrl+Shift+G
Clear collection

Delete Del
Info Ctrl+1
Exit Alt+F4

Your adjustments are saved to the image.

Saving as a Separate Image

If a JPEG or TIFF image is adjusted with the tool palette (p.106 to p.113)
and then saved in the same way as a RAW image as described below,
the image can be saved as a separate image with the adjustments
(recipe) applied to it.
Furthermore, if a trimmed image (p.114) or dust-erased image (p.117 to
p.121) is also saved in the same way, it actually becomes a trimmed or
dust-erased image.

Saving as a JPEG or TIFF Image (p.42)

Batch save as JPEG or TIFF images (batch processing) (p.102)
By saving as a separate JPEG or TIFF image as explained above, the
adjustments made with the tool palette are applied, and some image
deterioration that accompanies editing/saving occurs as when editing
with ordinary image editing software.

Applying Editing Contents to Another Image

You can copy the adjustment contents (recipe) of JPEG and TIFF
images that have been adjusted with the tool palette and apply them to
another image with the procedures below, in the same way as with RAW
images.

Applying adjustment contents to another image (p.41)

Utilizing adjustment contents (recipe) (p.99)

Printing
Edited JPEG and TIFF images can be printed with the procedures
below as with RAW images.

Printing (p.43)

Printing with shooting information (p.87)

Printing a thumbnail list (contact sheet printing) (p.88)

Printing RAW images on a high-end Canon printer (p.89)
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Re-Editing an Image o
Only the image processing conditions are changed in images adjusted
with the tool palette (p.106 to p.113), so the “original image data itself’
remains unaffected. Also, the trimming range or dust-erasure
information of a trimmed image (p.114) or dust-erased image (p.117 to Cg'gfa"rfzeat
p.121) is simply saved to the image.
For this reason, you can undo any adjustments saved (p.122) to the
image, trimming range and dust-erasure information, and revert to the Basic
condition when last saved, or when the image was shot. Operation
Select the image that is to be re-edited.
Advanced
. . Operation
Select the [Adjustment] menu P desired item.
Adjustrent Ad d
vance
Rotate L.e'Ft Ctrl+L Image Edltlng
Rotate Right Ctrl+R and Printing
Apply Dust Delete Data
Work color space 3 Processing
Large Numbers
Tone Curve Assist - Standard of |mages
Tone Curve Assist - High
Revert to last saved settings Ctrl+Alt+Z E g
Revert to shot settings Ctrl+Shift+7 JP§|FF
| es

The image reverts to the conditions of the selected item.
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Reference

This reference section has been provided to enhance your experience
using DPP.

It contains various troubleshooting solutions, how to delete DPP from
your computer, explanations of the various windows and a glossary.
An Index is provided at the end of the chapter for you to easily find
information you are looking for.

Troubleshooting.........ccueiiiiiiiii 125
Deleting the Software (Uninstalling) ...................... 126
List of Main Window (Folder Window) Functions....... 127
List of Main Window (Collection Window) Functions... 128
Image Frame Information in the Main Window and Edit

Image Window...........cooiiii 129
List of Edit Window Functions ...........ccoovvviinnenneen. 130
List of Tool Palette Functions ..........ccccovvevvvnreenne.n. 131
List of NR Preview Window Functions................... 134
List of Quick Check Window Functions.................. 135
List of Edit Image Window Functions .................... 136

List of Convert/Save One Image Window Functions ..... 137
List of Trimming/Angle Adjustment Window Functions... 138
List of Lens Aberration Correction Window Functions... 139
List of Digital Lens Optimizer Adjustment Window

FUNCLIONS ..o, 140
List of Compositing Tool Window Functions............... 141
List of HDR Window (Adjust Image) Functions ..... 142
List of Copy Stamp Window Functions.................. 143
List of Convert/Save Multiple Images Window (Batch
Processing) Functions..............coooiiiiiiiiiceiiee e, 144
List of Rename Window Functions........................ 145
GlOSSANY oo 146
INAEX .. 148
About This Instruction Manual .............................. 152
Trademarks ........cccveeeeeiiiiiieee e 152

Introduction

—_—

Contents at
a Glance
D ———————

Basic
Operation

—

Advanced
Operation

—

Advanced
Image Editing
and Printing

—_—

Processing
Large Numbers
of Images

Editing
JPEGI/TIFF
Images

|

Reference




Troubleshooting

If DPP is not operating correctly, refer to the items below.

Installation could not be completed correctly

Select an administrator-level privilege ([Computer administrator],
[Administrator], etc.) as a user setting. You cannot install the software
if a user setting other than an administrator-level privilege is selected.
For detailed information on selecting an administrator-level privilege,
refer to your computer User’s Manual.

DPP does not work

DPP does not operate correctly on a computer if its system
requirements are not met. Use DPP on a computer with compatible
system requirements (p.3).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.3), if other applications are running at the
same time as DPP, you may not have sufficient RAM (memory). Exit
any applications other than DPP.

The card reader does not detect the SD card

Depending on the card reader and computer OS used, SDXC cards
might not be correctly detected. In such a case, connect your camera
and computer with the provided interface cable, and transfer the
images to your computer using EOS Utility (provided software).

Images are not displayed properly

Images that are not supported by DPP are not displayed. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2, 2.21 or 2.3 compatible images and TIFF images other than
Exif compatible images may not display properly (p.3).

When a dust-erased image (p.75 to p.79, p.117 to p.121) is displayed
in a window other than the copy stamp window, it is displayed as it
was before dust erasure was performed. Check dust-erased images
in the copy stamp window.

An image could not be adjusted

The JPEG and TIFF images cannot be adjusted using the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.131).

PowerShot Pro1 RAW images cannot be adjusted with the image
adjustment function of the [RAW] tool palette. Adjust these images
with the [RGB] tool palette (p.131).

A recipe could not be pasted (applied) to another image

You cannot paste (apply) rotation (p.10, p.25, p.127, p.135, p.136),
trimming (p.38, p.114), dust erasure (copy stamp) (p.75to p.79, p.117
to p.121) of an image to another image as a recipe. Trim the image or
erase dust of the image using the copy/paste function in each window
and rotate each image individually.

The adjustment contents (recipe) of RAW images that has been
adjusted with the [RAW] tool palette cannot be applied to JPEG or
TIFF images (p.131).

The Auto Lighting Optimizer (p.61) is a function that is only available
for RAW images shot with EOS-1D X, EOS-1D C, EOS-1D Mark 1V,
EOS 5D Mark lll, EOS 5D Mark I, EOS 6D, EOS 7D Mark Il, EOS 7D,
EOS 70D, EOS 60D, EOS 50D, EOS 700D, EOS 100D, EOS 650D,
EOS 600D, EOS 550D, EOS 500D, EOS 1200D, EOS 1100D,

EOS M2 and EOS M. You cannot apply the Auto Lighting Optimizer’s
adjustment contents to RAW images shot with other cameras.

Color appears weak in the image when viewed with
other software

A RAW image which has a color space other than sRGB set (p.79,
p.95) and is then converted and saved as a JPEG or TIFF image will
appear weak in color when viewed in software that is only compatible
with sRGB color space. In this case, set the RAW image color space
to sSRGB, convert again to a JPEG or TIFF image and save, and then
view this image.
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The colors of the image displayed on screen and
the colors of the printed image do not match

If the color of the monitor that displays an image is not adjusted
correctly, or if a profile for a printer that is to print images, has not
been set up, the color of the image displayed on screen and the color
of the printed photograph may differ greatly. If the color of the monitor
that displays images is corrected (p.95) and a profile for a printer is
set up correctly (p.95), the color of a printed photograph and the color
of an image on screen can be more closely matched. Using a Canon
printer (p.43, p.46) or linked printing (p.89, p.91) automatically sets up
printer profiles, so you only need to set the color of the monitor to
bring the colors closer together.

When printing using Easy-PhotoPrint and the Easy-PhotoPrint
automatic compensation function and the various types of image
adjustment functions are operating, colors are not printed correctly.
Cancel all Easy-PhotoPrint image adjustment functions (p.47).

Even if you set a printer profile, if you use the color adjustment
function of the printer driver, the image may print in colors different
from those displayed on screen. Do not use the color adjustment
function of the printer driver.

Printing a large number of images in batches cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

A file remains in the folder after images are deleted

Delete [CRW_YYYY.THM] (camera index display image) if it remains
in the folder from which images have been deleted (p.49).
* Numbers are entered for [YYYY] in the file name.

The image information does not display

A JPEG image set to Adobe RGB and shot with EOS 10D, EOS 300D
DIGITAL and PowerShot Pro1 may not display image information
(p.10, p.23).

Deleting the Software (Uninstalling)

Exit any applications before uninstalling the software.

Log in under an administrator-level privilege when uninstalling the
software.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.

Windows 7

Select the [ ] button » [All Programs] » [Canon
Utilities] » [Digital Photo Professional] » [Digital
Photo Professional Uninstall].

Proceed with the uninstallation as directed by the

on-screen messages.
The software is uninstalled.

Windows 8.1, Windows 8

Uninstall the software according to the OS software uninstalling
method.
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List of Main Window (Folder Window) Functions (.10

Shows/hides the tool palette (p.131) Image information (p.23)  Cancels selection of all images Displays the trimming/
Shows/hides the folder area Selects all images ‘ Displays the quick check window (p.135) angle adjustment window
Switches to the edit image Displays the copy stamp window (p.143)  (p.138)
window (p.136)
Folder path

ifjital Photc|
Edit Vielv B

Toolbar*!

. Batch conversion/
[Collection] tab sheet*>

- saving
0 iew Paleit=
[Folder] tab sheet*> — roe | conmo | (p.102, p.103, p.144)
- Desktop )
Bt Image rotation
- Music (90 degree
E‘“‘Tnl Pictures incrementS)
Check mark (p.19) o Y
§ Samp\e_Pi(_tures
@--E Videos
- Homegrou i
I...'Ecmoi P = 5 - -~ Rating (p.19)
%2 48 Computer i IMG_0002.CR2 @3 [MG_0003.CR2 EN  [MG_0004.CR2 |l@m  MG_ooos.cr2
Folder area fi- 6 Network
IMG_0007.CR2 IMG_0008.CR2 _ IMG_0009.CR2
i -
_ IMG_0011.CR2 . IMG_0012.CR2 __ IMG_0013.CR2 ) _ MG_0014.CR2 . _ IMG_0015.CR2
e i . .
Imgge CE|OI" ISDace sRGE [/ Adobe RGB High quality Redipe data: Yes Number ofimages: 15 Nlilmber of selected images: 1 oMYk ———————— @~ CMYK SImUIatlon
ana wo’ cc;gr 96 . | —— Number of selected images display (p.95)
space™ (p.79, p.96) Display mode*4 Number of displaved i
. umber of displayed images
Recipe attachment status (p.99) piay 9
*1 To switch between show/hide, select the [View] menu » [Toolbar]. *4 The item selected in [Viewing and saving RAW images] (p.92) of the
*2 The images inside the folders selected here are displayed in a [Preferences] window is displayed.
thumbnail list on the right. *5 You can switch between the [Folder] and [Collection] windows.

*3 Displays the coordinates of the cursor position and the RGB values (8-bit
conversion) when click white balance was performed with the tool palette.

R
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List of Main Window (Collection Window) Functions ¢

Image information Cancels selection of all images
Shows/hides the tool palette Selects all images ‘
Switches to the edit image

Displays the quick check window

Displays the copy
stamp window

window
Toolbar = 2P ® ® D Batch conversion/
[CO”eCtion] tab Sheet*1 Selectall  Clearal  Rotateleft Rotste right SaVing
[Folder] tab sheet
Displays the
trimming/angle
adjustment window
Rating
7 IMG_0004.CR2 IMG_0006) CR2 .
| Image rotation
(90 degree
increments)
—— Check mark
NG ODISCR2
Image 00|0r SpaC?Zand SRGE / Adobe RGB High quality Recipe data: Yes Number of images: 7 Number of selected images: 1 CMYK CMYK S|mu|at|0n
work color space — | | displa
(p.79, p.96) Display mode e

Number of selected images
Number of displayed images

Recipe attachment status

*2 Displays the coordinates of the cursor position and the RGB values (8-
bit conversion) when click white balance was performed with the tool
palette.

*1 The total number of images added to the [Collection] window is
displayed in the () in the [Collection] tab sheet. Accordingly, when an
image that is displayed as a single image is added (p.22), twice the
total number of displayed images is displayed.

)
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Image Frame Information in the Main Window and Edit Image Window (.10, p.34)

Information displayed when [Large thumbnail] (p.10) is selected

o &

B ® @ » &

Edit image Folder Select all Clearzll  Rotste left Rotst= right Guick Stamp Trimming
window wiewr chack Angle

Digital Lens
Optimizer mark
(p.70 to p.74)

Faolder ‘ Collection(0) Chedk mark Rating Wk = o
BE Desktop
Check mark -y Libraries Copy stamp mark
(p18= p19) ._-....3 Documents (p75 to p79, p1 17
= I,J‘r Music to p121)
== Pictures
= Photo —— Lens aberration
= . mff_;éf_ﬂ b correction mark
Lo ; Sample Pictures
-8 Videos (p65)
-4 Homegroup - Trimming range**
Rating mark @=-.8 CANON (p.38, p.114)
(p.18, p.19) w .18 Computer
- N k
Brightness —— ‘ Aperture*3
adjustment ﬁ E]
*1 - edek E— 1400 1/400
value*' (p.26) é% IMG_0001.CR2 IMG_0002.CR2 Gps
k " *5
White balance icon*" File name Unsaved editing content mark GPS mark

(p.28)

Image type*2 Shutter speed*3

*1 Does not display with [Small thumbnail].

*2 Displays in RAW+JPEG images displayed as a single image (p.22).
[RAW] is displayed in RAW images.
(In [Small thumbnail] (p.10), [R] is displayed.)
In PowerShot Pro1 RAW images, [RAW] is not displayed.

*3 Does not display with [Medium thumbnail] or [Small thumbnail].

*4 When aspect ratio information is attached to an image shot with
EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds Mark IIl, EOS-1D
Mark 111, EOS 5D Mark Ill, EOS 6D, EOS 7D Mark Il, EOS 7D, EOS
70D, EOS 60D, EOS 700D, EOS 100D, EOS 650D, EOS 600D, EOS

*5 Displayed on images shot on a GPS function-compatible Canon
camera.

1200D, EOS M2 or EOS M, the image is displayed as a trimmed image.

)
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List of Edit Window Functions .11, p.25)

Path and file name of image

File Edit View Label Adjustment Tools Window Help

(1155,1688) : 42, 44,28  RAW [ Adobe RGE CMYK High quality

"

Information display*2 Display mode*4

Image color space*3 and work CMYK simulation display (p.95)
color space (p.79, p.95)

Tool palette*! (p.131, p.132, p.133)

[ 1c_ooo1.cr2

RAW  |ReB | nRjaLo [ LENs |

| Brightness adjustment J
[ 0.00
|White balance adjustment E]]
DEIE Register...
@ o) v ) Tune.. ]
||Picmre Style E]||

[@ (s5tandard) - | Browse...

Contrast:(0) a 1
Highlight:(0)

Shadow: (D)
[ Linear

Color tone: (0)

Color saturation:{0)

[Unsharp mask. v]
Strength:(0) [
Fineness:(0) [
Threshold:(0) [

== iy =] & &

J
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*1 To switch between show/hide, select the [View] menu » [Tool palette]. *3 RAW images are displayed with [RAW].
*2 Displays the coordinates of the cursor position and the RGB values (8- *4 The item selected in [Viewing and saving RAW images] (p.92) of the
bit conversion). [Preferences] window is displayed.



List of Tool Palette Functions

RAW Tool Palette (p.25)

IMG_0001.CR2 =
RAW [RGB | NR/ALO | LENS
Brightness adjustment
0 0.00
White balance adjustment ]'
Register...
’@ (Auta) v] Tune...
|Picture Style =)
’@ (Standard) || Browse...
] ] ] Y ;
] v l!!!'. i
: VA
i & B
i b 4
'“'-.

;\'IL"’" |II'A ;

-10.0 8.0 -6.0 -40

-20 0.0 20 40

Contrast:(0)
Highlight: (0)

Shadow: (0)
[ Linear,

Color tone:(0)
Color saturation:(0)

IUnsharp mask 'J
Strength:(0) [
Fineness:(0) [

0

z

Threshold: (0)

Brightness adjustment (p.26)

i— White balance adjustment

(p.28, p.56)

Picture Style settings (p.26, p.59)

Dynamic range adjustment (p.57)

Contrast adjustment (p.29)

Shadow/highlight adjustment (p.57)

Linear setting (p.29)

Color tone and color saturation
adjustment (p.30)

'~ Sharpness adjustment (p.31)

[ [Sharpness hd ] J
Sharpniess: (1) {1

Enlargement display position*

* If animage is displayed enlarged, the enlargement display position can
be moved by dragging. The enlargement display position appears
when [Docking display] (p.94) has been set and the editimage window
(p.136) has been enlarged.

RGB Tool Palette (p.60)

| IMG_0001.CR2 =
[aw | ReB  |nrjaLO | LEns |
|T0ne curve assist Ea
|Tor|e curve adjustment
| 3]

255

0

Brightness:

Contrast:

Hue:

Saturation:

Sharpness: [}

-
\

Automatic adjustment
(tone curve assist) (p.33, p.107)

Click white balance (p.109)

Tone curve adjustment
(p.58, p.111)

Dynamic range adjustment (p.112)

Brightness and contrast
adjustment (p.108)

Hue and Saturation adjustment
(p.110)

Sharpness adjustment (p.110)

Enlargement display position*
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NR/ALO Tool Palette
(When a RAW image is selected)

NR/ALO Tool Palette
(When a JPEG or TIFF image is selected)

IMG_0001.JPG

Rew |ReB | MRMALO LENS |

Chrominance noise reduction:(3)

1] ] 0

TIFF/IPEG

e e
Res [RGB | MRAALO |LEMS |
| Auto Lighting Optimizer |
U It Auto Lighting Optimizer (p.61)
Low Standard Strong y
[ Noise reduction o —f— Apply noise reduction button (p.62)
- [ MRPreview... Displays the [NR Preview] window
Luminance noise reduction: (1) (p62’ p1 34)
i o Luminance noise reduction for

RAW images (p.62)

Chrominance noise reduction
for RAW images (p.62)

| Noise reduction oy Apply noise reduction button (p.113)
[ mereview...  —+i+— Displays the [NR Preview] window
g (p.113, p.134)
TIFF/IPEG

Enlargement display position*

* If animage is displayed enlarged, the enlargement display position can
be moved by dragging. The enlargement display position appears
when [Docking display] (p.94) has been set and the editimage window
(p.136) has been enlarged.

Luminance noise reduction: ()

Luminance noise reduction for
| t 0 = JPEG and TIFF images (p.113)

Chrominance noise reduction: {J) . . .
o O » Chrominance noise reduction for
JPEG and TIFF images (p.113)

Enlargement display position*

)
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LENS Tool Palette

IMG_0001.CR2 =

RAW | RGB | NR/ALD | LENS

| Digital Lens Optimizer Tune...

Setting OFF I }

Lens data : Yes

Lens aberration correction Tune... ]—I

Peripheral ilumination OFF

Chromatic aberration OFF
Color blur OFF

Distortion OFF

Digital Lens Optimizer adjustment button (p.73)
Amount of Digital Lens Optimizer (p.72)

Lens data status (p.72)
Lens data Update button (p.72)

Lens aberration correction adjustment button (p.65)

Lens aberration correction (p.65)
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J

List of NR Preview Window Functions (62 p.113)
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' NR Preview

|

; e Apply noise reduction Basic
| Opeiaton
—_—
. Advanced
Enlgrgement display Operation
Navigator window Advanced
Image Editing
and Printing
S ——
Image type*
_ : — < Processing
[Lumlnance noise reduction: (7) ‘ ‘ Luminance noise Lar%(-i Numbers
L 0 i reduction _or'mages |
Chrominance noise reduction: (8)
Chrominance noise Editing
0 i 20 ) reduction JPEGITIFF
Images
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NR check window

* When you select a JPEG or TIFF image and display the [NR Preview]
window, [TIFF/JPEG] appears and you can reduce luminance noise
and chrominance noise for the JPEG and TIFF images.



List of Quick Check Window Functions .16 p.18)

50% view/100% view (moiré reduction off)/full view*'

Path and file name of image

wew H Full screen ]
ﬁﬁﬁ Check mark

Check mark display

Clear ‘

_ . annne

Rating mark display ——

[ f

Image Information ]

[ Rotate left H Rotate right l

*1 You can select 50% view/100% view (moiré reduction off) by selecting
[Preferences] in the [Tools] menu and using [Quick check tool display]
in the [View settings] tab sheet. You can also move the display
position in the enlarged display by dragging the image.

*2 To return to the normal screen, press the <Esc> key.

Displays the image in full screen*?

Removes check
marks (p.18)

Check marks (p.18)

Rating (Reject)
(p.18)

Rating (p.18)
Switches between
displayed images
Displays the AF
points (p.16)
Displays the image
information window
(p.24)

Image rotation
(90 degree
increments)

)
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List of Edit Image Window Functions (.34 p.36)

Shows/hides tool palette Shows/hides grid*4 Enlargement ratio of displayed image Displays the trimming/
Shows/hides thumbnail display area Image information (p.23) Displays the copy stamp window angle adjustment window
Switches to main window (p.127) (p.75to p.79, p.117 to p.121, p.143) (p.38, p.114, p.138)

Edit View Label |Adjustmept Tools | Help

Image path and fle name —— BE s Fo ==

® ©® ® & 2 Batch conversion/
WJ:E Rotate left Rotate right Stamp Tr::rg.lr:g ;:t:::“ SaV|ng
—1 (p.102, p.103, p.144)

Toolbar

RAW |RGB | NR/ALO | LENS

’ { ‘ Brightness adjustment
0 000 Image rotation

’ { \ba'ma _ (90 degree
’ { o T J]| increments)
’ a {_ — lajl Switches between
’_ @D MG 000LCR2 { [ﬂ (Standard) -|[ Browse... dlSpIayed imageS
| |
; - ’t L | Tool palette

Thumbnail display area*3 ’ { TSI R S (p.131)

Contrast:(0) {
(P e | el :
’ Color tone:{0) - I
Calor saturation:{0) {}
’ [Sharpﬂess ']
’ Sharpness: (1) {1
Pi—
JEm_ MG Oi;R2
Information display*2 ’h{
‘ ﬂaaq): 99,118,162 RAWfAd::he RGEB CMYK High quality
Image color space*! and work | \— Display mode*>
color space (p.79, p.95) CMYK simulation display (p.95)
*1 RAW images are displayed with [RAW]. *4 You can set the grid spacing with [Grid pitch] in the [Preferences]
*2 Displays the coordinates of the cursor position and the RGB values ; (p.93).
(8-bit conversion). *> The item selected in [Viewing and saving RAW images] (p.92) of the
*3 Displays images selected in the main window. The image selected [Preferences] window is displayed.

here is enlarged and displayed on the right.

J
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List of Convert/Save One Image Window Functions (.42

Savein: , Photo r @F g
Types of image |
Type of image Extension Rece’i’:aces N
Exif-JPEG JPG Vs
Exif-TIFF 8bit .TIF Desktop
TIFF 16bit TIF o i o
Exif-Tiff 8bit+Exi-JPEG | .TIF/.JPG Lol Save destination
TIFF 16bit+Exif-JPEG | .TIF/.JPG e
LY
Computer
File name @
MNetwork > ! 7
File name: ING_0001 - Save
Saveastpe:  |BdfJPEGCJPG, JPEG) ~| [ Cancel |
Quality setting
Resolution*1 Image quality 0 1w JPEG compression rate*3
Cutput setting ’
Output resolution 330 dpi [#] Embed 1CC profile in image

Embeds of ICC profiles*2 (p.146)

I[ Resize setting
|:|Resize
Size changing*4 width

L

Lock aspect ratio

N\

pixel

-
Shooting info setting
@ fnclude all shooting info:
") Remave only GPS info

(") Remove shooting infa
&

Shooting information setting*®

J

J

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.79, p.95) information that is set in an image is attached
to an ICC profile.
Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.79,
p.95), the ICC profiles are embedded automatically.

*3 The setting range is 1 to 10. The higher the numerical value, the higher
the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the
longer edge of an image and change its size.

*5 Shooting information setting can be selected.

)
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List of Trimming/Angle Adjustment Window Functions (.3 p.114)

Cancels all the trimming (aspect ratio) information

T
—]

Full screen

= 1/ 1 EAUsers\CANOMN\Pictul _ . . i ——

l Clear

Aspect ratio
Free
1.50 i

Reset

X
04 362

idt Heigl
1577 x 1051

Angle 10.10 =

‘ Rotate left Rotate right

| Copy

/] Show borders

|
Cpadty l

5]

| Show Grid
Grid Dltd'l

| Center on Screen

Cancel

(704, 362) -» (2281, 1413) = (1577 x 1051) [ 1.50]

. - I—

Trimming range
it to another image*2

Full screen display/returns to normal screen

Reverts to the condition when the image was shot

Ratio of trimming range (you can also enter
numerical values if you have selected [Custom])*1

Upper left coordinates of trimmed range (you
can also enter numerical values)

Size of trimmed range (you can also enter
numerical values)

Angle of image adjusted

(Drag bar, use the mouse to click A/V or enter
numerical values to set angle)

Applies the copied trimming range to all other
images*2
Switches between displayed images*?

Displays borders around a trimmed range
Level of opacity outside a trimmed range
Shows/hides grid lines

(Drag bar to set distance between grid lines)

Displays the trimming range in the center of the
window

Copies the trimmed range and applies (pastes)

Image rotation (90-degree increments)

“1 If [Free] has been selected in the [Aspect ratio] list box, you can also
drag the borders of the trimmed range to change its range.

*2 Operates when you have selected multiple images and the trimming/
angle adjustment window is displayed.
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List of Lens Aberration Correction Window Functions 65

When the list box for selecting an extender is displayed in the
[Lens aberration correction] window, select the extender
attached at the time of shooting from the list box.

e
i Lens aberration correction - [IMG_0001.CR2]

Enlargement display position
(Navigator display)

*1 The area you clicked on the image (Enlargement display position) is
displayed at 200%.

To correct distortion aberration of images shot with a fisheye lens,
four effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.

Enlargement display section*!

Reverts to the condition when the
image was shot

Shooting distance information
slider*? (p.68)

Peripheral illumination correction

[7] Peripheral illumination

| Chromatic aberration

Chromatic aberration correction

)( Corrects blue chromatic aberration
Color blur correction

[ Distortion

Distortion correction

Shows/hides position of
enlargement display section
>

jad. ) Grid display

| OK | | Cancel

Corrects red chromatic aberration

*2 For RAW images shot with MP-E65mm /2.8 1-5x Macro Photo or
EF50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to the zoom magnification.

The slider is not displayed for images shot with an EF-M lens.
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List of Digital Lens Optimizer Adjustment Window Functions .7

When the list box for selecting an extender is displayed in the
Digital Lens Optimizer window, select the extender attached at the
time of shooting from the list box.

i “a

. '# Enlargement display position (Navigator display)

=3 Shooting distance information

Shooting distance information slider*? (p.74)

[¥] Setting : (100) Digital Lens Optimizer adjustment (p.74)

[Do not sharpen previews] check box (p.74)

Enlargement display section*’

*1 The area you clicked on the image being enlarged (Enlargement display position) is displayed at 100%.
*2 The slider is not displayed in the Digital Lens Optimizer window for images shot with an EF-M lens.

J
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List of Compositing Tool Window Functions (.50

7 A= S

100% display (p.81)

Foreground Image

[ 100% view ]
] ‘l‘

Select foreground image (p.81)

[mMc_ooo2.cr2 - ‘

Thumbnail display for foreground

‘ image (p.81)
Composite Method
[Weight=d - i Select composite method (p.81)
V] compose in Raw Format ——g—————— Jse RAW compositing (p.82)
Weight 500 = |‘
: b; Weighting slider (p.81)
Position
lead
@E%@@ Alignment controls (p.82)
¥
X |0 = v o0 3
[ Continue ) Continue compositing (p.83)
[ Sawve As... ]
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List of HDR Window (Adjust Image) Functions (3

Presets

[

p
Tone/Color
Brightness:(55)

i
Saturation: (50)
I
Contrast: (50)

{

\

Detail Enhancement
Strenath: (0)

1]
Smoothness: (0)

1]

Fineness: (0)

T}

| ‘

I Save As...

IMG_0001,CR2 / IMG_0002,CR2 / IMG_0003.CR2 [

Close

Select an effect (p.85)

Adjust tone/color (p.85)

Adjust detail emphasis (p.85)
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List of Copy Stamp Window Functions .75t p.79, p.117 to p.121)

| 100% view H Full screen

[ Apply Dust Delete Data

Repair

(Dark)

Repair
{Light)
OO | @O

Select Copy Source

[] Fix Copy Source position

Pen type
@ Brush

Radius
=

[Undo

Copy

Paste

[ Previous

J{

MNext

1

Full screen display/returns to normal screen
Applies Dust Delete Data (p.75, p.117)

Types of dust to be erased (p.77, p.119)

Specifies the copy source (p.79, p.121)
Fixes the copy source position (p.79, p.121)

Types of stamps (p.79, p.121)

Sets the size of the dust erasure range (p.77,
p.119) or copy range (p.79, p.121) in a range of
5to 100 (in one pixel increments) (you can also
enter a numerical value)

Restores/redoes the image

Copies the dust erasure range or copy range
and applies (pastes) it to another image

[ ok

J(

Cancel

]

Set to 100% view to perform stamp operation

"

* Operates when you have selected multiple images and the copy
stamp window is displayed.

Switches between displayed images*
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)

List of Convert/Save Multiple Images Window (Batch Processing) Functions (.102) .
—_
Batch settings [ — S .-__:
IMG_0001.CR2 Save folder [ . i Contents at
File names of images to be N [ Er\Users\CANON Pictures Save destination a Glance
batch saved s P H "
IMG_0006.CR2 Kind of fle [Exif-PES v) Types of image
IMG_0007.CR2 H BaSic
IMG_0003.CR2 b ' = Type of image Extension Operation
Embeds ICC profiles*2 (p.146) —jje=eia-cr2 Output setting | .
. 1 mg:ggiéggi Output resolution 35|D dpi [V]Embed ICC profile Ele'J PEG J PG
Resolution e =T ~ Exif-TIFF 8bit TIF
IMG_0015.CR2 ) ["|Resize Lock aspect ratio TIFF 16bt TIF Advan“?ed
Size changing*4 — . ' . Operation
pixel Exif-Tiff 8bit+Exif-JPEG | .TIF/.JPG —
s X TIFF 16bit+Exif-JPEG | .TIF/.JPG Advanced
() Current file name Image Edltlng
, and Printin
— JPEG compression rate*3 anc rinting
0 . Processing
String Sequence number F|Ie name Large Numbers
DPP_ 0001 of |mages
|| save sequence number
\_ Ex.: DPP_0001.JPG, DPP_0002.JPG... ) Ed|ting
Slimoting infa Setting. . ) JPEG/TIFF
e Shooting information setting*6 Images
() Remove only GP3 info —
() Bemove shooting info )
( Image transfer settings )
Open image using software Batch transfer to other image editing R
—r—— software (p.103)
Images to be Converted are '[ Convert RAW images only ] [ Execute ] [ Cancel ]

limited to RAW images*5

*1 The setting range is 1 to 60,000 dpi.

*2 Color space (p.79, p.95) information that is set in an image is attached
to an ICC profile.
Even if you remove the check mark from images that have been set to
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.79,
p.95), the ICC profiles are embedded automatically.

*3 The setting range is 1 to 10. The higher the numerical value, the higher
the image quality becomes.

| Save

*4 The larger of the two values set in [Width] and [Height] is applied to the
longer edge of an image and change its size.

*5 Appears when you click the [Batch process] button (p.127, p.136)
without an image selected in the main window or the edit image
window. To convert RAW images only, instead of clicking the [Execute]
button, click this button.

*6 Shooting information setting can be selected.

O
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Order in which images are sorted

Checkmark to apply the same
name to RAW images and JPEG
images recorded simultaneously

Checkmark to copy the images
Click the [Browse] button and set
the save destination

List of Rename Window Functions .104

\

(File name Extension
DPP  Shooting Date,Time » Sequence number ~ | Do not change -

( Basic Settings

Sort
(@) Fit to main window
() File name

() Shooting Date/Time

Same file name for RAW +JPEG images )

( Format settings

Sequence number

ool [ save sequence number

Shooting Date/Time

[Year Month Day

[rv4mo0

( [ copy and Reename

Browse...

E:\Users\CANON'Pictures

Original File Name

Insert underbar

\

\

Modified File Name

IMG_0001.CR2
IMG_0001.JPG
IMG_0002.CR2
IMG_0002, PG
IMG_0003.CR2
IMG_0003.JPG
IMG_0004.CR2
IMG_0004.JPG

DPP_06-09-13_0001.CR2
DPP_06-09-13_0001.JPG
DPP_06-09-13_0002.CR2
DPP_06-03-13_0002. PG
DPP_06-09-13_0003.CR2
mp | DPP_06-03-13_0003.JPG
DPP_06-09-12_0004.CR2
DPP_06-09-12_0004.JPG

(Beae ] |

Cancel

Sets the new file name

Sets the format of information
in the file name

J
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Glossary
RAW image

EOS camera RAW images are recorded in an uncompressed 14bit or
12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.
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Introduction
Color space CMYK simulation profiles
A color space is the reproducible color range (color gamut A profile that simulates colors when printing in a CMYK environment
characteristics). DPP supports the following five kinds of color space. (printing machine, etc.). With DPP, you can simulate color with four Contents at
sRGB : Standard color space for Windows. Widely used for types of profile. a Glance
the standard color space of monitors, digital Euro Standard : Profile normally used for book printing in
cameras, and scanners. Europe, suitable for simulation of standard
Adobe RGB : A wider color space than sRGB. Mainly used for European printing. Basic
printing for business purposes. JMPA : Profile normally used for book printing, etc. in RpSiatel
Apple RGB : Standard color space for Macintosh. A slightly Japan, suitable for simulation of magazine
wider color space than sRGB. advertising standard color printing. Advanced
ColorMatch RGB : A slightly wider color space than sRGB. Mainly U.S.Web Coated : Profile normally used for book printing in Operation
used for printing for business purposes. North America, suitable for simulation of
Wide Gamut RGB : A wider color space than Adobe RGB. North American standard printing.
Refer to the color chart below for the color area of each color space. JapanColor2001 type3 : Profile becoming a standard in the Japanese Advanced
TN ; ; ; Image Editing
printing industry, swtablg fpr simulation of B siabinG
Color chart of color spaces compatible with DPP JapanColor standard printing.
Processing
y . .
o Rendering intent Lazgf?rﬂ:';‘é’i =
E— Adobe RGB Rendering intents are color conversion methods when printing an image.
p— %E’f’iﬁ{fgs The conversion method of each rendering intent is shown below. Editing
06 Perceptual : Before and after conversion, all colors are JPEG/TIFF
Color range that can be converted to maintain the relationship between LTEES
seen by the human eye colors. Even where colors slightly change, you
04 can print a natural-looking image which has
maintained color harmony. However, Reference
depending on the image, the saturation may
02 change overall.
Relative Colorimetric : There will not be much conversion to colors
which are similar before and after conversion,
0 02 04 08 08 X but colors which are not similar are converted
appropriately. Because there are little changes
Gamma White point to similar colors which comprise most of an @ @
value (color temp.) image, you can print a natural-looking image in
—— | sRGB 2.2 6500K(D65) which the saturation has not changed greatly.
R Adobe RGB 2.2 6500K(D65) However, depending on the image, there are
............ Apple RGB 1.8 6500K(D65) cases where the overall tone of an image
————- ColorMatch RGB 18 5000K(D50) chapges somewhat as colors which are not
______ Wide Gamut RGB 292 5000K(D50) similar and highlights change. 147




Index

A

AdJUuSt JPEG IMAQgES.....ceviiiiiiiiiiiiiiiee ettt 106

Adjust RAW IMaAgES .. .. eeeeeeeeeeeneeeeees 25

AdjUSt TIFF IMageS.......uuviiiiiiiiiiiiiiiiiiiiiiieiieet et 106

Adjusting (JPEG or TIFF Image)
Automatic Adjustment (Tone Curve Assist)............ccceeeeeeeinennn. 107
BrIgNINESS .....eeeiiiiiieie e 108
Click White BalancCe ............euuvviiiiiiiiiiiieiieeieeeeeeeeeeeeeeeeeee e 109
(O70] ] (=13 USSR 108
DynamiC RanNQe......couuuuiiiii i 112
HUB e 110
RGB T0oOol Palette .......ccooviiiiiiiieeee e 131
SAtUrAtION ... 110
TR E= Ty o] g [oT TP 110
Tone Curve Adjustment..........oooiiiiiiiiiii e 111

Adjusting (RAW image)
Apply AdJusStments...........oeceiiiii s 100
Automatic Adjustment (Tone Curve AsSist)........ccccoeiiiiiiiiiiinnnnns 33
BrGhINESS ..o 26
Brightness of Highlights............coooiiiiii e, 57
Brightness of Shadows............ccovviiiiiiiiiiiiee e 57
Click White BalancCe ..............uuuuueiiiiiiiiiiiiiiiiiiiiiiiiiiieiieeiveeneeeeieeneees 28
Color Saturation .............cccccveeeiieiiiiiiiiiiieeee e 30
Color TEMPErature ........cooiiiiiiiiiieee e 56
(@70 ] (o TN o) 1= TSP 30
(070 ] Lo AT o= 56
(@70 ] (= TS SRR 29
Copy AJUSTMENTS .....vviiiiiiiiiiiiiiiiiie et 100
DynamiC RanNQe......cocuuuiiiiii e e 57
Filter Effect ... 31
MONOCNIOME ..o 30
Personal White Balance ... 101
Picture Style ... 26
Picture Style File ... 59
R VA ool =1 1= 1 £ 131
Save AJJUSIMENTES ......coeiiiiiii e 100
Tone Curve Adjustment..........ooiiiiiiiiie e 58
ToniNG EffeCt ... 31
Tool Palette ... ..o 131, 132
White BalanCe ... 28

Adjustment Contents (RECIPE).......ccevvviiviiiiiiieiiiiiiee e 99, 146
AdOBE RGB .. ..o 147
APPIE RGBi.....eeeieeeeeeeeeeeeee ettt e e e 147
LN g =T gTo [ [ E=To [ PP 20, 21
Auto Lighting Optimizer ... 61
Automatic Adjustment (Tone Curve AsSiSt).......coovvvvvivieeiieiieennenn. 33, 107
Automatic Dust Erasure Processing.......cccccceevveeveeeneenn. 75,776,117, 118
B
Batch Apply White Balance to Images (Personal White Balance)..... 101
Batch Change the File Name of Images.........cccccooviiiiiiiiiiiiniiiine, 104
Batch Convert/Save Images (Batch Process) ..........oevevvevvivvveevienennee. 102
Batch Process (Batch Save JPEG and TIFF Images)............... 102, 144
Batch Process of Multiple Images
Change File Name ........coooiiii e 104
Convert/Save (Batch Process)........ccccccoviiiiiiiiiiiiiiiiiiiine, 102, 144
Personal White Balance.................ccccocoiiii 101
Recipe Data ........ooovviiiiiiiii 99
L= 1153 (=T PRt 103
Batch Settings Window..........ccccooviiiiiiiiiiiins 102, 103, 144
Batch Transfer Images ... 103
Batch Transfer Images to Image Editing Software..............ceeeveeeeee. 103
Before/After Comparison Display .............eeeeeeiveeiiimiiiiiiiiiiieeieeeeeeeeeeeeee 53
bit NUMDer ... 146
BOOKMAIK ... 51
BrightnesS. ..o 26, 108
C
Change File Name..........ouiiiiiiiiiiie e 104
Changing the File Name of Images in the Order in the Main Window............ 104
CheCK MarK .......cooieiiiiiiiiiee e 18, 19, 129, 135
Chromatic Aberration Correction ............coooeciiiiiee e, 65
Chrominance Noise Reduction (JPEG, TIFF Images).............ccu...... 113
Chrominance Noise Reduction (RAW Images) .........cccccveeeeeeeeeiicnnnenn. 62
Click White BalanCe..........cooounieeeeeeeeeeeeeeeee e 28, 109
CMYK SIMUIALION .o 95, 97, 147
Collection WINAOW .......coeeieeeeeeeee e 6, 36, 128
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(070] (o] g =1 (1] g @705 = To1 1 o] o OO RERPR 65
Color Chart.......ccooviiiii 147
Color Management (Color Matching).........cooocvviieeiieeeiiiiiiiiieeee e 146
Color Setting of the Monitor (Profiles) ..........cccccoviiiiiiieennenn. 95, 96
Color Setting of the Printer (Profiles)..........ccovvviviviveeeiieviennnee. 95, 96
(070] (o] gST o7 Tt TN 147
(@O o o] {11 146
Color Management (Preferences)........ccccceeeeiciiiiiiiee e 95
Color Saturation............ccoveiii 30
Color Setting of the Monitor (Profiles)...........cccccvveeiiiiiiiiieeeees 95, 96
Color Setting of the Printer (Profiles) ..., 95, 96
Color SPaCE .....ccooeiiiii 147
AdODBE RGB ... 147
APPIE RGB ... 147
Color Space Setting for Each Image ..........cccccoviiiiiiieineiiiine 79
(0701 o] 1Y/ F= 1 (ot a T 2] = 147
Default Setting of Color Space .........cevvvvveeeveeeviiiieieieeeeeeeeeeee, 95, 96
SRGB ... e a s 147
Wide GamUt RGBi..........ovveiiiiieieeeeeeee e 147
Color Space Setting for Each Image...........cocccviiiiiieiiiiiiiiiiieee e 79
Color Temperature..........cccooevveiieiiee 56
(©70] o] gl 1o o 1= TSRO PRRRRR 30
Color Whee€l ..., 56
ColorMatch RGB.........cceeeeee e 147
Compatible Cameras with the Lens Aberration Correction Function......... 63
Compatible Lenses with the Lens Aberration Correction Function..... 63
Compositing IMAgES .......cueeiiiiiie e 80
Contact Sheet Printing (Printing a Thumbnail List)...........cccccceeeennies 88
(070] 011 7= 11 AFUTT TR 29, 108
Convert to JPEG or TIFF Image and Save................. 42,102, 137, 144
Convert/save One Image Window ..............cccee e, 42 137
Copy Stamp (Image Correction) .........c.ceeeeeeeiiiiiiiiiieiee e 79, 121
Copy Stamp Window ... 75,777,117, 119, 143
Copying and Pasting (Applying) ReCipes.........cccccvveiiiiiiiiiiieeeeeees 100
Correct Images (Copy Stamp Function) .........................l. 79, 121
Creating @ FOIAEN ... 50

D

Default Noise Reduction Settings...........ooovciiiiiiiiiiiiiiie 95
Default Setting of Color SpPace ..........ccvevviiiiiiiiiee e 96
Delete IMages ... ... 49
Deleting

Delete Images ... 49

Delete the Software ..., 126
Deleting DPP (Uninstalling) .......cccvvviiiiiieiiieeee e 126
Detailed Setting Printing (Printing with Shooting Information)............. 87
Digital Lens OPtiMIZEr .........cooiiiiiiiiiiiee e 70
Display

Before/After Comparison Display.........c.cccccoooei, 53

Enlarged Display (Edit Window) ............cc.cccl 11, 130

Enlarged Display (Quick Check Window) ..........cccccevveeeeennnes 16, 135

Shooting Information Display ..........cccccevviivviiiiiiiiiiiiiiiiiiennnns 10, 23

Single Image Display .........cooooiiiiiiiiiee e 22

Synchronize Edit WINAOW ...........ouiiiiiiiiiiiiieeee e 54

Thumbnail Display (Main Window)............cccccveeeereeeeiiiieeee. 10, 127

Thumbnail Display and Enlarged Display

(Edit Image Window)........ccuuieiiiiieiiiieee e 34, 136
Distortion CorreCtioN ............ooiiiiiiiiieie e 65
Downloading an Image to Your Computer ...........ccocccviiiieeeeiiiiiiiiieen. 7

Downloading Images from a Camera ...........ccccceeeeiiiiiiiiiieeeee e, 7

Downloading Images from a Card Reader......................cceeeeeeee. 9
Downloading IMages ...........uuuuuuiiiiiiiii e 7
Downloading Images from a Camera...........ccccceveeeeeiiiiiiiieeee e 7
Downloading Images from a Card Reader ............ooccveeieeeeiiiiiiiiiieee.
Dust Delete Data ..........cooooiiiiiiies
Dust Erasure Processing

Automatic Dust Erasure Processing ...,

Image Correction (Copy Stamp Function)

Manual Dust Erasure (Repair Function) ............cccceeeeeeinnns 77,119
DynamiC RANGe ..........uuiiiiiiiiiiie e 57,112
E
Edit Image WINdOW.............uuuiiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeeeeeee e 34, 136
Edit WINAOW ... 11, 130
o111 T - Adjusting
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Enlarged Display (Edit WiNdOW) ........ccooiiiiiiiiiiiiee e 11, 130
Enlarged Display (Quick Check Window) ...........ccceiviiiiiiiieeeeeiines 135
EOS ULty ..o 7
EXItING DPP ...t 14
F
False Color Reduction ...........coooiiiiiiiiic e 92
Filter Effect.... .o 31
[2T0) [0 L= gAY o o [0V 2T 6, 127
G
General Settings (Preferences) ........ccccvveeeviiciiiiiiieee e 92
H
HDR (High Dynamic Range) Images...........cccccceeeiiniiiiiiiieiee e 83
[ 1= o Cover
Highlight Area Warning Indicator ...........cooooi oo, 55
HUE e 110
|
[CC PrOfileS ...t 146
Image Frame Information (Image Marks) ........cccccoiiiiiiiiiiiiiniiiiinne. 129
Image Marks (Image Frame Information) .........ccccccvveviiviieniiiniinnnnn.. 129
Image Quality
Default Noise Reduction Settings............ccccee, 95
False Color Reduction.............coovviiiiiiiiiiiiie e 92
Improve the Quality of an Image (Main Window) ...........cccceeeee.... 23
Noise Reduction of a JPEG Image (Luminance, Chrominance)....... 113
Noise Reduction of a RAW Image (Luminance, Chrominance) ... 62
View and Save a RAW Image ... 91, 92
Image Shooting Information Display ............ccccceeeiiiiiiiiiiiiecs 10, 23
Improve the Quality of an Image (Main Window)..........ccccoevviviieennenn. 23
J
B | L [ 4= Lo = TP 146
L
Lens Aberration Correction ..o 63
Lens Aberration Correction Window .........c.oveeeeveeiieiieiaeees 65, 139
LENS Tool Palette ......ccoooeieeeeeeeeeee e 133

LN e 29
Loading and Pasting (Applying) ReCIpes.........cccccvviiiiiiiieeiieeiiiee 100
Luminance Noise Reduction (JPEG, TIFF Images) .......cccccceeveunnneee. 113
Luminance Noise Reduction (RAW IMages) ........cccovvivvveeeeeeeiiiiiinnnen. 62
M
MaIiN WINAOW ... et e et e e e 10, 127
Manual Dust Erasure (Repair Function)..........cccccevvveiieeeiiviienneen. 77,119
MAP ULITIEY e 86
MONOCNIOME. ...t 30
Filter Effect ... 31
ToniNg EffeCt ... 31
MoVe Or COPY FOIAEIS .....cooeiiiiiiiiieee e 51
MoVe Or COPY IMAGES ...oevveeieieiiiiiieee e 50
N
Noise Reduction (JPEG or TIFF Image)......cccccceveviiiiiiiiieieeeeee 113
Noise Reduction (RAW IMage) ......ccoeeerviiiiiiiiiiiee e 62
Noise Reduction of a JPEG Image (Luminance, Chrominance) ....... 113
Noise Reduction of a RAW Image (Luminance, Chrominance) .......... 62
NR Preview WindOW..........ccueiiiiiiieeeeieee e 62, 113, 134
NR/ALO Tool Palette .......coooiiiie e 132
o
Organize IMages .......cooooeiiiii e 49
Organizing IMagES ........uueiiiiiiiiii e 49
Create @ FOIAer .........oviiiiie e 50
Delete IMages ..o 49
Move or CopY FOIAErS.........uuiiiieeiiiiiieieee e 51
Move Or COPY IMAGES .......uviiiiieeeeeiciieiie e 50
Register Folders as Bookmarks..............ccccviiiiiiiiienniiiiiiiiieeen 51
P
Peripheral lllumination Correction .............cccoueeveeeeiiiiiiiiiee e 65
Personal White Balance ..............oovvviiiiiiiiiic e 101
PiICture SEYIE ....ooeeeeeeeee e 26
Picture Style File..........oveeieeeeeeeee e 59
PreferenCes ... 91
Color Management ...........coeiiiiiiiiiiiiee e 95
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General SettiNgS.......uueiiiiie e 92
TOOl Palette ... 94
VIEW SEHHNGS...eeeiiiiiii e 93
Printing
Printing a Thumbnail List (Contact Sheet Printing) ..................... 88
Printing One Sheet of Paper ..o 14, 49
Printing Using Easy-PhotoPrint ..o 46
Printing Using Easy-PhotoPrint EX ... 43
Printing with a High-End Canon Printer............cccoiiiiiinee. 89
Printing with a Large-Format Canon Printer.............cccccceivinnee. 91
Printing with a Printer other than Canon Printers ......................... 49
Printing with Canon Inkjet Printers ..........ccccccoiiiiiiiis 43, 46
Printing with Easy-PhotoPrint Pro ..........cccccco, 89
Printing with Print Studio Pro..........ccooo 90
Printing with Shooting Information (Detailed Setting Printing)...... 87
Rendering Intents when Using Easy-PhotoPrint .................... 95, 97
Printing a Thumbnail List (Contact Sheet Printing)............ccccccvvvvvinnn. 88
Printing One Sheet of Paper..........cooooiiioiiiiiies 14, 49
Printing Using Easy-PhotoPrint...........cccccceoiiiiiiee e, 46
Printing Using Easy-PhotoPrint EX..........oooo 43
Printing with a High-End Canon Printer...........cccoooiiiiiiiiiiiiins 89
Printing with a Large-Format Canon Printer .............cccoiiiiinniiinnee. 91
Printing with a Printer other than Canon Printers............cccccccoeiinne. 49
Printing with Canon Inkjet Printers............cccovveiiiiiiee 43, 46
Printing with Easy-PhotoPrint Pro...........coooo oo 89
Printing with Print Studio Pro ... 90
Printing with Shooting Information (Detailed Setting Printing) ............ 87
Q
Quick CheCk WINAOW.......cccoiiiiieiiiiiie e 16, 135
R
RALING. ..o 18, 19, 135
N VAT [ 4T T T 146
RAW Tool Palette ......coooeeeiee e 131
Re-Adjusting an Image .........ccoviiiiiiieiiiccce e, 43,123
RECIPE ... e 99, 146
RECIPE FilE ..o e 99
Re-Editing an Image ........ooooviii e 43,123

Registering Folders as Bookmarks................ueueeieiiiiiiiiiiiiiiiiieeeeeeeeeeeee. 51
ReNamME WINAOW .....oeriiiieee e 104, 145
Rendering Intent (Matching Method) ... 147
Rendering Intents when Using Easy-PhotoPrint.................... 95, 97
Rendering Intents when Using Easy-PhotoPrint ...................oooc. 95, 97
Repair (Manual Dust Erasure).........cccccooviiiiiiieiiiiiiiiiieeeeeeeee 77,119
RGB Tool Palette..........ccooiiiiiiicc e 131
Rotate Images .......ccooeveiiiiciics 10, 25, 127, 128, 135, 136
S
SAUIALION ... 110
Save
Batch Convert/Save Images (Batch Process).................... 102, 144
Convert to JPEG or TIFF Images and Save ...........cccc.ee..... 42, 137
S AV e 41,122
SAVE A ——— 41, 122
Save JPEG or TIFF Image as a Separate Image ........ccccceeeee..... 122
View and Save RAW IMages ... 92
S AV AS e 41,122
Saving RECIPES.....cooiiiiee 100
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Thumbnail Display (Main Window) ...........cceeeiiiiiiiiiiineeeeeeee 10, 127
Change the Display .........ccouiiiiiiiiee e 10
Thumbnail Display and Enlarged Display (Edit Image Window)......... 34
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Change the Display .........ccouiiiiiiiiiie e 10
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B oL =T O = S 146
Tone Curve Adjustment ..........oeeviiiiiiiiee e 58, 111
Tone Curve Assist (Automatic Adjustment) ............ccccceeeerinnnee. 33, 107
ToniNg EffeCt.....c e 31
Tool Palette
LENS Tool Palette.......ccooeiiiiiiiieieeeeceee e 133
NR/ALO Tool Palette.........eeeveiiieiiiiiiieeeeeeeeeeeeeeeeeeeeeeeeeeeeee e 132
RAW ToOl Palette........oueiiiieiiieiiieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeee e 131
RGB Tool Palette ......oooveviiieiieiiiieeeeeeeeeeeeeeeeeeeeeeee e 131
Tool Palette (Preferences).......uvvveeiiieiiiiiiiiiieeeeee 94
Transfer
Batch Transfer Images to Image Editing Software..................... 103
Transfer an Image to Photoshop...........euviiiiiiiiiiis 79
Transfer an Image to Photoshop ... 79
Trimming and Adjusting the Angle of an Image........................... 38, 114
Trimming/Angle Adjustment Window.................................. 38, 114, 138
U
Unsharp Mask.......coooooiii 32
\'}
View Settings (Preferences) .......cvveiiiiiiiiiiiie e 93
w
WHhite BalanCe..........uuuuiiiiiiiiiiiiiiiiiiiit ettt 28
Click White BalanCe ..........cooouiiieiiiie e 28, 109
1070 ] (o]l Ir=T0 0] 0 1=T =1 (0] =T 56
1070 ] (o gAY o = 56
Personal White BalancCe ...........c..ueiiiiiiiiiiieccc e 101
Wide Gamut RGB .........ooiiiiiiiiiieeeee e 147
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About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademarks
Microsoft and Windows are trademarks or registered trademarks of
Microsoft Corporation in the United States and/or other countries.
Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.
All other trademarks are the property of their respective owners.
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